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Overview of Creating Oracle CEP
Applications

This section contains information on the following subjects:

= Section 1.1, "Overview of the Oracle CEP Programming Model"
= Section 1.2, "Oracle CEP IDE for Eclipse"

= Section 1.3, "Creating an Oracle CEP Application”

= Section 1.4, "Creating the EPN Assembly File"

m  Section 1.5, "Creating Oracle CEP Event Types"

= Section 1.6, "Configuring Oracle CEP Resource Access"

= Section 1.7, "Next Steps"

1.1 Overview of the Oracle CEP Programming Model

Because Oracle CEP applications are low latency high-performance driven
applications, they run on a lightweight container and are developed using a
POJO-based programming model. In POJO (Plain Old Java Object) programming,
business logic is implemented in the form of POJOs, and then injected with the
services they need. This is popularly called dependency injection. The injected services
can range from those provided by Oracle CEP services, such as configuration
management, to those provided by another Oracle product such as Oracle Kodo, to
those provided by a third party.

Oracle CEP defines a set of core services or components used together to assemble
event-driven applications; the typical services are adapters, streams, and processors.
You can also create your own business logic POJOs and Spring beans that are part of
the application, as well as specialized event beans that are just like Spring beans but
with full access to the Oracle CEP framework, such as monitoring and

record /playback of events. In addition to these, Oracle CEP includes other
infrastructure services, such as caching, clustering, configuration, monitoring, logging,
and so on.

All services are deployed on the underlying Oracle microServices Architecture (mSA)
technology. Oracle mSA is based upon the OSGi Service Platform defined by the OSGi
Alliance (see http://www.osgi.org/ for more information.)

The following sections provide additional information about the Oracle CEP
programming model and creating applications:

= Section 1.1.1, "Components of the Oracle CEP Event Processing Network"
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s Section 1.1.2, "Event Types"
= Section 1.1.3, "Event Type Data Types"

s Section 1.1.4, "Stream Sources and Stream Sinks and Relation Sources and Relation
Sinks"

= Section 1.1.5, "Component Configuration Files"

= Section 1.1.6, "Accessing Component and Server Configuration Using the
ConfigurationPropertyPlaceholderConfigurer Class"

= Section 1.1.7, "EPN Assembly File"

= Section 1.1.8, "How Components Fit Together"

= Section 1.1.9, "Oracle CEP Application Lifecycle"
s Section 1.1.10, "Oracle CEP APIs"

1.1.1 Components of the Oracle CEP Event Processing Network

The Oracle CEP Event Processing Network (EPN) represents the interconnections
between the various Oracle CEP components of an Oracle CEP application.

Oracle CEP applications and their event processing networks (EPNs) are made up of
the following basic components:

= Adapter: Components that provide an interface to incoming data feeds and
convert the data into event types that the Oracle CEP application understands.

Adapters can be both incoming (receive data) and outgoing (send data). Oracle
CEP includes some built-in adapters, such as HTTP publish-subscribe adapters.

For more information, see:

— Chapter 6, "Configuring JMS Adapters"

- Chapter 7, "Configuring HTTP Publish-Subscribe Server Adapters"

- Chapter 8, "Configuring Custom Adapters, Event Beans, and Spring Beans"

s Channel: Components that represent the physical conduit through which events
flow.

Channels connect components that send events with components that receive
events. For more information, see Chapter 9, "Configuring Channels".

= Processor: Components that execute user-defined event processing rules against
the events offered by channels.

The user-defined rules are written using either of the following:
- Oracle Continuous Query Language (Oracle CQL)
For more information, see:
*  Chapter 10, "Configuring Oracle CQL Processors"
*  Oracle CEP CQL Language Reference
- Event Processing Language (EPL)
For more information, see:
*

Chapter 11, "Configuring EPL Processors"
*  Oracle CEP EPL Language Reference
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Note: Oracle CQL replaces Event Processing Language (EPL) in
Oracle CEP Release 11gR1 (11.1.1). Oracle CEP supports EPL for
backwards compatibility.

Event bean: User-coded Plain Old Java Object (POJO) bean that is managed by
Oracle CEP.

Event beans are analogous to Spring beans, which are managed by the Spring
framework, however they support event-based features, such as the specification
of a suspend and resume methods. For more information, see Chapter 8,
"Configuring Custom Adapters, Event Beans, and Spring Beans".

Spring bean: User-coded Plain Old Java Object (POJO) managed by the Spring
framework.

These components are not managed by Oracle CEP; for example, you cannot
monitor these components, record and playback of events, and so on. If you
require this additional functionality for your POJO, consider creating an Oracle
CEP event bean instead. For more information, see Section 8.1.3, "Custom Spring
Beans".

Cache: Temporary storage area for events, created exclusively to improve the
overall performance of your application.

For more information, see:

- Section 10.4, "Configuring an Oracle CQL Processor Cache Source"
- Section 11.3, "Configuring an EPL Processor Cache Source"

— Chapter 12, "Configuring Caching".

Table: A node that connects a relational database table to the EPN as an event data
source.

For more information, see Section 10.3, "Configuring an Oracle CQL Processor
Table Source".

For more information, see:

Section 5.4.1, "Creating Nodes"
Section 1.1.1.1, "Nested Stages"
Section 1.1.1.2, "Foreign Stages"

1.1.1.1 Nested Stages

When you define a child stage within a parent stage, the child stage is said to be
nested. Only the parent stage can specify the child stage as a listener.

Example 1-1 shows the EPN assembly source in which HelloWorldBean is nested
within the helloworldOutputChannel. Only the parent
helloworldOutputChannel may specify the nested bean as a listener.

Example 1-1 EPN Assembly File With Nested Bean

<wlevs:adapter id="helloworldAdapter"
class="com.bea.wlevs.adapter.example.helloworld.HelloWorldAdapter" >

<wlevs:instance-property name="message" value="HelloWorld - the current time is:"/>

</wlevs:adapter>

<wlevs:channel id="helloworldInputChannel" event-type="HelloWorldEvent" >
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<wlevs:listener ref="helloworldProcessor"/>
<wlevs:source ref="helloworldAdapter"/>
</wlevs:channel>

<wlevs:processor id="helloworldProcessor" />

<wlevs:channel id="helloworldOutputChannel" event-type="HelloWorldEvent" advertise="true">
<wlevs:listener>
<bean class="com.bea.wlevs.example.helloworld.HelloWorldBean" />
</wlevs:listener>
<wlevs:source ref="helloworldProcessor"/>
</wlevs:channel>

Alternatively, you can define this EPN so that all nodes are nested as Example 1-2
shows. The helloworldAdapter, the outermost parent stage, is the only stage
accessible to other stages in the EPN.

Example 1-2 EPN Assembly File With all Nodes Nested

<wlevs:adapter id="helloworldAdapter" class="com.bea.wlevs.adapter.example.helloworld.HelloWorldAdapter" >
<wlevs:instance-property name="message" value="HelloWorld - the current time is:"/>
<wlevs:listener>
<wlevs:channel id="helloworldInputChannel" event-type="HelloWorldEvent" >
<wlevs:listener>
<wlevs:processor id="helloworldProcessor">
<wlevs:listener>
<wlevs:channel id="helloworldOutputChannel" event-type="HelloWorldEvent">
<wlevs:listener>
<bean class="com.bea.wlevs.example.helloworld.HelloWorldBean" />
</wlevs:listener>
</wlevs:channel>
</wlevs:listener>
</wlevs:processor>
</wlevs:listener>
</wlevs:channel>
</wlevs:listener>
</wlevs:adapter>

For more information, see Section 5.2.6, "Nested Stages".

1.1.1.2 Foreign Stages

You can refer to a stage simply by its id attribute when you define both the source and
target stage in the same application.

To refer to a stage you define in a different application, you use the following syntax:

FOREIGN-APPLICATION-NAME: FOREIGN-STAGE-ID

Where FOREIGN-APPLICATION-NANME is the name of the application in which you
defined the foreign stage and FOREIGN-STAGE-IDis the id attribute of the foreign
stage.

Example 1-3 shows how the reference in applicationl to the foreign stage
HelloWorldBeanSource that you define in application application?2.

Example 1-3 Application 1 Referencing Foreign Stage in Application 2

<wlevs:stream id="helloworldInstream" >
<wlevs:listener ref="helloworldProcessor"/>
<wlevs:source ref="application2:HelloWorldBeanSource"/>
</wlevs:stream>
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Example 1-4 Foreign Stage in Application 2

<wlevs:event-bean id="HelloWorldBeanSource"
class="com.bea.wlevs.example.helloworld.HelloWorldBeanSource"
advertise="true"/>

1.1.2 Event Types

Event types define the properties of the events that are handled by Oracle CEP
applications. Adapters receive incoming events from different event sources, such as
JMS, or financial market data feeds. You must define these events by an event type
before a processor is able to handle them. You then use these event types in the
adapter and POJO Java code, as well as in the Oracle CQL and EPL rules you associate
with the processors.

Events are JavaBean or Java class instances in which each property represents a data
item from the event source.

Oracle recommends that you create your own JavaBean class that represents the event
type and register the class in the EPN assembly file. By creating your own JavaBean,
you can reuse it and you have complete control over what the event looks like. If you
cannot represent your event as a JavaBean, you represent it as a Java class and provide
a factory to build instances of the event.

Alternatively, you can specify the properties of the event type declaratively in the EPN
assembly file using wlevs : property tags, in which case Oracle CEP will use a
java.util.Map or tuple. Tuple is the default and is similar to the Oracle CQL tuple.
It essentially provides the user with an optimized implementation, however, the user
must always set and get its value using the Event Type Repository APIs. This
approach is best used for quick prototyping

You can also create an event type programmatically using the
EventTypeRepository class.

When creating event types, observe the data type restrictions that Section 1.1.3, "Event
Type Data Types" describes.

For more information, see Section 1.5, "Creating Oracle CEP Event Types".

1.1.3 Event Type Data Types
When creating event types, observe the data type restrictions for the following event
types:
»  Section 1.1.3.1, "Event Types Specified as Java Bean, Java Class, or java.util. Map"
= Section 1.1.3.2, "Event Types Specified as a Tuple"
= Section 1.1.3.3, "Event Types for use With a Table Source"
= Section 1.1.3.4, "Event Types for use With the csvgen Adapter"
For more information, see:
s Section 1.1.2, "Event Types"
» "Datatypes” in the Oracle CEP CQL Language Reference
= "Overview of the EPL Language" in the Oracle CEP EPL Language Reference

1.1.3.1 Event Types Specified as Java Bean, Java Class, or java.util.Map

When you define an event type as a Java Bean, Java class, java.util.Map, you may
use any Java type for its properties.
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For more information, see

= Section 1.5.1, "How to Create an Oracle CEP Event Type as a JavaBean"

= Section 1.5.2, "How to Create an Oracle CEP Event Type as a Java Class"

s Section 1.5.3, "How to Create an Oracle CEP Event Type as a java.util. Map"

1.1.3.2 Event Types Specified as a Tuple

When you specify the properties of the event type declaratively in the EPN assembly
file as a tuple, you may only use the types specified by the
com.bea.wlevs.ede.api.Type class. Table 1-1 describes the usage for each of the
types this class defines.

Table 1-1 com.bea.wlevs.ede.api.Type Usage
Type Usage
bigint Numeric values in the range that java.math.BigInteger specifies.
boolean Boolean values as java. lang.Boolean specifies.
byte Byte values as java.lang.Byte specifies.
char Single or multiple character values. Use for both char and
java.lang.String values.
double Numeric values in the range that java . lang . Double specifies.
float Numeric values in the range that java.lang.Float specifies.
int Numeric values in the range that java.lang. Integer specifies.
interval | Interval values as the Oracle CQL INTERVAL data type specifies.
For more information, see "Interval Literals" in the Oracle CEP CQL Language
Reference
object An opaque data type that can be represented as a java.lang.Object.
timestamp | A timestamp String in a format that java.util.Date specifies.
For example:
"Sat, 12 Aug 1995 13:30:00 GMT+0430"
xmltype XML values as the Oracle CQL XMLTYPE data type specifies.
For more information, see "SQL /XML (SQLX)" in the Oracle CEP CQL Language
Reference.

Example 1-5 shows how to use these types:

Example 1-5 Using com.bea.welvs.ede.api.Type Data Types

<wlevs:event-type-repository>
<wlevs:event-type type-name="SimpleEvent">

<wlevs:properties>

<wlevs:property name="msg" type="char" />
<wlevs:property name="count" type="double" />
<wlevs:property name="time_stamp" type="timestamp" />

</wlevs:properties>
</wlevs:event-type>

</wlevs:event-type-repository>

For more information, see Section 1.5.4, "How to Create an Oracle CEP Event Type as a

Tuple".
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1.1.3.3 Event Types for use With a Table Source

When you specify the properties of an event type of a relational database table, you
must observe additional JDBC type restrictions. For more information, see:

»  Table 10-2, " EPN Assembly File event-type Element Property Attributes"
s Table 10-3, " SQL Column Types and Oracle CEP Type Equivalents"

For more information, see Section 10.3, "Configuring an Oracle CQL Processor Table
Source".

1.1.3.4 Event Types for use With the csvgen Adapter

When you specify the properties of an event type for use with the csvgen adapter,
you may only use the data types that Table 1-2 describes.

Table 1-2 csvgen Adapter Types

Type Usage

char Single or multiple character values. Use for both char and java.lang.String
values.

int Numeric values in the range that java.lang. Integer specifies.

long Numeric values in the range that java.lang.Long specifies.

double | Numeric values in the range that java. lang.Double specifies.

For more information, see Section 15.4, "Creating a Data Feed File".

1.1.4 Stream Sources and Stream Sinks and Relation Sources and Relation Sinks

All components in an EPN either emit events or receive events. Some components can
be both, such as an event bean in the middle of an EPN that receives events from an
adapter, for example, and then sends events to a processor.

Oracle CEP models event flow as either streams or relations:

= A stream S is a bag multi-set of elements (s, T) where s is in the schema of S and
T is in the time domain. Stream elements are tuple-timestamp pairs, which can be
represented as a sequence of timestamped tuple insertions. In other words, a
stream is a sequence of timestamped tuples. There could be more than one tuple
with the same timestamp. The tuples of an input stream are required to arrive at
the system in the order of increasing timestamps.

You specify a channel as a stream by setting EPN assembly element
wlevs:channel attribute is-relation to false (the default).

= Arelation is an unordered, time-varying bag of tuples: in other words, an
instantaneous relation. At every instant of time, a relation is a bounded set. It can
also be represented as a sequence of timestamped tuples that includes insertions,
deletions, and updates to capture the changing state of the relation.

You specify a channel as a realtion by setting EPN assembly element
wlevs:channel attribute is-relation to true.

For more information, see:
= Section 9.1.3, "Channels Representing Streams and Relations"

= "Streams and Relations" in the Oracle CEP CQL Language Reference
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1.1.4.1 Stream and Relation Sources

All components that emit events must implement the
com.bea.wlevs.ede.api.StreamSource or
com.bea.wlevs.ede.api.RelationSource interface.

The StreamSource interface has one method, setEventSender () ; at runtime the
event source component is injected with an
com.bea.wlevs.ede.api.StreamSender instance. The StreamSender instance,
in turn, has a sendInsertEvent () method that the component invokes to actually
send events to the next component in the EPN. The StreamSender instance also
provides a sendHeartbeat () method. The sendHeartBeat () method applies only
to application-timestamped channels.

RelationSource, through the RelationSender, provides a sendUpdateEvent ()
and sendDeleteEvent () methods.

1.1.4.2 Stream and Relation Sinks

Components that receive events must implement the
com.bea.wlevs.ede.api.StreamSink or
com.bea.wlevs.ede.api.RelationSink interface.

The StreamSink interface has a single callback method, onInsertEvent (), that
components implement to receive a list of events from the previous component in the
EPN.

The RelationSink interface extends StreamSink to model an Oracle CQL relation
sink. The RelationSink interface also provides an onDeleteEvent () and
onUpdateEvent () methods.

1.1.5 Component Configuration Files

Each component in your event processing network (adapter, processor, channel, or
event bean) can have an associated configuration file, although only processors are
required to have a configuration file. The caching system also uses a configuration file,
regardless of whether it is a stage in the event processing network. Component
configuration files in Oracle CEP are XML documents whose structure is defined using
standard XML Schema. You create a single file that contains configuration for all
components in your application, or you can create separate files for each component;
the choice depends on which is easier for you to manage.

The wlevs_application_config.xsd schema file describes the structure of
component configuration files. This XSD schema imports the following schemas:

m wlevs_base_config.xsd: Defines common elements that are shared between
application configuration files and the server configuration file

» wlevs_eventstore_config.xsd: Defines event store-specific elements.
» wlevs_diagnostic_config.xsd: Defines diagnostic elements.

The structure of application configuration files is as follows. There is a top-level root
element named config that contains a sequence of sub-elements. Each individual
sub-element contains the configuration data for an Oracle CEP component (processor,
channel, or adapter). For example:

<?xml version="1.0" encoding="UTF-8"?>
<nl:config xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<processor>
<name>helloworldProcessor</name>
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<rules>
<query id="helloworldRule">
<! [CDATA[ select * from helloworldInputChannel [Now] 11>
</query>
</rules>
</processor>
<channel>
<name>helloworldInputChannel</name>
<max-size>10000</max-size>
<max-threads>2</max-threads>
</channel>
<channel>
<name>helloworldOutputChannel</name>
<max-size>10000</max-size>
<max-threads>2</max-threads>
</channel>
</nl:config>

For more information, see:

= Section 1.1.6, "Accessing Component and Server Configuration Using the
ConfigurationPropertyPlaceholderConfigurer Class"

= Section 1.1.8, "How Components Fit Together"

1.1.6 Accessing Component and Server Configuration Using the
ConfigurationPropertyPlaceholderConfigurer Class
Using the ConfigurationPropertyPlaceholderConfigurer class, you can
reference existing configuration file properties, in both component configuration and
server configuration files, using a symbolic placeholder. This allows you to define a

value in one place and refer to that one definition rather than hard-coding the same
value in many places.

For example, given the element that Example 1-6 shows, you can refer to the netio
element port value as Example 1-7 shows.

Example 1-6 netio Element

<netio>
<name>MyNetIO</name>
<port>9003</port>
</netio>

Example 1-7 Accessing the netio Element port Value

<property name="myprop" value="${MyNetIO.port}"/>

To use this feature, insert a ConfigurationPropertyPlaceholderConfigurer
bean in the application context configuration file of your application bundle as
Example 1-8 shows.

Example 1-8 Adding a ConfigurationPropertyPlaceholderConfigurer
<bean class="com.bea.wlevs.spring.support.ConfigurationPropertyPlaceholderConfigurer"/>

For complete details, see the
com.bea.wlevs.spring.support.ConfigurationPropertyPlaceholderCon
figurer class in the Oracle CEP Java API Reference.
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1.1.7 EPN Assembly File

You assemble an Oracle CEP application an Event Processing Network (EPN)
assembly file before deploying it to the server; this EPN assembly file is an extension
of the Spring framework XML configuration file.

For some Oracle CEP features, you specify some configuration in the component
configuration file and some in the EPN assembly file.

The spring-wlevs-v11l_0_0_0.xsd schema file describes the structure of EPN
assembly files.

The structure of EPN assembly files is as follows. There is a top-level root element
named beans that contains a sequence of sub-elements. Each individual sub-element
contains the configuration data for an Oracle CEP component. For example:

<?xml version="1.0" encoding="UTF-8"?>
<beans xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:osgi="http://www.springframework.org/schema/osgi"
xmlns:wlevs="http://www.bea.com/ns/wlevs/spring"
xsi:schemaLocation="
http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans.xsd
http://www.springframework.org/schema/osgi
http://www.springframework.org/schema/osgi/spring-osgi.xsd
http://www.bea.com/ns/wlevs/spring
http://www.bea.com/ns/wlevs/spring/spring-wlevs-v11l_0_0_0.xsd">

<wlevs:event-type-repository>
<wlevs:event-type type-name="HelloWorldEvent">
<wlevs:class>com.bea.wlevs.event.example.helloworld.HelloWorldEvent</wlevs:class>
</wlevs:event-type>
</wlevs:event-type-repository>

<wlevs:adapter id="helloworldAdapter"
class="com.bea.wlevs.adapter.example.helloworld.HelloWorldAdapter" >
<wlevs:instance-property name="message" value="HelloWorld - the current time is:"/>
</wlevs:adapter>

<wlevs:channel id="helloworldInputChannel" event-type="HelloWorldEvent" >
<wlevs:listener ref="helloworldProcessor"/>
<wlevs:source ref="helloworldAdapter"/>

</wlevs:channel>

<wlevs:processor id="helloworldProcessor" />

<wlevs:channel id="helloworldOutputChannel"
event-type="HelloWorldEvent" advertise="true">
<wlevs:listener>
<bean class="com.bea.wlevs.example.helloworld.HelloWorldBean"/>
</wlevs:listener>
<wlevs:source ref="helloworldProcessor"/>
</wlevs:channel>

</beans>

For more information, see:
= Section 1.4, "Creating the EPN Assembly File"
= Section 1.1.8, "How Components Fit Together"
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1.1.8 How Components Fit Together

Oracle CEP applications are made of services that are assembled together to form an
Event Processing Network (EPN).

The server uses the Spring framework as its assembly mechanism due to Spring's
popularity and simplicity. Oracle CEP has extended the Spring framework to further
simplify the process of assembling applications. This approach allows Oracle CEP
applications to be easily integrated with existing Spring-beans, and other light-weight
programming frameworks that are based upon a dependency injection mechanism.

A common approach for dependency injection is the usage of XML configuration files
to declaratively specify the dependencies and assembly of an application. You
assemble an Oracle CEP application an EPN assembly file before deploying it to the
server; this EPN assembly file is an extension of the Spring framework XML
configuration file.

After an application is assembled, it must be package so that it can be deployed into
Oracle CEP. This is a simple process. The deployment unit of an application is a plain
JAR file, which must contain, at a minimum, the following artifacts:

s The compiled application Java code of the business logic POJO.

s Component configuration files. Each processor is required to have a configuration
file, although adapters and streams do not need to have a configuration file if the
default configuration is adequate and you do not plan to monitor these
components.

s The EPN assembly file.
s A MANIFEST.MF file with some additional OSGi entries.

After you assemble the artifacts into a JAR file, you deploy this bundle to Oracle CEP
so it can immediately start receiving incoming data.

For more information, see Chapter 14, "Assembling and Deploying Oracle CEP
Applications".

1.1.9 Oracle CEP Application Lifecycle

Figure 1-1 shows a state diagram for the Oracle CEP application lifecycle. In this
diagram, the state names (STARTING, INITIALIZING, RUNNING, SUSPENDING,
SUSPENDED, and FAILED) correspond to the ApplicationRuntimeMBean method
getState () return values. These states are specific to Oracle CEP; they are not OSGi
bundle states.
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Figure 1-1 Oracle CEP Application Lifecycle State Diagram
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Note: For information on Oracle CEP server lifecycle, see "Oracle
CEP Server Lifecycle" in the Oracle CEP Administrator’s Guide.

This section describes the lifecycle of an application deployed to the Oracle CEP server
and the sequence of com.bea.wlevs.ede.api API callbacks. The lifecycle
description is broken down into actions that a user performs, including:

»  Section 1.1.9.1, "User Action: Installing an Application or Start the Server With
Application Already Deployed"

m  Section 1.1.9.2, "User Action: Suspend Application"
= Section 1.1.9.3, "User Action: Resume Application”
= Section 1.1.9.4, "User Action: Uninstall Application"
= Section 1.1.9.5, "User Action: Update Application"

This information explains how Oracle CEP manages an application's lifecycle so that
you can better use the lifecycle APIs in your application. For a description of these
APIs (such as RunnableBean and SuspendableBean), see:

s Section 1.1.10, "Oracle CEP APIs"
= Appendix G, "Oracle CEP Metadata Annotation Reference"
»  Oracle CEP Java API Reference

1.1.9.1 User Action: Installing an Application or Start the Server With Application
Already Deployed

Oracle CEP performs the following actions:
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Oracle CEP installs the application as an OSGI bundle. OSGI resolves the imports
and exports, and publishes the service.

Oracle CEP creates beans (for both standard Spring beans and those that
correspond to the Oracle CEP tags in the EPN assembly file). For each bean, Oracle
CEP:

= Sets the properties on the Spring beans. The <wlevs:instance-property>
values are set on adapters and event-beans.

= Injects appropriate dependencies into services specified by @Service or
@ServiceReference annotations.

= Injects appropriate dependencies into static configuration properties.
s Calls InitializingBean.afterPropertiesSet().

= Calls configuration callbacks (@Prepare,@Activate) on Spring beans as well
as factory-created stages.

Application state is now INITIALIZING.
Oracle CEP registers the MBeans.

Oracle CEP calls ActivatableBean.afterConfigurationActive () onall
ActivatableBeans

Oracle CEP calls ResumableBean.beforeResume () on all ResumableBeans

For each bean that implements RunnableBean, Oracle CEP starts it running in a
thread.

Application state is now RUNNING.

1.1.9.2 User Action: Suspend Application

Oracle CEP performs the following actions:

1.
2.

Oracle CEP calls SuspendableBean. suspend () on all SuspendableBeans.

Application state is now SUSPENDED.

1.1.9.3 User Action: Resume Application
Oracle CEP performs the following actions:

1.
2.

Oracle CEP calls ResumableBean.beforeResume () on all ResumableBeans

For each bean that implements RunnableBean, Oracle CEP starts it running in a
thread.

Application state is now RUNNING.

1.1.9.4 User Action: Uninstall Application
Oracle CEP performs the following actions:

1.

2
3.
4

Oracle CEP calls SuspendableBean. suspend () on all SuspendableBeans.
Oracle CEP unregisters MBeans.
Oracle CEP calls DisposableBean.dispose () on all DisposableBeans.

Oracle CEP uninstalls application bundle from OSGI.

1.1.9.5 User Action: Update Application

This is equivalent to first unistalling an application and then installing it again.
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See:

Section 1.1.9.4, "User Action: Uninstall Application"

Section 1.1.9.1, "User Action: Installing an Application or Start the Server With
Application Already Deployed"

1.1.10 Oracle CEP APIs

Oracle CEP provides a variety of Java APIs that you use in your adapter or event bean
implementation.

This section describes the APIs in the com.bea.wlevs.ede.api package that you
will most typically use in your adapters and event beans.

Adapter—Adapters must implement this interface.
AdapterFactory—Adapter factories must implement this interface.

Component life cycle interfaces—If you want some control over the life cycle of
the component you are programming, then your component should implement
one or more of the following interfaces:

- ActivatableBean—Use if you want to run some code after all dynamic
configuration has been set and the event processing network has been
activated. Implement the afterConfigurationActive () method.

- DisposableBean—Use if you want to release resources when the application
is undeployed. Implement the destroy () method in your component code.

- InitializingBean—Use if you require custom initialization after Oracle
CEP has set all the properties of the component. Implement the
afterPropertiesSet () method.

- ResumableBean—Use if you want to perform some task, such as acquire or
configure resources, before the component resumes work.

- RunnableBean—Use if you want the component to be run in a thread.

The Spring framework implements similar bean life cycle interfaces; however,
the equivalent Spring interfaces do not allow you to manipulate beans that
were created by factories, while the Oracle CEP interfaces do.

- SuspendableBean—Use if you want to suspend resources or stop processing
events when the event processing network is suspended. Implement the
suspend () method.

See also Appendix G, "Oracle CEP Metadata Annotation Reference" for additional
lifecycle annotations.

EventBuilder—Use to create events whose Java representation does not expose
the necessary setter and getter methods for its properties. If your event type is
represented with a JavaBean with all required getter and setter methods, then you
do not need to create an EventBuilder.

EventBuilder.Factory—Factory for creating EventBuilders.

StreamSink—Components that want to receive events as an Oracle CEP stream
must implement this interface. An Oracle CEP stream has the following
characteristics:

= Append-only, that is, events are always appended to the end of the stream.

= Unbounded and generally need a window to be defined before it can be
processed.
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= Events have non-decreasing time-stamps.

The interface has a callback method, onInsertEvent (), in which programmers
put the code that handles the received events.

StreamSource—Components that send events modeling an Oracle CEP stream,
such as adapters, must implement this interface. The interface has a
setEventSender () method for setting the St reamSender, which actually
sends the event to the next component in the network.

RelationSink—Components that want to receive events modeling an Oracle
CEP relation must implement this interface. An Oracle CEP relation has the
following characteristics:

= Supports events that insert, delete, and update its content.
s Isalways known at an instant time.
= Events have non-decreasing time-stamps.

The interface has callback methods onDeleteEvent () and onInsertEvent ()
in which programmers put the code that handles event deletion and event
insertion.

RelationSource—Components that send events modeling an Oracle CEP
relation, such as adapters, must implement this interface. The interface has a
setEventSender () method for setting the RelationSender, which actually
sends the event to the next component in the network.

For more information, see:

Oracle CEP Java API Reference for the full reference documentation for all classes
and interfaces.

Chapter 8, "Configuring Custom Adapters, Event Beans, and Spring Beans" as well
as the HelloWorld and FX examples in the installed product, for sample Java code
that uses these APIs.

Section 1.6, "Configuring Oracle CEP Resource Access" for information on using
Oracle CEP annotations and deployment XML to configure resource injection.

1.2 Oracle CEP IDE for Eclipse

Oracle provides an IDE targeted specifically to programmers that want to develop
Oracle CEP applications. Oracle CEP IDE for Eclipse is a set of plugins for the Eclipse
IDE designed to help develop, deploy, and debug applications for Oracle CEP.

The key features of the Oracle CEP IDE for Eclipse are as follows:

Project creation wizards and templates to quickly get started building event driven
applications.

Advanced editors for source files including Java and XML files common to Oracle
CEP applications.

Integrated server management to seamlessly start, stop, and deploy to Oracle CEP
server instances all from within the IDE.

Integrated debugging.

Event Processing Network (EPN) visual design views for orienting and navigating
in event processing applications.
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s Integrated support for the Oracle CEP Visualizer so you can use the Oracle CEP
Visualizer from within the IDE.

Although it is not required or assumed that you are using the Oracle CEP IDE, Oracle
recommends that you give it a try.

For detailed instructions on installing and using the IDE, see Chapter 2, "Overview of
the Oracle CEP IDE for Eclipse".

1.3 Creating an Oracle CEP Application

The following procedure shows the suggested start-to-finish steps to create an Oracle
CEP application. Although it is not required to program and configure the various
components in the order shown, the procedure shows a typical and logical flow
recommended by Oracle.

It is assumed in the procedure that you are using an IDE, although it is not required
and the one you use is your choice. For one targeted to Oracle CEP developers, see
Section 1.2, "Oracle CEP IDE for Eclipse."

To create an Oracle CEP application:

1. Set up your environment as described in "Setting Your Development
Environment" in the Oracle CEP Getting Started.

2. Design your event processing network (EPN).

This step involves creating the EPN assembly file, adding the full list of
components that make up the application and how they are connected to each
other, as well as registering the event types used in your application.

This step combines both designing of your application, in particular determining
the components that you need to configure and code, as well as creating the actual
XML file that specifies all the components. You will likely be constantly updating
this XML file as you implement your application, but Oracle recommends you
start with this step so you have a high-level view of your application.

For details, see Section 1.4, "Creating the EPN Assembly File."

3. Design the rules that the processors are going to use to select events from the
channel.

See:
»  Oracle CEP CQL Language Reference
»  Oracle CEP EPL Language Reference

Note: Oracle CQL replaces Event Processing Language (EPL) in
Oracle CEP Release 11gR1 (11.1.1). Oracle CEP supports EPL for
backwards compatibility.

4. Determine the event types that your application is going to use, and, if creating
your own JavaBean, program the Java file.

See Section 1.5, "Creating Oracle CEP Event Types."

5. Program, and optionally configure, the adapters or event beans that act as
inbound, intermediate, or outbound components of your event processing
network. You can create your own adapters or event beans, or use the adapters
provided by Oracle CEP. For details, see:
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s Section 1.1.10, "Oracle CEP APIs"

s Chapter 8, "Configuring Custom Adapters, Event Beans, and Spring Beans"
s Chapter 6, "Configuring JMS Adapters"

s Chapter 7, "Configuring HTTP Publish-Subscribe Server Adapters"

= Section 1.6, "Configuring Oracle CEP Resource Access"

6. Configure the processors by creating their component configuration XML files; the
most important part of this step is designing and declaring the initial rules that are
associated with each processor.

See:
s Chapter 10, "Configuring Oracle CQL Processors"
s Chapter 11, "Configuring EPL Processors"

7. Optionally configure the channels that stream data between adapters, processors,
and the business logic POJO by creating their configuration XML files.

See Chapter 9, "Configuring Channels."

8. Optionally configure the caching system to publish or consume events to and from
a cache to increase the availability of the events and increase the performance of
your applications.

See Chapter 12, "Configuring Caching."

9. Optionally, use the Oracle CEP server log subsystem to write log messages from
your application to the Oracle CEP server log:

import org.apache.commons.logging.Log;
import org.apache.commons.logging.LogFactory;

Log LOG=LogFactory.getLog ("LogName") ;

LOG.debug ("Some debug information");

Using the Oracle CEP Visualizer, you can deploy your application, configure the
log level for your application, and view the Oracle CEP server console.

For more information, see:

s "Configuring Logging and Debugging for Oracle CEP" in the Oracle CEP
Administrator’s Guide

= "How to Configure Component Logging" in the Oracle CEP Visualizer User’s
Guide

= "How to View Console Output" in the Oracle CEP Visualizer User’s Guide

See Section 1.7, "Next Steps" for the list of steps you should follow after you have
completed programming your application, such as packaging and deploying.

1.4 Creating the EPN Assembly File

You use the Event Processing Network (EPN) assembly file to declare the components
that make up your Oracle CEP application and how they are connected to each other.
You also use the file to register event types of your application, as well as the Java
classes that implement the adapter and POJO components of your application.
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For an example of an EPN assembly file, see the "Foreign Exchange (FX) Example" in
the Oracle CEP Getting Started. For additional information about Spring and OSGi, see
Appendix A, "Additional Information about Spring and OSGi."

1.4.1 How to Create the EPN Assembly File Using Oracle CEP IDE for Eclipse

The most efficient and least error-prone way to create and edit the EPN file is using the
EPN editor in the Oracle CEP IDE for Eclipse. Optionally, you can create a channel
configuration file manually (see Section 1.4.2, "How to Create the EPN Assembly File
Manually").

For more information, see Section 5.2, "EPN Editor Overview".

To create the EPN assembly file using Oracle CEP IDE for Eclipse:
1. Create an Oracle CEP project.

See Section 3.2, "Creating Oracle CEP Projects".
2. Open the EPN editor.

See Section 5.1, "Opening the EPN Editor".
3. Create and connect nodes on the EPN.

See Section 5.4, "Using the EPN Editor".

1.4.2 How to Create the EPN Assembly File Manually

Although the Oracle CEP IDE for Eclipse EPN editor is the most efficient and least
error-prone way to create and edit the EPN file (see Section 1.4.1, "How to Create the
EPN Assembly File Using Oracle CEP IDE for Eclipse"), alternatively, you can also
create and maintain the EPN file manually.

As is often true with Spring, there are different ways to use the tags to define your
event network. This section shows one way.

See Section B.2, "EPN Assembly Schema spring-wlevs-v11_0_0_0.xsd" for the full
reference information on the other tags and attributes you can use.

To create the EPN assembly file manually:

1. Using your favorite XML or plain text editor, create an XML file with the <beans>
root element and namespace declarations as follows:

<?xml version="1.0" encoding="UTF-8"?>
<beans xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:osgi="http://www.springframework.org/schema/osgi"
xmlns:wlevs="http://www.bea.com/ns/wlevs/spring"
xsi:schemalocation="
http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans.xsd
http://www.springframework.org/schema/osgi
http://www.springframework.org/schema/osgi/spring-osgi.xsd
http://www.bea.com/ns/wlevs/spring
http://www.bea.com/ns/wlevs/spring/spring-wlevs.xsd">

</beans>
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If you are not going to use any of the Spring-OSGI tags in the XML file, then their
corresponding namespace declarations, shown in bold in the preceding example,
are not required.

If you have programmed an adapter factory, add an <osgi:service ...>
Spring tag to register the factory as an OSGi service. For example:

<osgi:service interface="com.bea.wlevs.ede.api.AdapterFactory">
<osgil:service-properties>
<entry key="type" value="hellomsgs<"/entry>
</osgi:service-properties>
<bean
class="com.bea.wlevs.adapter.example.helloworld.HelloWorldAdapterFactory" />
</osgi:service>

Specify the Oracle CEP-provided adapter factory
(com.bea.wlevs.ede.api.AdapterFactory) for the interface attribute.
Use the <osgi-service-properties> tag to give the OSGI service a type
name, in the example above the name is hellomsgs; you will reference this label
later when you declare the adapter components of your application. Finally, use
the <bean> Spring tag to register the your adapter factory bean in the Spring
application context; this class generates instances of the adapter.

Caution: Be sure the type name (hellomsgs in the preceding
example) is unique across all applications deployed to a particular
Oracle CEP. The OSGI service registry is per server, not per
application, so if two different adapter factory services have been
registered with the same type name, it is undefined which adapter
factory a particular application will use. To avoid this confusion, be

sure that the value of the <entry key="type" ...> entry for each
OSGl-registered adapter factory in each EPN assembly file for a server
is unique.

Add a <wlevs:event-type-repository> tag to register the event types that
you use throughout your application, such as in the adapter implementations,
business logic POJO, and the EPL rules associated with the processor components.
For each event type in your application, add a <wlevs:event-type> child tag.

Event types are simple JavaBeans that you either code yourself (recommended) or
let Oracle CEP automatically generate from the meta data you provide in the
<wlevs:event-type> tag. If you code the JavaBean yourself, use a
<wlevs:class> tag to specify your JavaBean class. You can optionally use the
<wlevs:property name="builderFactory"> tag to specify the Spring bean
that acts as a builder factory for the event type, if you have programmed a factory.
If you want Oracle CEP to automatically generate the JavaBean class, use the
<wlevs:property> tag to list each property of the event type. The following
example is taken from the FX sample:

<wlevs:event-type-repository>
<wlevs:event-type type-name="ForeignExchangeEvent">
<wlevs:class>
com.bea.wlevs.example. fx.OutputBean$SForeignExchangeEvent
</wlevs:class>
<wlevs:property name="builderFactory">
<bean id="builderFactory"
class="com.bea.wlevs.example.fx.ForeignExchangeBuilderFactory"/>
</wlevs:property>
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</wlevs:event-type>
</wlevs:event-type-repository>

See Section D.12, "wlevs:event-type-repository" for reference information about
this tag.

See Section 1.5, "Creating Oracle CEP Event Types" for additional information
about creating event types.

4. For each adapter component in your application, add a <wlevs:adapter> tag to
declare that the component is part of the event processing network. Use the
required id attribute to give it a unique ID and the provider attribute to specify
the type of data feed to which the adapter will be listening. Use the
<wlevs:instance-property> child tag to pass the adapter the properties it
expects. For example, the csvgen adapter, provided by Oracle CEP to test your
EPL rules with a simulated data feed, defines a setPort () method and thus
expects a port property, among other properties. Use the provider attribute to
specify the adapter factory, typically registered as an OSGi service; you can also
use the csvgen keyword to specify the csvgen adapter.

The following example declares the helloWorldadapter of the HelloWorld
example:

<wlevs:adapter id="helloworldAdapter" provider="hellomsgs" advertise="true">
<wlevs:instance-property name="message" value="HelloWorld - the currenttime

is:"/>

</wlevs:adapter>

In the example, the property message is passed to the adapter. The adapter
factory provider is hellomsgs, which refers to the type name of the adapter
factory OSGI service. The advertise attribute, common to all components,
enables monitoring for the adapter; by default, manageability of the component is
disabled due to possible performance impacts.

See Section D.2, "wlevs:adapter" for reference information about this tag, in
particular additional optional attributes and child tags.

5. For each processor component in your application, add a <wlevs:processor>
tag. Use the id attribute to give it a unique ID. Use either the 1isteners
attribute or <wlevs:1listener> child tag to specify the components that listen to
the processor. The following two examples are equivalent:

<wlevs:processor id="preprocessorAmer" listeners="spreaderIn"/>
<wlevs:processor id="preprocessorAmer">

<wlevs:listener ref="spreaderIn"/>
</wlevs:processor>

In the examples, the spreaderIn channel component listens to the
preprocessorAmer processor.

See Section D.20, "wlevs:processor" for reference information about this tag, in
particular additional optional attributes, such as advertise for enabling
monitoring of the component.

6. For each channel component in your application, add a <wlevs:channel> tag to
declare that the component is part of the event processing network. Use the 1d
attribute to give it a unique ID. Use the <wlevs:listener> and
<wlevs:source> child tags to specify the components that act as listeners and
sources for the channel. For example:

<wlevs:channel id="fxMarketAmerQut">
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<wlevs:listener ref="preprocessorAmer"/>
<wlevs:source ref="fxMarketAmer"/>
</wlevs:channel>

In the example, the fxMarketAmerOut channel listens to the fxMarketAmer
component, and the preprocessorAmer component in turn listens to the
fxMarketAmerOut channel.

Nest the declaration of the business logic POJO, called outputBean in the
example, using a standard Spring <bean> tag inside a <wlevs:listener> tag,
as shown:

<wlevs:channel id="spreaderOut" advertise="true">
<wlevs:listener>
<!-- Create business object -->
<bean id="outputBean"
class="com.bea.wlevs.example.fx.OutputBean"
autowire="byName" />
</wlevs:listener>
</wlevs:channel>

The advertise attribute is common to all Oracle CEP application assembly tags
and is used to register the component as a service in the OSGI registry.

Section D.10, "wlevs:channel" for reference information about this tag, in particular
additional optional attributes, such as advertise for enabling monitoring of the
component.

1.5 Creating Oracle CEP Event Types

Event types define the properties of the events that are handled by Oracle CEP
applications. Adapters receive incoming events from different event sources, such as
JMS, or financial market data feeds. You must define these events by an event type
before a processor is able to handle them. You then use these event types in the
adapter and POJO Java code, as well as in the Oracle CQL and EPL rules you associate
with the processors.

This section describes:

= Section 1.5.1, "How to Create an Oracle CEP Event Type as a JavaBean"

= Section 1.5.2, "How to Create an Oracle CEP Event Type as a Java Class"

= Section 1.5.3, "How to Create an Oracle CEP Event Type as a java.util. Map"
= Section 1.5.4, "How to Create an Oracle CEP Event Type as a Tuple"

= Section 1.5.5, "Using an Event Type Builder Factory"

= Section 1.5.6, "Sharing Event Types Between Application Bundles"

For more information, see Section 1.1.2, "Event Types".

1.5.1 How to Create an Oracle CEP Event Type as a JavaBean

This procedure describes how to create and register an Oracle CEP event type as a Java
Bean. This is the preferred approach.

See the JavaBeans Tutorial at
http://java.sun.com/docs/books/tutorial/javabeans/ for additional
detalils.
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For more information on valid event type data types, see Section 1.1.3.1, "Event Types
Specified as Java Bean, Java Class, or java.util. Map".

To create an Oracle CEP event type as a Java bean:
1. Create a Java Bean class to represent your event type.
Follow standard JavaBeans programming guidelines. See the JavaBeans Tutorial at

http://java.sun.com/docs/books/tutorial/javabeans/ for additional
details.

Oracle recommends that, if possible, you make your event type JavaBeans
immutable to improve performance. Immutable beans help the garbage collection
work much better. Inmutable beans are read only (only getters) and have public
constructors with arguments that satisfy immutability.

Example 1-9 shows the MarketEvent which is implemented by the

com.bea.wlevs.example.algotrading.event.MarketEvent class.

Example 1-9 MarketEvent Class

package com.bea.wlevs.example.algotrading.event;
import java.util.Date;

public final class MarketEvent {
private final Long timestamp;

private final String symbol;
private final Double price;
private final Long volume;
private final Long latencyTimestamp;
public MarketEvent (final Long timestamp, final String symbol,
final Double price, final Long volume, final Long latencyTimestamp) {
this.timestamp = timestamp;
this.symbol = symbol;
this.price = price;

this.volume = volume;
this.latencyTimestamp = latencyTimestamp;

public Double getPrice() {
return price;

public String getSymbol() {
return symbol;

public Long getTimestamp () {
return timestamp;

public Long getLatencyTimestamp() {
return latencyTimestamp;

public Long getVolume () {
return volume;
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}

2. Compile the JavaBean that represents your event type.
3. Register your JavaBean event type in the Oracle CEP event type repository:

a. To register declaratively, edit the EPN assembly file using the
wlevs:event-type-repository element wlevs:event-type child
element as Example 1-10 shows.

Example 1-10 EPN Assembly File event-type-repository

<wlevs:event-type-repository>
<wlevs:event-type type-name="MarketEvent">
<wlevs:class>
com.bea.wlevs.example.algotrading.event.MarketEvent
</wlevs:class>
</wlevs:event-type>
</wlevs:event-type-repository>

b. To register programatically, use the EventTypeRepository class as
Example 1-11 shows.

Example 1-11 Programmatically Registering an Event

EventTypeRepository rep = getEventTypeRepository();
rep.registerEventType (
"MarketEvent",
com.bea.wlevs.example.algotrading.event.MarketEvent.getClass ()

For more information, see the Oracle CEP Java API Reference.
4. Use the event type:

= Reference the event types as standard JavaBeans in the Java code of the
adapters and business logic POJO in your application.

public void onEvent (List newEvents)
throws RejectEventException {
for (Object event : newEvents) {
MarketEvent marketEvent = (MarketEvent) event;
System.out.println("Price: " + marketEvent.getPrice());

}

m  Access the event types from Oracle CQL and EPL rules:

The following Oracle CQL rule shows how you can reference the
MarketEvent in a SELECT statement:

<query id="helloworldRule">
<! [CDATA[ select MarketEvent.price from marketEventChannel [Now] ]]>
</query>

1.5.2 How to Create an Oracle CEP Event Type as a Java Class

This procedure describes how to create and register an Oracle CEP event type as a Java
class that does not conform to the JavaBeans programming guidelines.

For more information on valid event type data types, see Section 1.1.3.1, "Event Types
Specified as Java Bean, Java Class, or java.util. Map".
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To create an Oracle CEP event type as a Java class:
1. Create a Java class to represent your event type.

Oracle recommends that, if possible, you make your event type Java class
immutable to improve performance. Immutable beans help the garbage collection
work much better. Inmutable beans are read only (only getters) and have public
constructors with arguments that satisfy immutability.

Example 1-9 shows the ForeignExchangeEvent which is implemented by the
ForeignExchangeEvent inner class of
com.bea.wlevs.example. fx.OutputBean.

Example 1-12 ForeignExchangeEvent Class: Does not Conform to JavaBean Standards

package com.bea.wlevs.example.fx.OutputBean.ForeignExchangeEvent;

static public class ForeignExchangeEvent {
private String symbol;
private Double price;
private String fromRate;
private String toRate;
private Long clientTimestamp;
private Long adapterTimestamp;

public ForeignExchangeEvent () {

public ForeignExchangeEvent (String symbol, Double price, String fromRate, String toRate)

this.symbol = symbol;
this.price = price;
this.fromRate = fromRate;
this.toRate = toRate;

if (clientTimestamp == null)
this.clientTimestamp = new Long(0);

if (adapterTimestamp == null)
this.adapterTimestamp = new Long(0);

public String getSymbol() {
return symbol;

public Double getPrice() {
return price;

public String getFromRate() {
return fromRate;

public String getToRate() {
return toRate;

public Long getClientTimestamp() {
return clientTimestamp;

public Long getAdapterTimestamp () {
return adapterTimestamp;
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2. Create aJava class to represent your event type builder as Example 1-13 shows.

Example 1-13 ForeignExchangeBuilderFactory

package com.bea.wlevs.example.fx;

import java.util.HashMap;
import java.util.Map;

import com.bea.wlevs.ede.api.EventBuilder;
import com.bea.wlevs.example.fx.OutputBean.ForeignExchangeEvent;

public class ForeignExchangeBuilderFactory implements EventBuilder.Factory {

public EventBuilder createBuilder() {
return new ForeignExchangeBuilder () ;

static class ForeignExchangeBuilder implements EventBuilder ({
private Map<String,Object> values = new HashMap<String,Object>(10);

public Object createEvent() {
return new ForeignExchangeEvent (
(String) values.get("symbol"),
(Double) values.get("price"),
(String) values.get("fromRate"),
(String) values.get("toRate"));

public void put (String property, Object value) throws IllegalStateException {
values.put (property, value);

Oracle CEP uses the event builder factory to create event instances that do not
follow the JavaBean specification. See Section 1.5.5, "Using an Event Type Builder
Factory" for additional information about using an event type builder factory.

3. Compile the Java classes that represent your event type and event builder factory.

4. Register your event type and event builder factory in the Oracle CEP event type
repository:

a. To register declaratively, edit the EPN assembly file using the
wlevs:event-type-repository element wlevs:event-type child
element as Example 1-10 shows.

Use the <wlevs:class> tag to point to your JavaBean class, and then use the
<wlevs:property name="builderFactory"> tagto specify a custom
event builder factory for the event type.

Example 1-14 EPN Assembly File event-type-repository

<wlevs:event-type-repository>
<wlevs:event-type type-name="ForeignExchangeEvent">
<wlevs:class>
com.bea.wlevs.example. fx.OutputBean.ForeignExchangeEvent
</wlevs:class>
<wlevs:property name="builderFactory">
<bean id="builderFactory"
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class="com.bea.wlevs.example. fx.ForeignExchangeBuilderFactory"/>
</wlevs:property>
</wlevs:event-type>
</wlevs:event-type-repository>

b. To register programatically, use the EventTypeRepository class as
Example 1-11 shows.

Example 1-15 Programmatically Registering an Event

EventTypeRepository rep = getEventTypeRepository();
ForeignExchangeBuilderFactory factory = new ForeignExchangeBuilderFactory();
rep.registerEventType (

"ForeignExchangeEvent",

com.bea.wlevs.example. fx.OutputBean.ForeignExchangeEvent.getClass (),

factory.createBuilder ()

For more information, see the Oracle CEP Java API Reference.
5. Use the event type:

= Reference the event types as standard JavaBeans in the Java code of the
adapters and business logic POJO in your application.

public void onEvent (List newEvents)
throws RejectEventException {
for (Object event : newEvents) {
ForeignExchangeEvent fxEvent = (ForeignExchangeEvent) event;
System.out.println("Price: " + fxEvent.getPrice());

}

m  Access the event types from Oracle CQL and EPL rules:

The following Oracle CQL rule shows how you can reference the
MarketEvent in a SELECT statement:

<query id="helloworldRule">

<! [CDATA[ select ForeignExchangeEvent.price from marketEventChannel
[Now] ]1>
</query>

1.5.3 How to Create an Oracle CEP Event Type as a java.util.Map

This procedure describes how to create and register an Oracle CEP event type as a
java.util.Map. Oracle recommends that you create an Oracle CEP event type as a
JavaBean (see Section 1.5.1, "How to Create an Oracle CEP Event Type as a JavaBean").

For more information on valid event type data types, see Section 1.1.3.1, "Event Types
Specified as Java Bean, Java Class, or java.util. Map".

To create an Oracle CEP event type as a java.util.Map:
1. Decide on the properties your event type requires.

2. Register your event type in the Oracle CEP event type repository:

a. To register declaratively, edit the EPN assembly file using the
wlevs:event-type-repository elementwlevs:event-type child
element as Example 1-16 shows.
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Example 1-16 EPN Assembly File event-type-repository

<wlevs:event-type-repository>
<wlevs:event-type type-name="AnotherEvent">
<wlevs:property>
<entry key="name" value="java.lang.String"/>
<entry key="age" value="java.lang.Integer"/>
<entry key="address" value="java.lang.String"/>
</wlevs:property>
</wlevs:event-type>
</wlevs:event-type-repository>

At runtime, Oracle CEP generates a bean instance of AnotherEvent for you.
The AnotherEvent has three properties: name, age, and address.

b. To register programatically, use the EventTypeRepository class as
Example 1-17 shows.

Example 1-17 Programmatically Registering an Event

EventTypeRepository rep = getEventTypeRepository();
java.util.Map map = new Map ({name, java.lang.String}, {age, java.lang.Integer}, {address,
java.lang.String});
rep.registerEventType (
"AnotherEvent",
map

For more information, see the Oracle CEP Java API Reference.
3. Use the event type:

= Reference the event types as standard JavaBeans in the Java code of the
adapters and business logic POJO in your application.

public void onEvent (List newEvents)
throws RejectEventException {
for (Object event : newEvents) {
AnotherEvent anEvent = (AnotherEvent) event;
System.out.println("Age: " + anEvent.getAge());

}

= Access the event types from Oracle CQL and EPL rules:

The following Oracle CQL rule shows how you can reference the
MarketEvent in a SELECT statement:

<query id="helloworldRule">
<! [CDATA[ select AnotherEvent.age from eventChannel [Now] ]]>
</query>

1.5.4 How to Create an Oracle CEP Event Type as a Tuple

This procedure describes how to create and register an Oracle CEP event type
declaratively in the EPN assembly file as a tuple. Oracle recommends that you create
an Oracle CEP event type as a JavaBean (see Section 1.5.1, "How to Create an Oracle
CEP Event Type as a JavaBean").

For more information on valid event type data types, see Section 1.1.3.2, "Event Types
Specified as a Tuple".
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To create an Oracle CEP event type as a tuple:
1. Decide on the properties your event type requires.

2. Register your event type declaratively in the Oracle CEP event type repository:

To register declaratively, edit the EPN assembly file using the
wlevs:event-type-repository element wlevs:event-type child element
as Example 1-18 shows.

Example 1-18 EPN Assembly File event-type-repository

<wlevs:event-type-repository>
<wlevs:event-type type-name="CrossRateEvent">
<wlevs:properties>
<wlevs:property name="price" type="double"/>
<wlevs:property name="fromRate" type="char"/>
<wlevs:property name="toRate" type="char"/>
</wlevs:properties>
</wlevs:event-type>
</wlevs:event-type-repository>

At runtime, Oracle CEP generates a bean instance of CrossRateEvent for you.
The CrossRateEvent has three properties: price, fromRate, and toRate.

For more information on the valid values of the type attribute, see Section 1.1.3.2,
"Event Types Specified as a Tuple".

3. Use the event type:

= Reference the event types as standard JavaBeans in the Java code of the
adapters and business logic POJO in your application.

public void onEvent (List newEvents)
throws RejectEventException {

for (Object event : newEvents) {
CrossRateEvent anEvent =
System.out.println("Price:

(CrossRateEvent) event;
" + anEvent.getPrice());

}

m  Access the event types from Oracle CQL and EPL rules:

The following Oracle CQL rule shows how you can reference the
MarketEvent in a SELECT statement:

<query id="helloworldRule">
<! [CDATA[ select CrossRateEvent.price from eventChannel [Now] ]]>
</query>

1.5.5 Using an Event Type Builder Factory

When you register an event type in the repository using the wlevs:event-type tag,
Oracle CEP creates instances of the event using the information in the event type class.

Sometimes, however, you might want or need to have more control over how the
event type instances are created. This is required if the POJO that represents the event
does not expose the necessary getter and setter methods for the event properties. For
example, assume the event type has a £irstname property, but the EPL rule that
executes on the event type assumes the property is called fname. Further assume that
you cannot change either the event type class (because you are using a shared event
class from another bundle, for example) or the EPL rule to make them compatible with
each other. In this case you can use an event type builder factory to change the way the
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event type instance is created so that the property is named fname rather than
firstname.

When you program the event type builder factory, you must implement the
EventBuilder.Factory inner interface of the
com.bea.wlevs.ede.api.EventBuilder interface; see the Oracle CEP Java API
Reference for details about the methods you must implement, such as
createBuilder () and createEvent ().

The following example of an event type builder factory class is taken from the FX
sample:

package com.bea.wlevs.example.fx;
import java.util.HashMap;
import java.util.Map;
import com.bea.wlevs.ede.api.EventBuilder;
import com.bea.wlevs.example.fx.OutputBean.ForeignExchangeEvent;
public class ForeignExchangeBuilderFactory implements EventBuilder.Factory {
public EventBuilder createBuilder() {
return new ForeignExchangeBuilder();
}
static class ForeignExchangeBuilder implements EventBuilder {
private Map<String,Object> values = new HashMap<String,Object>(10);
public Object createEvent() {
return new ForeignExchangeEvent (
(String) values.get("symbol"),
(Double) values.get("price"),
(String) values.get("fromRate"),
(String) values.get("toRate"));
}
public void put (String property, Object value) throws IllegalStateException {
values.put (property, value);

When you register the event type in the EPN assembly file, use the
<wlevs:property name="builderFactory"> child tag of the
<wlevs:event-type> tag to specify the name of the factory class. The hard-coded
builderFactory value of the name attribute alerts Oracle CEP that it should use the
specified factory class, rather than its own default factory, when creating instances of
this event. For example, in the FX example, the builder factory is registered as shown
in bold:

<wlevs:event-type-repository>
<wlevs:event-type type-name="ForeignExchangeEvent">
<wlevs:class>com.bea.wlevs.example. fx.OutputBean$ForeignExchangeEvent</wlevs:class>
<wlevs:property name="builderFactory">
<bean id="builderFactory"
class="com.bea.wlevs.example.fx.ForeignExchangeBuilderFactory"/>
</wlevs:property>
</wlevs:event-type>
</wlevs:event-type-repository>

1.5.6 Sharing Event Types Between Application Bundles

Each Oracle CEP application gets its own Java classloader and loads application
classes using that classloader. This means that, by default, one application cannot
access the classes in another application. However, because the event type repository is
a singleton service, you can configure the repository in one bundle and then explicitly
export the event type classes so that applications in separate bundles (deployed to the
same Oracle CEP server) can use these shared event types.

Overview of Creating Oracle CEP Applications 1-29



Configuring Oracle CEP Resource Access

The event type names in this case are scoped to the entire Oracle CEP server instance.
This means that you will get an exception if you try to create an event type that has the
same name as an event type that has been shared from another bundle, but the event
type classes are different.

To share event type classes, add their package name to the Export-Package header
of the MANIFEST . MF file of the bundle that contains the event type repository you
want to share.

Be sure you deploy the bundle that contains the event type repository before all
bundles that contain applications that use the shared event types, or you will get a
deployment exception.

1.6 Configuring Oracle CEP Resource Access

By using Oracle CEP and standard Java annotations and deployment XML, you can
configure the Oracle CEP Spring container to inject resources (such as data sources or
persistence managers, and so on) into your Oracle CEP application components.

The Spring container typically injects resources during component initialization.
However, it can also inject and re-inject resources at runtime and supports the use of
JNDI lookups at runtime.

Oracle CEP supports the following types of resource access:
= Section 1.6.1, "Static Resource Injection”

m  Section 1.6.2, "Dynamic Resource Injection"

= Section 1.6.3, "Dynamic Resource Lookup Using JNDI"

See Section 1.6.4, "Understanding Resource Name Resolution" for information on
resource name resolution.

See Appendix G, "Oracle CEP Metadata Annotation Reference" for complete details of
all Oracle CEP annotations.

In the following sections, consider the example resource that Example 1-19 shows.
This is a data source resource named StockDS that you specifiy in the Oracle CEP
server config.xml file.

Example 1-19 Sample Resource: Data Source StockDS

<config ...>
<data-source>
<name>StockDs</name>

<driver-params>
<url>jdbc:derby:</url>

<driver-params>
</data-source>

</config>

1.6.1 Static Resource Injection

Static resource injection refers to the injection of resources during the initialization
phase of the component lifecycle. Once injected, resources are fixed, or static, while the
component is active or running.

You can configure static resource injection using:
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s Section 1.6.1.1, "Static Resource Names"

s Section 1.6.1.2, "Dynamic Resource Names"

1.6.1.1 Static Resource Names

When you configure static resource injection using static resource names, the resource
name you use in the @Resource annotation or Oracle CEP assembly XML file must
exactly match the name of the resource as you defined it. The resource name is static in
the sense that you cannot change it without recompiling.

To configure static resource injection using static resource names at design time, you
use the standard javax.annotation.Resource annotation as Example 1-20
shows.

To override design time configuration at deploy time, you use Oracle CEP assembly
file XML as Example 1-21 shows.

In Example 1-20 and Example 1-21, the resource name St ockDs exactly matches the
name of the data source in the Oracle CEP server config.xml file as Example 1-19
shows.

Example 1-20 Static Resource Injection Using Static Resource Names: Annotations

import javax.annotation.Resource;
public class SimpleBean implements EventBean {

@Resource (name="StockDs")
public void setDataSource (DataSource dataSource) {
this.dataSource = dataSource;

Example 1-21 Static Resource Injection Using Static Resource Names: XML

< wlevs:event-bean id="simpleBean" class="...SimpleBean"/>
<wlevs:resource property="dataSource" name="StockDs"/>
</wlevs:event-bean>

If the name of the EventBean set method matches the name of the resource, then the
@Resource annotation name attribute is not needed as Example 1-22 shows.
Similarly, in this case, the wlevs: resource element name attribute is not needed as
Example 1-23.

Example 1-22 Static Resource Injection Using Static Resource Names: Annotations

import javax.annotation.Resource;
public class SimpleBean implements EventBean {

@Resource ()
public void setStockDs (DataSource dataSource) {
this.dataSource = dataSource;

Example 1-23 Static Resource Injection Using Static Resource Names: XML

< wlevs:event-bean id="simpleBean" class="...SimpleBean"/>
<wlevs:resource property="dataSource"/>
</wlevs:event-bean>
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1.6.1.2 Dynamic Resource Names

A dynamic resource name is one that is specified as part of the dynamic or external
configuration of an application. Using a dynamic resource name, the deployer or
administrator can change the resource name without requiring that the application
developer modify the application code or the Spring application context.

To add a dynamic resource name to a component, such as an adapter or POJO, you
must first specify custom configuration for your component that contains the resource
name as Example 1-24 shows.

Example 1-24 Custom Component Configuration

<simple-bean>
<name>SimpleBean</name>
<trade-datasource>StockDs</trade-datasource>
</simple-bean>

To configure static resource injection using dynamic resource names at design time,
you use the standard javax.annotation.Resource annotation as Example 1-25
shows.

To override design time configuration at deploy time, you use Oracle CEP assembly
file XML as Example 1-26 shows.

Example 1-25 Static Resource Injection Using Dynamic Resource Names: Annotations

import javax.annotation.Resource;

public class SimpleBean implements EventBean {

@Resource (name="trade-datasource")
public void setDataSource (DataSource dataSource) {
this.dataSource = dataSource;

Example 1-26 Static Resource Injection Using Dynamic Resource Names: XML

< wlevs:event-bean id="simpleBean" class="...SimpleBean"/>
<wlevs:resource property="dataSource" name="trade-datasource"/>
</wlevs:event-bean>

1.6.2 Dynamic Resource Injection

Dynamic resource injection refers to the injection of resources dynamically while the
component is active in response to a dynamic configuration change using Spring
container method injection.

To configure dynamic resource injection at design time, you use the standard
javax.annotation.Resource annotation as Example 1-27 shows.

Example 1-27 Dynamic Resource Injection: Annotations
import javax.annotations.Resource;
public class SimpleBean implements EventBean {

@Resource ("trade-datasource")
public abstract DataSource getDataSource ();
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The component calls the getDataSource () method at run time whenever it needs to
retrieve a new instance of the resource that the resource name trade-datasource
refers to.

Typically, the component calls the getDataSource () method during the @Prepare
or @Activate methods when dynamic configuration changes are handled. For more
information see:

= Section G.2, "com.bea.wlevs.management.Activate"
= Section G.3, "com.bea.wlevs.management.Prepare”

Another strategy is to always call the getDataSource () prior to using the data
source. That is, the application code does not store a reference to the data source as a
field in the component.

1.6.3 Dynamic Resource Lookup Using JNDI

Oracle CEP supports the use of JNDI to look up resources dynamically as
Example 1-28.

Example 1-28 Dynamic Resource Lookup Using JNDI

import javax.naming.InitialContext;

public class SimpleBean implements EventBean {

public abstract void getDataSource () throws Exception {
InitialContext initialContext= new InitialContext ();
return initialContext.lookup ("StockDs”);
}
}
In Example 1-28, the JNDI name StockDs must exactly match the name of the data

source in the Oracle CEP server config.xml file as Example 1-19 shows.

Note: You must disable security when starting the Oracle CEP server
in order to use JNDI. Oracle does not recommend the use of JNDI for
this reason.

For more information, see "Configuring Security for Oracle CEP" in
the Oracle CEP Administrator’s Guide.

1.6.4 Understanding Resource Name Resolution

Oracle CEP server resolves resource names by examining the naming scopes that
Table 1-3 lists.

Table 1-3 Resource Name Resolution

Naming Scope | Contents Resolution Behavior
Component The property names of the component’s custom configuration | Mapping
Application The names of the configuration elements in the application Matching

configuration files

Server The names of the configuration elements in the server Matching
configuration file

JNDI The names registered in the server's JNDI registry Matching
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Each naming scope contains a set of unique names. The name resolution behavior is
specific to a naming scope. Some naming scopes resolve names by simple matching.
Other scopes resolve names by mapping the name used to do the lookup into a new
name. Once a name is mapped, lookup proceeds recursively beginning with the
current scope.

1.7 Next Steps

After you have programmed all components of your application and created their
configuration XML files:

Assemble all the components into a deployable OSGi bundle. This step also
includes creating the MANIFEST . MF file that describes the bundle.

See Section 14.2, "Assembling an Oracle CEP Application."
Start Oracle CEP.

See:

— Section 4.3.1, "How to Start an Oracle CEP Server"

- Section 4.3.2, "How to Stop an Oracle CEP Server"

Optionally configure the server in your domain to enable logging, debugging, and
other services.

See:
—  Section 4.2, "Creating Oracle CEP Servers"
—  Section 4.3, "Managing Oracle CEP Servers"

- "Understanding Oracle CEP Configuration” in the Oracle CEP Administrator’s
Guide

Deploy the application to Oracle CEP.
See Section 14.3, "Deploying Oracle CEP Applications."

Optionally, use the Oracle CEP load generator and Oracle CEP Visualizer to test
and tune your Oracle CEP application.

The Oracle CEP load generator is a testing tool that you can use to test your
application, in particular its rules. This testing tool can temporarily replace the
adapter component in your application, for testing purposes. For details, see
Chapter 15, "Testing Applications With the Load Generator and csvgen Adapter."

The Oracle CEP Visualizer is a runtime administration console with advanced
diagnostic and maintenance features that you can use to manage and tune your
Oracle CEP application. For details, see Oracle CEP Visualizer User’s Guide.d

See also Section 4.4, "Debugging an Oracle CEP Application Running on an Oracle
CEP Server".
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Oracle CEP IDE for Eclipse

Part II contains the following chapters:

Chapter 2, "Overview of the Oracle CEP IDE for Eclipse"

Chapter 3, "Oracle CEP IDE for Eclipse Projects"

Chapter 4, "Oracle CEP IDE for Eclipse and Oracle CEP Servers"

Chapter 5, "Oracle CEP IDE for Eclipse and the Event Processing Network"






2

Overview of the Oracle CEP IDE for Eclipse

Oracle CEP IDE for Eclipse is an IDE targeted specifically to programmers that want to
develop Oracle CEP applications.

This chapter describes:

Section 2.1, "Overview of Oracle CEP IDE for Eclipse"
Section 2.2, "Installing the Latest Oracle CEP IDE for Eclipse"

Section 2.3, "Installing the Oracle CEP IDE for Eclipse Distributed With Oracle
CEP"

Section 2.4, "Configuring Eclipse"

2.1 Overview of Oracle CEP IDE for Eclipse

Oracle CEP IDE for Eclipse is a set of plugins for the Eclipse IDE designed to help
develop, deploy, and debug applications for Oracle CEP.

The key features of the Oracle CEP IDE for Eclipse are as follows:

Project creation wizards and templates to quickly get started building event driven
applications.

Advanced editors for source files including Java and XML files common to Oracle
CEP applications.

Integrated server management to seamlessly start, stop, and deploy to Oracle CEP
server instances all from within the IDE.

Integrated debugging.

Event Processing Network (EPN) visual design views for orienting and navigating
in event processing applications and visually creating and editing EPN
components.

Oracle CEP application source file validation including Oracle Continuous Query
Language (Oracle CQL) syntax highlighting and component configuration and
assembly files.

Ability to build and export deployable Oracle CEP applications.

Integrated support for the Oracle CEP Visualizer so you can use the Oracle CEP
Visualizer from within the IDE.

In Release 11gR1 (11.1.1), Oracle CEP IDE for Eclipse requires JDK 6.0. For more
information, see:

"Setting Your Development Environment" in the Oracle CEP Getting Started
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Section 2.4, "Configuring Eclipse”

2.2 Installing the Latest Oracle CEP IDE for Eclipse

New versions of the IDE will be made available via the Oracle Technology Network
Web site. Oracle recommends that you install the IDE from this Eclipse update site:

http://download.oracle.com/technology/software/cep-ide/11/

To install the latest Oracle CEP IDE for Eclipse:

1.

Obtain the required versions of Eclipse (3.3.2) and WTP (2.0). We recommend you
take the entire Europa installation available at the following Web sites:

Windows:
http://www.eclipse.org/downloads/download.php?file=/technolog
y/epp/downloads/release/europa/winter/eclipse-jee-europa-wint
er-win32.zip

Linux:
http://www.eclipse.org/downloads/download.php?file=/technolog
y/epp/downloads/release/europa/winter/eclipse-jee-europa-wint
er-linux-gtk.tar.gz

Note: Check the Oracle CEP Web site
(http://www.oracle.com/technologies/soa/complex-even
t-processing.html) for the latest requirements on the Eclipse
tools.

Open your Eclipse IDE and select the menu item Help > Software Updates > Find
and Install.

The Install/Update dialog appears as Figure 2-1 shows.
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Figure 2—-1 Install/Update Dialog

& Install/Update

Feature Updates

Choose the way you want ko search For Features ko install

() search for updates of the currently installed Features

Select this option if vou want ko search For updates of the features vou already have installed.

Select this option if vou want ko install new features From existing or new update sites, Some sites may already be
available. You can add new update site URLs to the search.

3. Select the Search for New Features option.
4. Click Next.
The Update Sites to Visit dialog appears as Figure 2-2 shows.

Overview of the Oracle CEP IDE for Eclipse 2-3



Installing the Latest Oracle CEP IDE for Eclipse

Figure 2-2 Update Sites to Visit Dialog

& Install

Update sites to visit
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O v;.r araphical Editing Framewark {GEF) Update Site
O v: Model Developement Tools (MDT) Updates

[ Sl Mylyn

|:| \q,r Mylyn Extras

O \r: The Eclipse Project Updates

o
[ %ilweb Tools PlatForm (W TF) Updates Import sites. ..,
Exzport sites...

‘DIL
Sites ko include in search:

Ignore Features not applicable ko this environment

[ automatically select mirrors

Finish ] [ Cancel

5. Click New Remote Site.
The New Update Site dialog appears as Figure 2-3 shows.

Figure 2-3 New Update Site Dialog

& New Lipdate Site

Marne: |

URL: | hiepsif

@ [ Ok l [ Cancel ]

6. Configure this dialog as Table 2-1 describes.

Table 2-1 New Update Site Dialog Attributes

Attribute | Description

Name The name for this remote update site. For example: Oracle CEP Tools
Update.
URL The URL to the Oracle Technology Network Web site. Valid value:

http://download.oracle.com/technology/software/cep-ide/11/

7. Click OK.
8. Complete the Update Manager, selecting to install the Oracle CEP tools.

9. When prompted restart, Eclipse. If you skip this, unreliable behavior can occur.
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10. To confirm the installation, select Help > About Eclipse Platform.

The About Eclipse Platform dialog appears as Figure 2—4 shows.

Figure 2-4 About Eclipse Platform

& About Eclipse Platform

Eclipse Platform

Yersion: 3.3.2
Build id: M20030221-1500

() Copyright Eclipse contributors and others 2000, 2008, All rights reserved.
Wisit hktp:f e, eclipse, orgfplatform

This praduct includes software developed by the
Apache Software Foundation http: /vy, apache. orgf

SEZ %

':':’:' [Eeature Details ] EEIug-in Detailsij [gonfiguration Details

11. Click Plug-In Details.
The About Eclipse Platform Plug-ins dialog appears as Figure 2-5 shows.

Figure 2-5 About Eclipse Platform Plug-ins Dialog

& About Eclipse Platform Plug-ins

Si... | Provider Flug-in Mame Yersion Plug-in Id G
Eclipse.arg Flug-in Development UI 3.3.1.w2007...  org.eclipse.pde.ui
53] Eclipse.arg Inkegration Plug-in 1.1.102.%20,.,  org.eclpse.jst. common. framewarks
Eclipse.org Htkp Services Serviet 1.0.1.R33%_... org.eclpse.equino:x.http.servlet
] Eclipse.arg EMF Annotated Java Imporker 2,3.1.w2008... org.eclipse.emf.impaorter.java
EE Eclipse.org Common] S0 2.3.0.v20058...  org.eclipse.emf.commonj.sdo
S| Eclipse.arg Servlet infopop 1.0.202.v20,.. org.eclipse.jst. servlet, ui.infopop
23] IEM Corporation IC1U4] Data Update Fragment 3.6,1.42008.,,  com.ibm.icu3e,data,update
IEM Corporation International Components for U...  3.6.1.%2007...  com.ibm.icu
Jiraft, Inc, J5ch 0.1.31 com, jcraft.jsch
|1_§- le 1 ¥
COracle Oracle CEP Toals UL 11.1.0.2009,,.  com.bea.wlevs eclipse tools,ui
Oracle Oracle CEP Tools Documentation 11.1.0.2009...  com.bea.wlevs eclipse. tools,doc
[ES] WS0Z Webservice Axis2 UI Plug-in 1.0.1.v2007... org.eclpse.jst.ws.axis2.ui
EE WSOZ Webservice Axis2 Consumption,..  1.0,2,%2008,,,  org.ecipse.jst.ws.axis2,consumpti..,
B WSOZ Webservice Axis2 Creation Car...  1.0.2.42007...  org.ecipse.jst.ws.axis2, creation.c...
Ea WSOZ Webservice Axis2 Consumption...  1.0.1.%2007..,  org.eclipse.jst.ws.axis2,consumpti. .,
[EE WI0Z Webservice AxisZ Core Plug-in 1.0.2.v2007... org.eclpse.jst.ws, axis2.core
S| W02 Webservice Axis2 Creation ULP... 1.0.2.%2008... org.edipse.jst.ws.axis2.creation.ui 3
v
@

12. Scroll down in the list and confirm that the plug-ins that Table 2-2 lists are shown.

Table 2-2 Oracle CEP IDE for Eclipse Plug-Ins

Provider | Plug-in Name Plug-in Id

Oracle Oracle CEP Tools Core com.bea.wlevs.eclipse.tools.core
Oracle Oracle CEP Tools UI com.bea.wlevs.eclipse.tools.ui
Oracle Oracle CEP Tools Documentation | com.bea.wlevs.eclipse.tools.doc
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13. After installing Oracle CEP IDE for Eclipse, consider the following configuration
topics:

= Section 2.4, "Configuring Eclipse"

2.3 Installing the Oracle CEP IDE for Eclipse Distributed With Oracle CEP

A version of the Oracle CEP IDE for Eclipse is shipped with the Oracle CEP product,
although this version might be older than the one on the Oracle Technology Network
site.

To install the Oracle CEP IDE for Eclipse distributed with Oracle CEP:

1. Obtain the required versions of Eclipse (3.3.2) and WTP (2.0). We recommend you
take the entire Europa installation available at the following Web sites:

Windows:
http://www.eclipse.org/downloads/download.php?file=/technolog
y/epp/downloads/release/europa/winter/eclipse-jee-europa-wint
er-win32.zip

Linux:
http://www.eclipse.org/downloads/download.php?file=/technolog
y/epp/downloads/release/europa/winter/eclipse-jee-europa-wint
er-linux-gtk.tar.gz

2. Open your Eclipse IDE and select the menu item Help > Software Updates > Find
and Install.

The Install/Update dialog appears as Figure 2-1 shows.

Figure 2—6 Install/Update Dialog

& Install/Update |:|@@
Feature Updates |

Choose the way vou want ko search For Features ko install :IN:_

() search for updates of the currently installed features

Select this option if vou want ko search For updates of the features vou already have installed.

Select this option if vou want ko install new features From existing or new update sites, Some sites may already be
available. You can add new update site URLs to the search.
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3. Select the Search for New Features option.
4. Click Next.
The Update Sites to Visit dialog appears as Figure 2-2 shows.

Figure 2-7 Update Sites to Visit Dialog

& Install

Update sites to visit

Select update sites ko visit while looking For new Features,

Sikes to include in search:

O \!E Dali Java Persistence API Tools {JPA) Updates Mew Remoke Site. ..

O \!E Diaka Tools PlatForm {DTP) Updates

[ “flEclipse Modeling Framewark Technologiss (EMFT) Updates Mew Local Site. ..
n . N
E & EMF Service Data Objects (SDO) Updates New Archived Ste. .
&l

Europa Discovery Sike

O \JE Garaphical Editing Framework {GEF) Update Site
O \!E Model Developement Tools (MDT) Updates

[ il mylyn

[ Sl Mylyn Extras

O \!E The Eclipse Project Updates

W
[ %l 'web Tools PlatForm (WTP) Updates Import sikes. ..
Expart sites. ..

Ignore features not applicable ko this environment

[ automatically select mirrors

@

Finish ] [ Cancel

5. Click New Archived Site.
The Select Local Site Archive dialog appears as Figure 2-8 shows.

Figure 2-8 Select Local Site Archive Dialog

Select Local Site Archive

Loak jn: |_}eclipse-update-site V| O ¥ = '

My Recent
Documents

Deskiop

My Documents

ty Computer

File name: | ceprtocls-11.0.0.20090319-2158.2ip | Open
Py Netwark. Files of tpe: | * jar" zip v | [ Cancel ]
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6.

Navigate to the ORACLE_CEP_HOME/ocep_11.1/eclipse-update-site

directory and select the cep-tools-11.0.0.DATE-BUILD. zip file.

Where ORACLE_CEP_HOME refers to the main directory into which you installed
Oracle CEP, such as /oracle_cep, and DATE is the build date and BUILDis the

build number.

7. Click Open.

8. Complete the Update Manager, selecting to install the Oracle CEP tools.

9. When prompted restart, Eclipse. If you skip this, unreliable behavior can occur.
10. To confirm the installation, select Help > About Eclipse Platform.

The About Eclipse Platform dialog appears as Figure 2—4 shows.

Figure 2-9 About Eclipse Platform

& About Eclipse Platform

Eclipse Platform

Yersion: 3.3.2
Build id: M20050221-1300

() Copyright Eclipse contributors and others 2000, 2008, All rights reserved.
Yisit hkkp: S iana, eclipse. orgfplatForm

This praduct includes software developed by the
Apache Software Foundation http: /vy, apache. orgf

S E %=

':-_’:' [Eeature Details] EEIug-in Detailsﬂ [gonfiguration Details

1.

Click Plug-In Details.
The About Eclipse Platform Plug-ins dialog appears as Figure 2-5 shows.

Figure 2-10 About Eclipse Platform Plug-ins Dialog

& About Eclipse Platform Plug-ins

Si... | Provider Flug-in Mame Yersion Plug-in Id G
Eclipse.arg Flug-in Development UI 3.3.1.w2007...  org.eclipse.pde.ui
53] Eclipse.arg Inkegration Plug-in 1.1.102.%20,.,  org.eclpse.jst. common. framewarks
Eclipse.org Htkp Services Serviet 1.0.1.R33%_... org.eclpse.equino:x.http.servlet
[E2S] Eclipse.org EMF Annotated Java Imporker 2.3.1.w2008... org.ecipse.emf.imparter.java
EE Eclipse.org Common] S0 2.3.0.v20058...  org.eclipse.emf.commonj.sdo
S| Eclipse.arg Servlet infopop 1.0.202.v20,.. org.eclipse.jst. servlet, ui.infopop
23] IEM Corporation IC1U4] Data Update Fragment 3.6,1.42008.,,  com.ibm.icu3e,data,update
IEM Corporation International Components for U...  3.6.1.%2007...  com.ibm.icu
Jiraft, Inc, J5ch 0.1.31 com, jcraft.jsch
Ig_;- Oracle e
COracle Oracle CEP Toals UL 11.1.0.2009,,.  com.bea.wlevs eclipse tools,ui
Oracle Oracle CEP Tools Documentation 11.1.0.2009...  com.bea.wlevs eclipse. tools,doc
[ES] WS0Z Webservice Axis2 UI Plug-in 1.0.1.v2007... org.eclpse.jst.ws.axis2.ui
EE WSOZ Webservice Axis2 Consumption,..  1.0,2,%2008,,,  org.ecipse.jst.ws.axis2,consumpti..,
B WSOZ Webservice Axis2 Creation Car...  1.0.2.42007...  org.ecipse.jst.ws.axis2, creation.c...
Ea WSOZ Webservice Axis2 Consumption...  1.0.1.%2007..,  org.eclipse.jst.ws.axis2,consumpti. .,
[EE WI0Z Webservice AxisZ Core Plug-in 1.0.2.v2007... org.eclpse.jst.ws, axis2.core
S| W02 Webservice Axis2 Creation ULP... 1.0.2.%2008... org.edipse.jst.ws.axis2.creation.ui 3
v
@
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12. Scroll down in the list and confirm that the plug-ins that Table 2-2 lists are shown.

Table 2-3 Oracle CEP IDE for Eclipse Plug-Ins

Provider | Plug-in Name Plug-in Id

Oracle Oracle CEP Tools Core com.bea.wlevs.eclipse.tools.core
Oracle Oracle CEP Tools Ul com.bea.wlevs.eclipse.tools.ui
Oracle Oracle CEP Tools Documentation | com.bea.wlevs.eclipse.tools.doc

13. After installing Oracle CEP IDE for Eclipse, consider the following configuration

topics:

= Section 2.4, "Configuring Eclipse"

2.4 Configuring Eclipse

This section describes how to configure Eclipse to work with the Oracle CEP.

To configure Eclipse:

1.
2

Exit out of Eclipse if it is running.
Install a Java 6 JRE on your computer.

The JRockit Java 6.0 JRE is installed with Oracle CEP in your Oracle CEP home
directory. For example:

C:\OracleCEP\jrockit-R27.6.0-50-1.6.0_05\jre

Using the editor of your choice, open your eclipse. ini file located in your
Eclipse install directory, for example, C: \eclipse as Example 2-1 shows.

Example 2—-1 Default eclipse.ini File

-showsplash
org.eclipse.platform
--launcher.XXMaxPermSize
256M

4,

Note: When making changes to the eclipse.ini file, add
arguments one argument per line, as
http://wiki.eclipse.org/Eclipse.ini describes.

For more information about configuring Eclipse, see
http://wiki.eclipse.org/FAQ How_do_I_run_Eclipse.

Add the following lines to the eclipse. ini file as Example 2-2 shows.

Example 2-2 Memory Resources

-showsplash
org.eclipse.platform
--launcher.XXMaxPermSize
256M

-vmargs

-Xmx512m
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-XX:MaxPermSize=256M

5. Add the following to the eclipse. ini file as Example 2-3 shows.

Example 2-3 Virtual Machine Path
-vm

PATH-TO-JRE-6.0-JAVAW

Where PATH-TO-JRE-6. 0-JAVAWis the fully qualified path to your Java 6.0 JRE
javaw executable. For example:

-vm
C:\OracleCEP\jrockit-R27.6.0-50-1.6.0_05\jre\bin\javaw.exe

Note: Do not put both the -vm and the path on the same line. Each
must be on a separate line as Example 2-3 shows.

6. Save and close the eclipse. ini file.
7. Start Eclipse.
8. Select Help > About Eclipse Platform and click Configuration Details.

The Configuration Details dialog appears as shown in Figure 2-11.

Figure 2-11 Configuration Details for Java 6

& Configuration Details

Eclipse o
——launcher. library
Ciheclipseipluginsiorg.eclipse.equinox. launcher. win32 . win3z . x36
-startup
Ciheclipsehpluginsiorg.eclipse.equinox. launcher 1.0.1.R33x_w200
—vm

C:yProgram FileshJaval jredibini\clienth jvm.dll
eclipse.ee.install.verify=false
eclipse.product=org.eclipse.platform. ide
eclipse.startTinme=1232465723100

Program File jresh yelienth Jvm.dll
eclipse.vmargs=-Dosgi.requireddavaVersion=1.5
—Hms40m
—HmxS518m

—HEE:MaxPerm3ize=256H1
-Djawva.class.path=Ciheclipsehpluyinshorg.eclipse.equinox. launch
eof=eof

file.encoding=Cpl252

file.encoding.pkg=sun.io

file.separator=}

Sl *

@ [Eiew Error Log ] [Copy to Clipboard ]

9. Confirm that the eclipse.vm property points to the Java 6.0 JRE you configured
in the eclipse. ini file.

10. Open the Oracle CEP project you originally created using Java 5.
11. Select Window > Preferences.

The Preferences dialog appears as shown in Figure 2-12.
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Figure 2-12 Preferences Dialog

& Preferences

|type filker text |

General
Ant
Caonneckivity
Help
InstalljUpdate
Inkernet
Java
IPA
Telylyr
Oracle CEP Problem Severities
Plug-in Developrment
Run/Debug
[=)- Server
Audio
Installed Runtimes
Launching
S0L Developrnent
Team
Walidation
Wb and sML
Web Services

Installed Server Runtime Environments

Add, remove, or edit installed server runtime definitions.

Installed server runtimes:

Mame
[k oracle CEP w11

Type
Oracle CEP w11

| add.

Search

sDoclet
12. Expand the Server option and select Installed Runtimes.

13.
14.
15.

Select a runtime that uses the Java 6 JRE.
Click OK.
Right-click your project and select Properties.

The Project Properties dialog appears as shown in Figure 2-13.
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Figure 2-13 Project Properties Dialog: Java Build Path

[evme Fileer test | Java Build Path e
Resouree | ——— EE PR e R SO 7
Beanlnfa Path | € source | & Projects | B Libraries | % order and Export |
Builders J4Rs and class Folders on the build path:

Java Build Path
R Bl JRE System Library [jre1.6.0_07] Add JARs. .

Java Code Style
& . i B OCEP Classpath
ava Camnpiler Add External JARs...

Java Editor
Javadoc Location

Plug-in Developrment
Profile Compliance and Yalidatic Add Library. ..
Project Facets
Project References
Refackoring History
Run{Debug Settings
Targeted Runtimes

Task Repository
Task Tags
Yalidation

“Doclet

Add Class Faolder...

il

l [ Cancel

&
o
-

16. Select the Java Build Path option and click on the Libraries tab.

17. Select the existing JRE System Library [jre1.5.0_XX] Java 5.0 library and click
Remove.

18. Create a new JRE System Library for Java 6.0 by clicking Add Library and
choosing the Java 6.0 JRE.

19. Select the Project Facets option.
The Project Facet properties are displayed as Figure 2-14 shows.
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Figure 2-14 Project Properties Dialog: Project Facets

& Properties for COLDBTest

|type filker text | Project Facets

- Resource

- BeanInfo Path

- Builders

- Java Build Path

- Java Code Style

- Java Cornpiler

- Java Edikor

- Javadoc Location

- Oracle CEP Problem Sewverities
-Plug-in Development

- Profile Compliance and Yalidatic

Yersion

5.0
111

Projeck Facet

Java
Oracle CEP

B
BB

ol
=

- Project References
- RunfDebug Settings
- Targeted Runtimes
-Task Repository

- Task Tags

- Yalidation

- ®Doclet

ol
=

Modify Project...

@ I Ok ] [ Cancel

]

20. Click Modify Project.
The Modify Faceted Project dialog appears shown in Figure 2-15.

Figure 2-15 Modify Faceted Project

£ Modify Faceted Project

Project Facets
Select the Facets that should be enabled for khis project,

Configurations: |<cust0m> v| [ Save ] [ Delete ]
Project Facet Runtimes:
[Z1&F] Java G oracle CEP w111

[l oracle CEP

[5haw all runtimes

Runtime Composition:

Gl oracle CEP w114
B IRE 6.0: jrel.6,0_07

Hide Runtimes ==

':-_’:' = Back MNext = [ ] [ Cancel

Finish

21. For the Java facet, select 6.0 from the Version pull-down menu.

22. Click Finish.
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23. Click OK.

Your project will now build and run using Java 6.0.
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Oracle CEP IDE for Eclipse Projects

An Oracle CEP project is an Eclipse project that brings together all Oracle CEP
artifacts.

This chapter describes:

»  Section 3.1, "Oracle CEP Project Overview"

»  Section 3.2, "Creating Oracle CEP Projects"

= Section 3.3, "Exporting Oracle CEP Projects"

= Section 3.4, "Upgrading Projects"

= Section 3.5, "Managing Oracle CEP Project Libraries"

= Section 3.6, "Configuring Oracle CEP IDE for Eclipse Preferences"

3.1 Oracle CEP Project Overview
An Oracle CEP application includes the following artifacts:
» Java source files
» XML configuration files
= OSGi bundle Manifest file

Figure 3-1 shows the Explorer after creating a project.
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Figure 3—1 Oracle CEP Project Structure

=
==
ER=d Hello
B src

4 com.bea.wlevs. example. helloworld
B JRE System Library [jrel.6.0_02]

B, Flug-in Dependencies

(&= build

& META-INF

- spring

- BB

MANIFEST.MF (-

4 com.bea.wlevs.adapter.example.helloworld

4 com.bea.wlevs.event.example helloworld 1_- Java Files

|¥] Hello.context. xml ‘_/
B wilevs
1% config.xml

__— XML Configuration

— Files

Bundle Manifest

@a build.properties

&1 build il

Table 3-1 summarizes the important files in an Oracle CEP project including their use

and location.

Table 3—1

Oracle CEP Project Artifacts

File Type Location

Description

Java source files

Default: src.

Any Java source folder.

Events, adapters, and listeners are implemented in an
Oracle CEP application with Java files. All Java files must
be in a source folder in order to be compiled.

For more information, see Chapter 1, "Overview of
Creating Oracle CEP Applications".

EPN assembly file

META-INF/spring

These are the main files used to wire-up an EPN and to
define event types. This is a Spring context file, and is
where adapters, channels, processors, and listeners are
connected.

For more information, see Chapter 1.1.7, "EPN Assembly
File".

Processor
configuration file

META-INF/wlevs

The processor configuration file is where the Complex
Event Processor (CEP) is defined. In this file you'll find
processor rules (defined in the Continuous Query
Language - CQL or the Event Processing Language--EPL)
and other component configuration settings.

For more information, see:

. Chapter 10, "Configuring Oracle CQL Processors"

= Chapter 11, "Configuring EPL Processors"

MANIFEST.MF file | META-INF

The manifest file contains metadata about your application
including its name, version, and dependencies, among
others.

For more information, see Chapter 14, "Assembling and
Deploying Oracle CEP Applications".

3.2 Creating Oracle CEP Projects

Development of an Oracle CEP application begins by creating a project to hold all

source code and related files.
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Projects correspond 1-to-1 with Oracle CEP applications and are the unit of work that
is associated with and deployed to a server instance. In concrete terms, the output of a
built project is a single OSGi bundle (JAR) containing the Oracle CEP application.

3.2.1 How to Create an Oracle CEP Project

By default new projects are set to use Java 6.0. This section describes how to create an
Oracle CEP project using Java 6. For information on configuring an Oracle CEP project
to use Java 6, see Section 2.4, "Configuring Eclipse".

To create an Oracle CEP project:
1. Open the EPN Editor (see Section 5.1, "Opening the EPN Editor")

2. Select File > New Project.
The New Project - Select a Wizard dialog appears as shown in Figure 3-2.

Figure 3-2 New Project - Select a Wizard Dialog

& New Project |Z|@@

Select a wizard

57

wWizards:

|type filker best

= General

= Vs

== Eclipse Madeling Framework
= EXB

& 12EE

= Java

= P4

= web
= Examples

3. Expand Oracle CEP and select Oracle CEP Application Project.
4. Click Next.

The New Oracle CEP Application Project wizard appears as shown in Figure 3-3.
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Figure 3-3 New Oracle CEP Application Project Wizard: Create an Oracle CEP

Application

& New Qracle CEP Application Project

Create an Oracle CEP Application.
Create an Oracle CEP Application Project,

- BX

Project name: | MyCEPProj|

s default lacation

Location:

Target Runtime

| Oracle CEP v11.1

@ [ < Back “ Mext » ]

5. Configure the Create an Oracle CEP Application dialog as shown in Table 3-2.

Table 3-2 Create an Oracle CEP Application Dialog

Attribute

Description

Project name

The name of your Oracle CEP project. This name will be used as
the default name of your application when it is deployed to the
Oracle CEP server.

Location

The directory in which your project is stored.

By default your project is located inside the Eclipse workspace
directory.

To keep your workspace and source code control directories
separate, uncheck Use default location and click Browse to
place the project in a directory outside of your workspace.

Target Runtime

The Oracle CEP server you will deploy your project to.

6. Click Next.

The Oracle CEP Application Content dialog appears as shown in Figure 3—4.
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Figure 3-4 New Oracle CEP Application Project Wizard: Oracle CEP Application Content

& New Qracle CEP Application Project

Oracle CEP Application Content
Enter the data required to create application. \% |

Bundle Properties
Bundle ID: My CEPProj

Bundle Yersion: | 1.0.0
Bundle Mame: My CEPProj

Bundle Provider:

@ [ <Back |} Mext > |[ Firish H Cancel ]

7. Optionally, configure the Oracle CEP Application Content dialog as shown in
Table 3-3.

Table 3-3 Oracle CEP Application Content Dialog

Attribute Description

Bundle ID The unique ID that distinguishes this application’s OSGi bundle
from those deployed to the target runtime.

Bundle Version The version of this instance of this OSGi bundle.

Bundle Name The name of this application’s OSGi bundle.

Bundle Provider The name of the provider for this application’s OSGi bundle
(optional).

8. Click Next.

The Template dialog appears as shown in Figure 3-5.
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Figure 3-5 New Oracle CEP Application Project Wizard: Template Dialog

& New Qracle CEP Application Project

New Oracle CEP Application Project
Select one of the available kernplates to generate a Fully Functioning Oracle
CEP Application a—

Create an Oracle CEP Application using an application template

Termplates:
@Fx | & Hello World application For the Oracle CEP server, A
= It includes a simple adapter that repeatedly sends a |
Hello orld s
: . | Hello Warld message. The message is printed out o
[ signal Generation et et

[ Finish ][ Cancel ]

9. Optionally, select an Oracle CEP application template to pre-populate your project
with the content that the template specifies.

10. Click Finish.
The Oracle CEP IDE for Eclipse creates the Oracle CEP project.

3.3 Exporting Oracle CEP Projects

Exporting an Oracle CEP project builds the project into an OSGi bundle that can be
deployed to a production Oracle CEP server.

3.3.1 How to Export an Oracle CEP Project

This section describes how to export an Oracle CEP project into an OSGi bundle.

To export an Oracle CEP project:
1. Start the Oracle CEP IDE for Eclipse and open your Oracle CEP project.

2. The Oracle CEP IDE for Eclipse compiles and adds Java resources to the exported
JAR automatically. If your project contains other resources (such as a manifest file
or images), configure your project to export them:

a. Locate the build.properties file in the Project Explorer and double-click
this file to edit it.

The build.properties file opens as shown in Figure 3-6.
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Figure 3-6 Oracle CEP Project build.properties File

Fﬁ;‘g EPM: Hellowvaorld @a *build. properties 3 =8
& Build Configuration @
[ custom Build

Runtime Information

Define the libraries, specify the order in which they shauld be built, and list the source Folders that should be compiled into each
selected library.

Bk, add Library,..

Binary Build Source Build
Select the Folders and files to include in the binary build, Select the Folders and files toinclude in the source build,
T —
\settings ~ [7[%] .classpath ”
= META-INF % project
b [ (= build ] .settings
@b build. properties []E= META-INF
1) build,xml ] buid
bundle . properties F 3} build properties
& dist 4] build.xml
(=] [H] = images [ E bundle.properties
. .tj example-resource. jpg | = dist =
src% v [ images v

\___/

b Extra Classpath Entries

Build | build. properties

b. In the Binary Build area, check the resources you want exported with your
application.
3. Select File > Export.

The Export dialog appears as shown in Figure 3-7.
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Figure 3—-7 Export Dialog

Select

Export Oracle CEP applications to a form suitable For deployment to an
external Oracle CEP server.

Select an export destination:

|type filker text |

(= General
= EB

(= IzEE

(= Java

(= Mylyn
== Cracle CEP

(= Plug-in Development
(= Team

= Web

(= Web Services

@

4. Expand the Oracle CEP option and select Oracle CEP Applications.

5. Click Next.
The Oracle CEP Applications Export: Select Project dialog appears as shown in
Figure 3-8.

Figure 3-8 Oracle CEP Applications Export: Select Project Dialog

& Oracle CEP Applications

Oracle CEP Applications

Select the projects ko export as Oracle CEP applications and the » E|
directory where they will be placed, 1

Available Projects:

Praject Cutput File Select Al
Hellovorld (1.0.0 ocep.example.helowarld_1.0.0jar
O ¢ ) 5 5 - g Deselect Al

Direcktory: | b | [ Erowse. .. ]

[ overwrite existing Files withaut warning

@
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6. Configure the Oracle CEP Applications Export: Select Project dialog as shown in
Table 3—4.

Table 3-4 Oracle CEP Application Content Dialog

Attribute Description

Available Projects The list of Oracle CEP projects available for export.
Check the project or projects you want to export.

Each project will be exported to a JAR file with the name given
in the Output File column. The name of the bundle that will be
exported conforms to the OSGi bundle naming conventions,
using the bundle ID and the bundle version in the JAR name.

Directory The directory in which Oracle CEP project JAR files are
exported.

Click Browse to choose this directory.

Overwrite existing files Check this option to overwrite existing JAR files with the same
without warning name in the selected directory.

7. Click Finish.

Your project, its Java resources, and any binary resources you selected are
exported to the project JAR file.

8. Deploy the JAR file to your Oracle CEP server.

See Section 4.3.5, "How to Deploy an Application to an Oracle CEP Server".
9. Deploy other dependent resources, if any, to your Oracle CEP server.

For example:

»  Other OSGi bundles your application depends on.

Deploy these bundles on the Oracle CEP server using the Oracle CEP
Visualizer or command line deployment tools.

= Any entries in config.xml for datasources that are referenced from within
the application.

Add these entries to the target server's config.xml file.

3.4 Upgrading Projects

When upgrading Oracle CEP from one version to another, it may be necessary to make
changes to your existing Oracle CEP projects.

This section describes:
= Section 3.4.1, "How to Upgrade Projects from Oracle CEP 2.1 to 10.3"

= Section 3.4.2, "How to Upgrade Projects from Oracle CEP 10.3 to Release 11gR1
(11.1.1)"

For more information, see:
= Section 2.4, "Configuring Eclipse"
»  Oracle CEP Getting Started
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3.4.1 How to Upgrade Projects from Oracle CEP 2.1 t0 10.3

While project structure has stayed the same since 2.1, the data stored in Oracle CEP
Projects has changed significantly. It is therefore necessary to take steps to upgrade 2.1
projects manually before continuing their development in 10.3.

The following outlines the steps necessary to upgrade 2.1 projects to 10.3

To upgrade projects from Oracle CEP 2.1 to 10.3:
1. Open your Oracle CEP 2.1 project in Oracle CEP IDE for Eclipse.

2. Select File > Switch Workspace > Other.

The Workspace Launcher dialog appears as shown in Figure 3-9.

Figure 3-9 Workspace Launcher Dialog

& Workspace Launcher [‘S_<|
Select a workspace
Eclipse Platform stores your projects in a folder called a workspace,
Choose a workspace folder to use For this session,
wiorkspace: | Cleclipse-projs v

~ Lo a5
[ workbench Layout
[ warking Sets

.;:i;. (o4 ] [ Cancel

Note: Do not choose to copy settings from the current workspace.

3. Click Browse and select a new workspace directory.
Eclipse exits and restarts using the new workspace.
4. Select File > Import.
The Import Dialog appears as shown in Figure 3-10.
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Figure 3—10 Import Dialog

& Import
Select
N
Create new projects from an archive file or directory., I E - 5 I

Select an import source:

|type filker text |

== General
[, archive File
99‘ EBreakpoints
EE tirg Project:
[, File System
EL Preferences

= s

= EB

(= 12EE

(= Mylyn

(= Plug-in Development

(= Team

(= web

(= Web services

@

5. Expand the General option and select Existing Projects into Workspace.

6. Click Next.

The Import Projects dialog appears as shown in Figure 3-11.
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Figure 3—11 Import Projects Dialog

Import Projects e
Select a directory to search for existing Eclipse projects. ; ,""
-
() Select root directory: | | [ Browse. .. ]

O select archive file: | |

Projects:

Select all
Deselect Al

|:| Copy projects into workspace

®

7. Use the Import Projects dialog to import your 2.1 projects into the new workspace.
Optionally, choose to copy the project files into your new workspace.

8. For each project, change the project facet version as follows:
a. Right-click your project and select Properties.

The Project Properties dialog appears as shown in Figure 3-12.
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Figure 3—12 Project Properties Dialog: Project Facets

& Properties for COLDBTest

[kvpe Filter text | Project Facets
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- Java Code Style
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- Javadoc Location

- Oracle CEP Problem Sewverities
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- Project References

- RunfDebug Settings

- Targeted Runtimes

-Task Repository

- Task Tags

- Yalidation

- ¥Doclet

B
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ol
=
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=

2 ———
@ l. Ok J[ Cancel ]

b. Select the Project Facets option.

The Project Facet properties are displayed as Figure 3-12 shows.
c. Click Modify Project.

The Modify Faceted Project dialog appears shown in Figure 3-13.

Figure 3-13 Modify Faceted Project

= Modify Faceted Project

Project Facets
Select the Facets that should be enabled for khis project, \?

Configurations: |<cust0m> v|[ Save ][ Delete ]

Project Facet Version

@ Java

(ie| Oracle CEP

<< Show Runtimes

@ < Back Mt = [ mnsh | [ Cancel
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d. For the Oracle CEP facet, select 10.3 from the Version pull-down menu.
e. Click Finish.
f. Click OK.
g. Repeat for the next project.
9. Create a new Oracle CEP server runtime:
a. Select Window > Preferences.

The Preferences dialog appears as shown in Figure 3-14.

Figure 3-14 Preferences Dialog

& Preferences

[Evpe Filer bext Installed Server Runtime Environments i

+! T . L
General Add, remove, or edit installed server runtime definitions.

Ank

Conneckivicy Installed server runtimes: /_\
Help Name p— T
Install{Update

Internet
Java
P&
Plug-in Developrment
RunDebug
[=)- Server
Audio
Installed Runtimes
Launching
S0L Developrnent
Team
Walidation
Wb and XML
Web Services
WindowTester
wDoclet

@ [ oK ] [ Cancel

b. Expand the Server option and select Installed Runtimes.

c. Add anew 10.3 Oracle CEP server runtime as Section 4.2.1, "How to Create an
Oracle CEP Server Runtime" describes.

d. Click OK.
10. For each project, specify the new 10.3 Oracle CEP server runtime you created:
a. Right-click your project and select Properties.

The Project Properties dialog appears as shown in Figure 3-15.
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Figure 3—15 Project Properties Dialog: Targeted Runtimes

& Properties for CEPProj |Z|@@

|type filker text |

EH-B-8

Resource

BeanInfo Path
Builders

Java Build Path
Java Code Style
Java Compiler

Java Edikor

Javadoc Location
Plug-in Developrient
Profile Compliance and Yalidatic
Project Facets
Project References
Refackoring History
Run{Debug Settings

Task Repository
Task Tags
Yalidation
“Doclet

Targeted Runtimes P

Runtimes:

@ Oracle CEP+10.3

[5how all runtimes

Runtime Composition:

&L oracle CEF v10.3
=4 IRE 6.0¢ jrel.6,0_07

IF a runtire that vou want ta select is not displayed or is disabled wou may need to
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Uninstall Facets. ..

[Restore Defaults ] [ Apphy ]
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b. Select the Targeted Runtimes option.

The Targeted Runtimes properties are displayed as Figure 3-15 shows.

c. Check the new Oracle CEP 10.3 targeted runtime you created.

d. Click OK.

e. Repeat for the next project.

11. For each project update the project builders:

a. Right-click the project and select Open EPN Editor.

b. If the EPN diagram opens without error, proceed to step 12.

c. If the EPN diagram opens with the error shown in Figure 3-16, click the
Configure Builder button.
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Figure 3—16 Builder Error

| hella.context.xml 5} EPN: hello 3 =8

Fiter: = Full EPN 45| 100% 2| & =

The EPN cannot be displaved because the Oracle CEP build is configured in aninvalid order,
Click the button below to reconfigure the builder in the correct order,

Configure Builder

Overview

The EPN diagram is displayed.
d. Repeat for the next project.
12. Validate build inclusions:

If your application bundle is using bundle localization and has substitution
variables in its MANIFEST . MF file such as:

Bundle-Name: $project.name
Then your project root directory’s build.properties file element

bin.include must contain a reference to your bundle.properties file such
as:

bin.includes = META-INF/,\
bundle.properties, \

13. Perform source changes, if necessary.
For more information, see:

s "Upgrading a WebLogic Event Server 2.0 Application to Run on Oracle CEP
10.3" in the Oracle CEP Getting Started

m  Oracle CEP Release Notes for 10.3
(http://download.oracle.com/docs/cd/E13157_
01/wlevs/docs30/notes/notes.html)

After performing these steps, you should do a clean build of your project.

3.4.2 How to Upgrade Projects from Oracle CEP 10.3 to Release 11gR1 (11.1.1)

While project structure has stayed the same since 10.3, the data stored in Oracle CEP
Projects has changed significantly. It is therefore necessary to take steps to upgrade
10.3 projects manually before continuing their development in Release 11gR1 (11.1.1).

The following outlines the steps necessary to upgrade 10.3 projects to Release 11gR1
(11.1.1)
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To upgrade projects from Oracle CEP 10.3 to Release 11gR1 (11.1.1)
1. Open your Oracle CEP 10.3 project in Oracle CEP IDE for Eclipse.

2. Select File > Switch Workspace > Other.
The Workspace Launcher dialog apperas as shown in Figure 3-17.
Figure 3—17 Workspace Launcher Dialog

& Workspace Launcher,

X

Select a workspace

Eclipse Platform stores your projects in a folder called a workspace,
Choose a workspace folder to use For this session,

Workspace: | Ci\edipse-projs v| [ Browse...

[ warking Sets

@ [ K ] [ Cancel ]

3. Click Browse and select a new workspace directory.

Note: Do not choose to copy settings from the current workspace.

Eclipse exits and restarts using the new workspace.

4. Select File > Import.

The Import Dialog appears as shown in Figure 3-10.
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Figure 3—18 Import Dialog

& Import
Select
N
Create new projects from an archive file or directory., I E - 5 I

Select an import source:

|type filker text |
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[, archive File
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[, File System
EL Preferences

= s

= EB

(= 12EE

(= Mylyn

(= Plug-in Development
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@

5. Expand the General option and select Existing Projects into Workspace.
6. Click Next.

The Import Projects dialog appears as shown in Figure 3-11.
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Figure 3—19 Import Projects Dialog

Import Projects

Select a directory to search for existing Eclipse projects.

-

() Select root directory: |

[ Browse. .. ]

() Select archive file: |

Projects:

|:| Copy projects into workspace

Select all
Deselect Al

Cancel

7. Use the Import Projects dialog to import your 10.3 projects into the new
workspace. Optionally, choose to copy the project files into your new workspace.

8. For each project, change the project facet version as follows:

a. Right-click your project and select Properties.

The Project Properties dialog appears as shown in Figure 3-12.
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Figure 3-20 Project Properties Dialog: Project Facets
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b. Select the Project Facets option.

The Project Facet properties are displayed as Figure 3-12 shows.
c. Click Modify Project.

The Modify Faceted Project dialog appears shown in Figure 3-13.

Figure 3-21 Modify Faceted Project

= Modify Faceted Project

Project Facets
Select the Facets that should be enabled for khis project,

Configurations: |<cust0m> v|[ Save ][ Delete ]

Project Facet Version

&) Java 6.0 -
(E| Oracle CEP 2.0 v

11.1

& Implementation of version 2.0 of project Facet wlevs.module could not be Found, Functionality will be limited.

<< Show Runtimes

@ < Back Next » [ Firish ] [ Cancel
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d. For the Java facet, select 6.0 from the Version pull-down menu.
e. For the Oracle CEP facet, select 11.1 from the Version pull-down menu.
f. Click Finish.
g. Click OK.
h. Repeat for the next project.
9. Create a new Oracle CEP server runtime:
a. Select Window > Preferences.

The Prefences dialog appears as shown in Figure 3-14.

Figure 3-22 Preferences Dialog

& Preferences

[Evpe Filer bext Installed Server Runtime Environments i

+! T . L
General Add, remove, or edit installed server runtime definitions.

Ank
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Help Name p— T
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Internet
Java
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Plug-in Developrment
RunDebug
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Installed Runtimes
Launching
S0L Developrnent
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Walidation
Wb and XML
Web Services
WindowTester
wDoclet

(3] [ oK ] [ Cancel

b. Expand the Server option and select Installed Runtimes.

c. Add anew 11.0 Oracle CEP server runtime as Section 4.2.1, "How to Create an
Oracle CEP Server Runtime" describes.

d. Click OK.
10. For each project, specify the new 11.0 Oracle CEP server runtime you created:
a. Right-click your project and select Properties.

The Project Properties dialog appears as shown in Figure 3-15.
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Figure 3-23 Project Properties Dialog: Targeted Runtimes
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Java Build Path
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b. Select the Targeted Runtimes option.
The Targeted Runtimes properties are displayed as Figure 3-15 shows.
c. Check the new Oracle CEP 11.0 targeted runtime you created.
d. Click OK.
e. Repeat for the next project.
11. For each project update the project builders:
a. Right-click the project and select Open EPN Editor.
b. If the EPN diagram opens without error, proceed to step 12.

c. If the EPN diagram opens with the error shown in Figure 3-16, click the
Configure Builder button.
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Figure 3-24 Builder Error

| hella.context.xml 5} EPN: hello 3 =8

Fiter: = Full EPN 45| 100% 3| A& =

The EPN cannot be displaved because the Oracle CEP build is configured in aninvalid order,
Click the button below to reconfigure the builder in the correct order,

Configure Builder

Overview

The EPN diagram is displayed.
d. Repeat for the next project.
12. Select Window > Preferences.

The Preferences dialog appears as shown in Figure 3-25.
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Figure 3-25 Preferences Dialog
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13. Select the Validaion option.
14. Ensure that the following validation options are checked:
s CQL Validator
» EPL Validator
= EPN Validator
= XML Validator
15. Unselect all other options.
16. Click OK.
17. Validate build inclusions:

If your application bundle is using bundle localization and has substitution
variables in its MANIFEST . MF file such as:

Bundle-Name: $project.name

Then your project root directory’s build.properties file element
bin.include must contain a reference to your bundle.properties file such
as:
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bin.includes = META-INF/,\
bundle.properties, \

18. Perform source changes, if necessary.

For more information, see:

= "Upgrading an Oracle CEP 10.3 Application to Run on Oracle CEP Release
11gR1 (11.1.1)" in the Oracle CEP Getting Started

m  Oracle CEP Release Notes

3.5 Managing Oracle CEP Project Libraries

Many projects require use of libraries that were obtained from a source other than the
project itself, whether that be third party libraries, internal libraries created in other
projects, or otherwise.

You can use two types of library in Oracle CEP projects, each with its own packaging
and deployment characteristics:

Standard JAR Files: Adding a standard JAR file to a project makes for the easiest
management of the library. The library is packaged directly with the project by the
Oracle CEP IDE for Eclipse and you can check the library into a source code
control system as part of the project.

For more information, see Section 3.5.1, "How to Add an Oracle CEP Project
Library as a Standard JAR File"

OSGi Bundles: If your library is already a packaged as an OSGi bundle and you
would like to deploy it to the server once (allowing multiple applications to
reference it), you can use the OSGi bundle library option. Note that this leaves
some parts of deployment to the user since the OSGi bundle is not automatically
packaged with the application. It can also make working in team environments a
little more difficult because each developer must have the bundle in the user_
projects/modules directory of their machine, rather than have it source
controlled with the rest of the project.

For more information, see Section 3.5.2, "How to Add an Oracle CEP Project
Library as an OSGi Bundle"

3.5.1 How to Add an Oracle CEP Project Library as a Standard JAR File

If the library you need to use is a standard JAR file, you can add it to your Oracle CEP
project. Alternatively, you can add a library as an OSGi bundle (see Section 3.5.2, "How
to Add an Oracle CEP Project Library as an OSGi Bundle").

To add an Oracle CEP project library as a standard JAR file:

1.

Place the JAR file in your Oracle CEP IDE for Eclipse project.

Oracle recommends that you create a folder to put them in such as 1ib as
Figure 3-26 shows.
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Figure 3-26 Oracle CEP IDE for Eclipse lib Directory

% Package Explorer X =g

=y
[ src
=) JRE System Library [jdk150_11]
Bl Plug-in Dependencies
(= build
= lib
= customutils.jar
(= META-INF
@ build.properties

£ build. xml

[ B B B

2. Right-click the META-INF/MANIFEST .MF file and select Open With > Plug-in
Manifest Editor.

The Manifest Editor opens as Figure 3-27 shows.

Figure 3-27 Manifest Editor: Runtime Tab

I CEPPraj 22 i
=i Runtime @
Exported Packages Classpath
Enumerate all the packages that this plug-in exposes to clients, Specify the libraries and folders that constitute the plug-in
All other packages will be hidden from clients at all times. classpath. If unspecified, the casses and resources are

assumed to be at the root of the plug-in,

add...

|

|| Mew...
Caleulate Uses

Total: 1

Overview | Dependencies | Runtime | Build | MAMIFEST.MF | build. properties

3. Click the Runtime tab.
4. In the Classpath area, click the Add button.
The JAR Selection dialog appears as shown in Figure 3-28.
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Figure 3-28 JAR Selection Dialog
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=& lib
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Select the JAR you want to add to the bundle.
Check Update the build path.

Click OK.

Select File > Save All.

©® N o o

You will see the JAR listed in the Bundle-Classpath section of the
MANIFEST .MF file, in the bin.includes section of the build.properties file,
and on the build path in your explorer as Figure 3-29 shows.

Figure 3-29 Package Explorer
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The JAR file will no longer appear in the 1ib folder in the Package and Project
explorers after you add it to the build path. The JAR will now be included in
builds, packaged with the bundle when it is deployed to the Oracle CEP server,
and when exporting the application.

3.5.2 How to Add an Oracle CEP Project Library as an OSGi Bundle

If the library you need to use is an OSGi bundle, you can add it to your Oracle CEP
project. Alternatively, you can add a library as a standard JAR file (see Section 3.5.1,
"How to Add an Oracle CEP Project Library as a Standard JAR File").

To add an Oracle CEP project library as an OSGi bundle, you add the bundle to that
bundle's dependencies definition.
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To add an Oracle CEP project library as an OSGi bundle:

1. Place the OSGi bundle in the user_projects/modules directory of your Oracle

CEP server installation directory. For example:

c:\bea\user_projects\modules

2. Start the Oracle CEP IDE for Eclipse.

refresh the target platform. Navigate to Window > Preferences... > Plug-in
Development > Target Platform. On this page, simply hit the "Reload" button.
Make sure your bundle now shows in the list then close the preferences dialog.

3. Right-click the META-INF/MANIFEST .MF file and select Open With > Plug-in

Manifest Editor.

The Manifest Editor opens as Figure 3-30 shows.

Figure 3-30 Manifest Editor: Dependencies Tab
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4. Click the Dependencies tab.

5. In the Required Plug-ins area, click Add.

The Plug-in Selection dialog appears as shown in Figure 3-31.
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Figure 3-31 Plug-in Selection Dialog
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6. Select the bundle you added to the user_projects/modules directory of your
Oracle CEP server installation directory in step 1 and click OK.

The selected bundle appears in the Require-Bundle section of the MANIFEST . MF
file.

Note: This process only makes the referenced bundle available to
your project at build time. It does not package the bundle directly
with your application when it is deployed or exported. Instead, this
bundle must be deployed to the Oracle CEP server manually.

3.6 Configuring Oracle CEP IDE for Eclipse Preferences

You can configure various preferences to customize Oracle CEP IDE for Eclipse to suit
your needs, including:

= Section 3.6.1, "How to Configure Problem Severity Preferences for a Workspace"

= Section 3.6.2, "How to Configure Problem Severity Properties for a Project”

3.6.1 How to Configure Problem Severity Preferences for a Workspace

You can assign a severity to the various problems that Oracle CEP IDE for Eclipse can
detect in your Oracle CEP project and application.

To configure problem severity preferences for a Workspace:
1. Open the EPN Editor (see Section 5.1, "Opening the EPN Editor")

2. Select Window > Preferences.

The Preferences dialog appears as shown in Figure 3-32.
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Figure 3-32 Preferences Dialog: Workspace
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3. Select Oracle CEP Problem Severities.

4. Select a severity for each type of problem. You can select one of:
m Error: treat the problem as an error.
= Warning: treat the problem as a warning.
= Ignore:ignore the problem.

Table 3-5 describes each of the problem areas you can configure.

Table 3-5 Oracle CEP Problem Severities

Problem Description

Configuration objects without
a matching assembly definition

EPN configuration elements are linked to assembly definitions by name
and ID, respectively. Validate that a configuration element has a name
that exactly matches an assembly element by ID within the same
application.

Configuration objects with
duplicate name declarations.

Configuration elements in Oracle CEP configuration files are identified
by a name. Validate that no two configuration elements in an
application have the same name.

Unresolved event listeners or
resolved listeners with
incorrect interface declarations

An event processing network is built by defining how elements in the
network pull or push to events to other elements in the application.
Validate that the target of an event push, a listener declaration on an
EPN assembly element, implements the interfaces required to receive
pushed events.

Unresolved event sources or
resolved sources with incorrect
interface declarations

An event processing network is built by defining how elements in the
network pull or push to events to other elements in the application.
Validate that the source of an event pull, a source declaration on an EPN
assembly element, implements the interfaces required to provide pulled
events.

Deprecated EPN elements

Oracle CEP provides backwards compatibility with applications built
for previous versions. Validate an application's use of deprecated XML
elements.
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Table 3-5 (Cont.) Oracle CEP Problem Severities

Problem

Description

Event property type values that | Event types may be defined using dynamic Spring Beans through the
are not predefined types or do | properties element. The property values are limited to a fixed set
not resolve to a known class. of supported types. Validate that the property type is one of these

allowed types.

For more information, see Section 1.1.2, "Event Types".

Problems found validating
CQL Statements

Validate that the Oracle CQL statement in a processor configuration is
correct given the current application. Verify property names, event
types, syntax, and other assembly-to-Oracle CQL references.

Problems preventing the
validation of CQL statements from being validated. For example, a processor configuration must have

Some fundamental application errors will keep a Oracle CQL statement

a matching processor assembly definition before any Oracle CQL
requirements can be met. Verify that the minimum requirements are met
to validate a processor's Oracle CQL statements.

5.
6.

Click Apply.
Click OK.

3.6.2 How to Configure Problem Severity Properties for a Project

You can assign a severity to the various problems that Oracle CEP IDE for Eclipse can
detect in your Oracle CEP project and application.

To configure problem severity properties for a project:
Open the EPN Editor (see Section 5.1, "Opening the EPN Editor").

1.
2.

Right-click a project and select Properties.

The Preferences dialog appears as shown in Figure 3-33.

Figure 3-33 Properties Dialog: Project
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Oracle CEP IDE for Eclipse Projects 3-31



Configuring Oracle CEP IDE for Eclipse Preferences

3. Select Oracle CEP Problem Severities.

4. Check the Enable project specific settings check box.

Note:

These properties settings are saved with the project (in the

.settings directory) and can be checked into a source code
management system.

5. Select a severity for each type of problem. You can select one of:

»s Error: treat the problem as an error.

= Warning: treat the problem as a warning.

= Ignore:ignore the problem.

Table 3-6 describes each of the problem areas you can configure.

Table 3-6 Oracle CEP Problem Severities

Problem

Description

Configuration objects without
a matching assembly definition

EPN configuration elements are linked to assembly definitions by name
and ID, respectively. Validate that a configuration element has a name
that exactly matches an assembly element by ID within the same
application.

Configuration objects with
duplicate name declarations.

Configuration elements in Oracle CEP configuration files are identified
by a name. Validate that no two configuration elements in an
application have the same name.

Unresolved event listeners or
resolved listeners with
incorrect interface declarations

An event processing network is built by defining how elements in the
network pull or push to events to other elements in the application.
Validate that the target of an event push, a listener declaration on an
EPN assembly element, implements the interfaces required to receive
pushed events.

Unresolved event sources or
resolved sources with incorrect
interface declarations

An event processing network is built by defining how elements in the
network pull or push to events to other elements in the application.
Validate that the source of an event pull, a source declaration on an EPN
assembly element, implements the interfaces required to provide pulled
events.

Deprecated EPN elements

Oracle CEP provides backwards compatibility with applications built
for previous versions. Validate an application's use of deprecated XML
elements.

Event property type values that
are not predefined types or do
not resolve to a known class.

Event types may be defined using dynamic Spring Beans through the
properties element. The property values are limited to a fixed set
of supported types. Validate that the property type is one of these
allowed types.

For more information, see Section 1.1.2, "Event Types".

Problems found validating
CQL Statements

Validate that the Oracle CQL statement in a processor configuration is
correct given the current application. Verify property names, event
types, syntax, and other assembly-to-Oracle CQL references.

Problems preventing the
validation of CQL statements

Some fundamental application errors will keep a Oracle CQL statement
from being validated. For example, a processor configuration must have
a matching processor assembly definition before any Oracle CQL
requirements can be met. Verify that the minimum requirements are met
to validate a processor's Oracle CQL statements.

6. Click Apply.
7. Click OK.
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Oracle CEP IDE for Eclipse and Oracle CEP

Servers

Using Oracle CEP IDE for Eclipse, you can manage and deploy to the Oracle CEP
server: the core of an Oracle CEP application. It provides the runtime in which your

Oracle CEP application executes.

This chapter describes:

s Section 4.1, "Oracle CEP Server Overview"

m  Section 4.2, "Creating Oracle CEP Servers"

m  Section 4.3, "Managing Oracle CEP Servers"

= Section 4.4, "Debugging an Oracle CEP Application Running on an Oracle CEP

Server"

4.1 Oracle CEP Server Overview

The Oracle CEP IDE for Eclipse provides features that allow you to set up and manage
Oracle CEP servers that are used during development. These tools help you to:

= Configure instances of Oracle CEP servers

m Attach to external Oracle CEP server instances

= Manage Oracle CEP server lifecycle with start, stop, and debug commands

= Associate applications with and deploy applications to Oracle CEP servers during
development

Table 4-1 maps Eclipse terminology used by the Oracle CEP IDE for Eclipse to Oracle
CEP server terminology.

Table 4—-1

Eclipse and Oracle CEP Server Concepts

Eclipse IDE
Concept

Oracle CEP Server
Concept

Description

Runtime

Oracle CEP server
installation

The Oracle CEP IDE for Eclipse has the concept of a runtime.
The runtime defines the location where the Oracle CEP IDE for
Eclipse can find the installation of a particular Oracle CEP
server. This information is used to find JAR files and OSGi
bundles to add to the project classpath and to further define
Servers and Server Instances.

Note that a Runtime is not itself a runnable artifact.
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Table 4-1 (Cont.) Eclipse and Oracle CEP Server Concepts

Eclipse IDE Oracle CEP Server

Concept Concept Description
Server and Domain The Oracle CEP IDE for Eclipse uses the term Server to describe
Server Instance an actual runnable Oracle CEP server instance. You can think of

it as something that has start scripts, for example. In Oracle CEP
server terminology, this equates to a Domain. When you set up a
server, you specify the domain that this instance will run.

For more information on domains, see:

N For more information, see "Creating and Updating Oracle
CEP Standalone Server Domains" in the Oracle CEP
Administrator’s Guide.

N For more information, see "Creating and Updating Oracle
CEP Multi-Server Domains" in the Oracle CEP
Administrator’s Guide.

Publish Deploy The Oracle CEP IDE for Eclipse typically uses the term Publish
to describe physically deploying an application to a server.
Project Application or A project in the Oracle CEP IDE for Eclipse becomes a single
Deployment Oracle CEP application packaged as an OSGi bundle. It is

deployed to a server and shows in the Oracle CEP server’s
deployments .xml file.

Server definitions are the central concept in controlling an Oracle CEP server from the
Oracle CEP IDE for Eclipse. It is from the server definition that you start and stop the
server. After associating a project with the server, you can publish (deploy) the
application to and unpublish (undeploy) the application from the server, all without
having to leave the Oracle CEP IDE for Eclipse. For more information, see Section 4.2,
"Creating Oracle CEP Servers".

You can communicate with a running Oracle CEP server using Oracle CEP IDE for
Eclipse in the following ways:

»  Start a server from within Oracle CEP IDE for Eclipse.

In this case, the Oracle CEP server console is sent directly to the console view in
Oracle CEP IDE for Eclipse. All of the Oracle CEP server features (such as start,
stop, publish, unpublish, debug, and launching the Oracle CEP Visualizer) are
available. The Oracle CEP server process itself is managed from within Oracle CEP
IDE for Eclipse. In other words, stopping the Oracle CEP server from the Oracle
CEP IDE for Eclipse will terminate the actual Oracle CEP server process. Console
messages from the Oracle CEP server are sent to the Oracle CEP IDE for Eclipse
Console view.

For more information, see:

—  Section 4.3.1, "How to Start an Oracle CEP Server"

—  Section 4.3.2, "How to Stop an Oracle CEP Server"
= Attach to a running Oracle CEP server.

In this case, the user starts the Oracle CEP server from the command line, then
clicks the Start button for that server in Oracle CEP IDE for Eclipse. A dialog is
shown asking whether or not to attach and, if the user clicks Yes, Oracle CEP IDE
for Eclipse enters attached mode. All of the Oracle CEP server features except
debug are available. However, the Oracle CEP server process is not managed by
the Oracle CEP IDE for Eclipse. Clicking the Stop button simply disconnects from
the attached Oracle CEP server; it does not terminate the actual Oracle CEP server
process. Console messages from the Oracle CEP server are sent to the Oracle CEP
server console (standard output to the terminal window in which it is running).
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Oracle CEP IDE for Eclipse only shows limited Oracle CEP IDE for Eclipse
operation messages in the console view.

For more information, see:
- Section 4.3.3, "How to Attach to an Existing Oracle CEP Server Instance"

- Section 4.3.4, "How to Detach From an Existing Oracle CEP Server Instance"

4.2 Creating Oracle CEP Servers

Creating a server allows you to start and stop the server instance from within the
Oracle CEP IDE for Eclipse, as well as automatically deploy your applications to that
server.

This section describes:
s Section 4.2.1, "How to Create an Oracle CEP Server Runtime"

m Section 4.2.2, "How to Create an Oracle CEP Server and Server Runtime"

4.2.1 How to Create an Oracle CEP Server Runtime

Before you can create a server, you must configure the Oracle CEP IDE for Eclipse with
the location of your Oracle CEP server installation by creating a server runtime using
the runtime wizard. You can access the runtime wizard from several places including
the new server wizard, the new project wizard, and the workspace preferences dialog.

You only need to create a runtime explicitly if you have not yet created an Oracle CEP
server (see Section 4.2.2, "How to Create an Oracle CEP Server and Server Runtime").

To create an Oracle CEP server runtime:
1. Select Windows > Preferences.

The Preferences dialog appears as Figure 4-1 shows.
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Figure 4-1 Preferences - Server - Installed Runtimes
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2. Expand the Server option and select Installed Runtimes.
3. Click Add.

The New Server Runtime dialog appears as shown in Figure 4-2.
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Figure 4-2 New Server Runtime Dialog
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4. Configure the dialog as shown in Table 4-2.

Table 4-2 New Server Runtime Dialog Attributes

Attribute Description
Server’s host name: The host name of the computer on which you installed Oracle
CEP server.

For development, this will typically be localhost.

Select the server type: The type of Oracle CEP server.

In this example, choose Oracle CEP v11.1.

Also create new local server | Optionally, check this to create a new local server if you have
not yet created a server. For more information, see Section 4.2.2,
"How to Create an Oracle CEP Server and Server Runtime".

5. Click Next.

The New Server: New Oracle CEP v11 Runtime dialog appears as shown in
Figure 4-3.
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Figure 4-3 New Server: New Oracle CEP v11 Runtime Dialog
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6. Configure the dialog as shown in Table 4-3.

Table 4-3 New Server Runtime Dialog Attributes

Attribute

Description

BEA Home Directory

The fully qualified path to the Oracle CEP server installation
directory. This is the same as the "Middleware Home" that was
selected when installing the server.

When selecting this directory, select directory that contains the
Oracle CEP installation rather than the Oracle CEP directory
itself. For example, choose:

C:\OracleCEP

But do not choose:
C:\OracleCEP\ocep_11.1

The runtime wizard will use the installation to find the
appropriate Oracle CEP installation directory.

JRE

The type of JRE to use.

Select the type of JRE to use from the pull-down menu or click
the Installed JRE preferences link to create a new JRE.

Be sure to choose either JRockit Real Time 2.0 or the JRockit JDK
installed with your Oracle CEP installation.

7. Click Finish.
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4.2.2 How to Create an Oracle CEP Server and Server Runtime

This section describes how to create both a server and server runtime. After creating
the initial server and server runtime, you can create additional server runtimes (see
Section 4.2.1, "How to Create an Oracle CEP Server Runtime").

To create an Oracle CEP server and Server Runtime:
1. Select Window > Show View > Servers.

The Servers view appears as shown in Figure 4—4.

Figure 4-4 Oracle CEP IDE for Eclipse Server View

4 Servers 53 e e HE i .

Server State Status

2. Right-click in the Servers view pane and select New > Server.

3. If this is the first time you have created an Oracle CEP server, there will be no
installed server runtimes:

In this case, the New Server: Define New Server dialog appears as Figure 4-5
shows.
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Figure 4-5 New Server: Define New Server Dialog (No Installed Runtimes)
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Configure the new server as follows:

a. Configure the dialog as shown in Table 4-4.

Table 4-4 New Server: Define New Server Dialog (No Installed Runtimes) Attributes

Attribute Description
Server’s host name: The host name of the computer on which you installed Oracle
CEP server.

For development, this will typically be localhost.

Select the server type: The type of Oracle CEP server.

In this example, choose Oracle CEP v1l

b. Click Next.

The New Server: New Oracle CEP v11 Runtime dialog appears as shown in
Figure Figure 4-6.
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Figure 4-6 New Server: New Oracle CEP v11 Runtime Dialog
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c. Configure the dialog as shown in Table 4-5.

Table 4-5 New Server: New Oracle CEP v11 Runtime Dialog Attributes

Attribute Description
BEA Home Directory The fully qualified path to the Oracle CEP server installation
directory.

When selecting this directory, select directory that contains the
Oracle CEP installation rather than the Oracle CEP directory
itself. For example, choose:

C:\OracleCEP

But do not choose:
C:\OracleCEP\ocep_11.1

The runtime wizard will use the installation to find the
appropriate Oracle CEP installation directory.

JRE The type of JRE to use.

Select the type of JRE to use from the pull-down menu or click
the Installed JRE preferences link to create a new JRE.

Be sure to choose either JRockit Real Time 2.0 or the JRockit JDK
installed with your Oracle CEP installation.

d. Click Next.
e. Proceed to step 5.

4, If this is not the first time you have created an Oracle CEP server, there will be one
or more installed server runtimes.
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In this case, the New Server: Define New Server dialog appears as Figure 4-7

shows.

Figure 4-7 New Server: Define New Server (Installed Runtimes) Dialog
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Configure the new server as follows:

a. Configure the dialog as shown in Table 4-6.

Table 4-6 New Server: Define New Server (Installed Runtimes) Dialog Attributes

Attribute

Description

Server’s host name:

The host name of the computer on which you installed Oracle
CEP server.

For development, this will typically be localhost.

Select the server type:

The type of Oracle CEP server.

In this example, choose Oracle CEP v1l.

Server runtime:

Select the server runtime from the pull-down menu.

To create or edit server runtimes, click Installed Runtimes. For
more information, see Section 4.2.1, "How to Create an Oracle
CEP Server Runtime".

b. Click Next.

5. The New Server: New Oracle CEP v11 Server dialog appears as Figure 4-8 shows.
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Figure 4-8 New Server: New Oracle CEP v11 Server Dialog
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6. Click Advanced.
7. Configure the dialog as shown in Table 4-7.

Table 4-7 New Server: New Oracle CEP v11 Server Dialog Attributes

Attribute Description

Domain Directory The fully qualified path to the directory that contains the domain for
this server.

Click Browse to choose the directory.

Default: ORACLE-CEP-HOME\user_projects\domains\ocep_
domain\defaultserver.

Start Script The script that Oracle CEP IDE for Eclipse uses to start the Oracle CEP
server.

Default on UNIX: ORACLE-CEP-HOME/user_
projects/domains/ocep_
domain/defaultserver/stopwlevs.sh

Default on Windows: ORACLE-CEP-HOME\user_
projects\domains\ocep_
domain\defaultserver\stopwlevs.cmd

Stop Script The script that Oracle CEP IDE for Eclipse uses to stop the Oracle CEP
server.

Default on UNIX: ORACLE-CEP-HOME/\user_
projects/domains/ocep_
domain/defaultserver/startwlevs.sh

Default on Windows: ORACLE-CEP-HOME\user_
projects\domains\ocep_
domain\defaultserver\startwlevs.cmd
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Table 4-7 (Cont.) New Server: New Oracle CEP v11 Server Dialog Attributes

Attribute

Description

Debug Port

The Oracle CEP server port that Oracle CEP IDE for Eclipse connects
to when debugging the Oracle CEP server.

Default: 8453.

Server Name

The name of the Oracle CEP server.
Default: Oracle CEP v11

User Name

The user name Oracle CEP IDE for Eclipse uses when logging into the
Oracle CEP server.

Default: wlevs.

User Password

The user password Oracle CEP IDE for Eclipse uses when logging
into the Oracle CEP server.

Default: wlevs.

Automatic Publishing

By default, when you change an application, you must manually
publish the changes to the Oracle CEP server.

Select Use Workspace Default to configure Oracle CEP IDE for
Eclipse to automatically publish changes to the Oracle CEP server.

Default: Disabled.

8. Click Finish.

If you configured Automatic Publishing as Use Workspace Default, select

Windows > Preferences.

The Preferences dialog appears as Figure 4-9 shows.

Figure 4-9 Preferences - Server
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10. Select the Server option.
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11. Configure your automatic publishing options:

= Automatically publish to local servers: enable or disable this option, as
required.

Default: enabled.

— Publishing interval: configure the frequency at which the Oracle CEP IDE
for Eclipse publishes changes to the server (in seconds).

Default: 60 seconds.

= Automatically publish to remote servers: enable or disable this option, as
required.

Default: enabled.

— Publishing interval: configure the frequency at which the Oracle CEP IDE
for Eclipse publishes changes to the server (in seconds).

Default: 60 seconds.
12. Click OK.

4.3 Managing Oracle CEP Servers

Using the Oracle CEP IDE for Eclipse and the Oracle CEP Visualizer accessible from
the Oracle CEP IDE for Eclipse, you can manage many aspects of your Oracle CEP
server during development.

This section describes the following Oracle CEP server management tasks you can
perform from the Oracle CEP IDE for Eclipse:

s Section 4.3.1, "How to Start an Oracle CEP Server"

= Section 4.3.2, "How to Stop an Oracle CEP Server"

= Section 4.3.3, "How to Attach to an Existing Oracle CEP Server Instance"

= Section 4.3.4, "How to Detach From an Existing Oracle CEP Server Instance"
= Section 4.3.5, "How to Deploy an Application to an Oracle CEP Server"

= Section 4.3.6, "How to Configure Connection and Control Settings for Oracle CEP
Server"

= Section 4.3.7, "How to Configure Domain (Runtime) Settings for Oracle CEP
Server"

s Section 4.3.8, "How to Start the Oracle CEP Visualizer from Oracle CEP IDE for
Eclipse"

4.3.1 How to Start an Oracle CEP Server

After you create a server (see Section 4.2.2, "How to Create an Oracle CEP Server and
Server Runtime"), you can start the Oracle CEP server from the Oracle CEP IDE for
Eclipse.

You can also start the Oracle CEP server in debug mode (see Section 4.4.1, "How to
Debug an Oracle CEP Application Running on an Oracle CEP Server").

Alternatively, you can start the Oracle CEP server from the command line and attach
to it using Oracle CEP IDE for Eclipse (see Section 4.3.3, "How to Attach to an Existing
Oracle CEP Server Instance").
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To start an Oracle CEP server:
1. Select Window > Show Views > Servers.

The Servers view opens as shown in Figure 4-10.

Figure 4-10 Starting an Oracle CEP Server
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2. Start the server by choosing one of the following;:
a. Click the Start the Server icon in the Servers view tool bar.
b. Right-click a server in the Servers view and select Start.

After starting the server you will see log messages from the server in the Console
view.

4.3.2 How to Stop an Oracle CEP Server

After you start the Oracle CEP server from the Oracle CEP IDE for Eclipse (see
Section 4.3.1, "How to Start an Oracle CEP Server"), you can stop the Oracle CEP
server from the Oracle CEP IDE for Eclipse.

To stop an Oracle CEP server:
1. Select Window > Show Views > Servers.

The Servers view opens as shown in Figure 4-11.

Figure 4-11 Stopping an Oracle CEP Server
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2. Stop the server by choosing one of the following:
a. Click the Stop the Server icon in the Servers view tool bar.

b. Right-click a server in the Servers view and select Stop.
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4.3.3 How to Attach to an Existing Oracle CEP Server Instance

After you create a server (see Section 4.2.2, "How to Create an Oracle CEP Server and
Server Runtime"), you can start the Oracle CEP server from the command line and
attach Oracle CEP IDE for Eclipse to the existing, already running Oracle CEP server
instance.

Alternatively, you can start the Oracle CEP server directly from within Oracle CEP IDE
for Eclipse (see Section 4.3.1, "How to Start an Oracle CEP Server").

To attach to an existing Oracle CEP server instance:
1. Start the Oracle CEP server from the command line.

For more information, see "Starting and Stopping Oracle CEP Servers" in the
Oracle CEP Administrator’s Guide.

2. Select Window > Show Views > Servers.

The Servers view opens as shown in Figure 4-10.

Figure 4-12 Attaching to an Existing Oracle CEP Server Instance
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3. Attach to the already running server by choosing one of the following;:
a. Click the Start the Server icon in the Servers view tool bar.
b. Right-click a server in the Servers view and select Start.

The Attach to Running CEP Server dialog appears as Figure 4-13 shows.

Figure 4-13 Attach to Running CEP Server
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4. Click Yes.

After attaching to the server you will not see log messages from the server in the
Console view.

You can view the server console using the Oracle CEP Visualizer. For more
information, see "How to View Console Output" in the Oracle CEP Visualizer User’s
Guide.
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4.3.4 How to Detach From an Existing Oracle CEP Server Instance

After you attach to an existing, running Oracle CEP server instance (see Section 4.3.3,
"How to Attach to an Existing Oracle CEP Server Instance"), you can detach from the
Oracle CEP server and leave it running.

To detach from an existing Oracle CEP server instance:
1. Select Window > Show Views > Servers.

The Servers view opens as shown in Figure 4-11.

Figure 4-14 Stopping an Oracle CEP Server
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2. Detach from the server by choosing one of the following:
a. Click the Stop the Server icon in the Servers view tool bar.
b. Right-click a server in the Servers view and select Stop.

Oracle CEP IDE for Eclipse detaches from the Oracle CEP server instance. The
Oracle CEP server instance continues to run.

4.3.5 How to Deploy an Application to an Oracle CEP Server

A project in the Oracle CEP IDE for Eclipse is built as an Oracle CEP application, then
deployed to the server. To deploy an application, a server must first be defined (see
Section 4.2.2, "How to Create an Oracle CEP Server and Server Runtime"). To then
deploy an application, simply add it to the server. The application will be deployed
immediately if the server is already started, or when the server is next started if the
server is stopped.

To deploy an application to an Oracle CEP server:
1. Create an Oracle CEP project (see Section 3.2, "Creating Oracle CEP Projects").

2. Create a server (see Section 4.2.2, "How to Create an Oracle CEP Server and Server
Runtime").

3. Select Window > Show Views > Servers.

The Servers view opens as shown in Figure 4-15.
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Figure 4-15 Adding a Project to an Oracle CEP Server
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4. Right-click the server and select Add and Remove Projects.
The Add and Remove Projects dialog appears as shown in Figure 4-16.

Figure 4-16 Add and Remove Projects Dialog
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5. Select a project and click Add or click Add All to add all projects to the Oracle CEP
server.

6. Click Finish.

Once an application is deployed, it will show as a child of the server in the Servers
view as shown in Figure 4-17.
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Figure 4-17 Server View After Adding a Project
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4.3.6 How to Configure Connection and Control Settings for Oracle CEP Server

After you create a server (see Section 4.2.2, "How to Create an Oracle CEP Server and
Server Runtime"), you can use the Server Overview editor to configure all the
important server connection and control settings that Oracle CEP IDE for Eclipse uses
to communicate with the Oracle CEP server.

For information on how to configure Oracle CEP server domain (runtime) settings, see

Section 4.3.7, "How to Configure Domain (Runtime) Settings for Oracle CEP Server".

To configure connection and control settings for Oracle CEP server:
1. Select Window > Show Views > Servers.

2. Double-click a server in the Servers view.

The Server Overview editor opens as shown in Figure 4-18.

Figure 4-18 Server Overview Editor
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3. Configure the Server Overview editor as shown in Table 4-8.
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Table 4-8 Server Overview Editor Attributes

Attribute

Description

Server Name

The name of this server. Only used within the Oracle CEP IDE
for Eclipse as a useful identifier.

For more information, see Section 4.2.2, "How to Create an
Oracle CEP Server and Server Runtime".

Host Name The name of the host on which this server is installed.
For more information, see Section 4.2.2, "How to Create an
Oracle CEP Server and Server Runtime".

Runtime The current installed runtime selected for this server.

Select a new runtime from the pull down menu or click the Edit
link to modify the configuration of the selected runtime.

For more information, see Section 4.2.2, "How to Create an
Oracle CEP Server and Server Runtime".

Domain Directory

The fully qualified path to the directory that contains the
domain for this server.

Click Browse to choose the directory.

Default: ORACLE-CEP-HOME\user_
projects\domains\ocep_domain\defaultserver.

Start Script

The script that Oracle CEP IDE for Eclipse uses to start the
Oracle CEP server.

Click Browse to choose the start script.

Default on UNIX: ORACLE-CEP-HOME\user__
projects\domains\ocep_
domain\defaultserver\stopwlevs.sh

Default on Windows: ORACLE-CEP-HOME\user_
projects\domains\ocep_
domain\defaultserver\stopwlevs.cmd

Stop Script

The script that Oracle CEP IDE for Eclipse uses to stop the
Oracle CEP server.

Click Browse to choose the stop script.

Default on UNIX: ORACLE-CEP-HOME\user__
projects\domains\ocep_
domain\defaultserver\startwlevs.sh

Default on Windows: ORACLE-CEP-HOME\user_
projects\domains\ocep_
domain\defaultserver\startwlevs.cmd

Debug Port

The Oracle CEP server port that Oracle CEP IDE for Eclipse
connects to when debugging the Oracle CEP server.

Default: 8453.

Server Name

The name of the Oracle CEP server.

Default: Oracle CEP v1l

User Name

The user name Oracle CEP IDE for Eclipse uses when logging
into the Oracle CEP server.

Default: wlevs.

User Password

The user password Oracle CEP IDE for Eclipse uses when
logging into the Oracle CEP server.

Default: wlevs.
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Table 4-8 (Cont.) Server Overview Editor Attributes

Attribute Description

Override when the server is | By default, when you change an application, you must
automatically published to | manually publish the changes to the Oracle CEP server.

Select Use default publishing settings to enable automatic
publishing using the default publishing preferences. Click the
Edit link to configure the default publishing preferences.

Select Never publish automatically to disable automatic
publishing.

Select Override default settings to override the default
automatic publishing interval. Enter a new publishing interval
(in seconds).

Default: Never publish automatically.

4. Select File > Save.

5. Close the Server Overview editor.

4.3.7 How to Configure Domain (Runtime) Settings for Oracle CEP Server

After you create a server (see Section 4.2.2, "How to Create an Oracle CEP Server and
Server Runtime"), you can use the Oracle CEP IDE for Eclipse to configure Oracle CEP
server domain (runtime) settings.

You can also use the Oracle CEP IDE for Eclipse to configure all the important server
connection and control settings that Oracle CEP IDE for Eclipse uses to communicate
with the Oracle CEP server (see Section 4.3.6, "How to Configure Connection and
Control Settings for Oracle CEP Server").

To configure domain (runtime) settings for Oracle CEP server:
1. Select Window > Show Views > Servers.

2. Right-click a server in the Servers view and select Open Domain Configuration
File as shown in Figure 4-19.

Figure 4-19 Editing the Domain Configuration File
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The Oracle CEP server domain configuration file config.xml opens as shown in
Figure 4-20.

Figure 4-20 Oracle CEP Domain Configuration File config.xml
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4 >
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3. Edit the domain configuration file as required.
4. Select File > Save.

5. Close the domain configuration file.

4.3.8 How to Start the Oracle CEP Visualizer from Oracle CEP IDE for Eclipse

After you create a server (see Section 4.2.2, "How to Create an Oracle CEP Server and
Server Runtime"), you can start the Oracle CEP Visualizer from the Oracle CEP IDE for
Eclipse.

The Oracle CEP Visualizer is the administration console for a running Oracle CEP

server. For more information, see the Oracle CEP Visualizer User's Guide.

To start the Oracle CEP Visualizer from Oracle CEP IDE for Eclipse:
1. Start the server (see Section 4.3.1, "How to Start an Oracle CEP Server").

2. Right-click the running server in the Servers view and select Open CEP Visualizer
as shown in Figure 4-21.
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Figure 4-21 Opening the Oracle CEP Visualizer
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The Oracle CEP Visualizer opens as shown in Figure 4-22.

Figure 4-22 Oracle CEP Visualizer
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3. Use the Oracle CEP Visualizer as the Oracle CEP Visualizer User's Guide describes.

4.4 Debugging an Oracle CEP Application Running on an Oracle CEP
Server

Because Oracle CEP applications are java applications, standard Java debugging tools
including those provided in Eclipse can be used with these applications.

4.4.1 How to Debug an Oracle CEP Application Running on an Oracle CEP Server

This section describes how to debug an Oracle CEP application running on an Oracle
CEP server.

To debug an Oracle CEP application running on an Oracle CEP server:
1. Set a breakpoint in the Java code you wish to debug.

In this case, set the breakpoint by right-clicking in the gutter of the editor and
selecting Toggle Breakpoint as Figure 4-23 shows.

Figure 4-23 Setting a Breakpoint
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2. Select Window > Show Views > Servers.

3. Start the server in debug mode by choosing one of the following as shown in
Figure 4-24:

a. Click the Start the Server in debug mode icon in the Servers view tool bar.

b. Right-click a server in the Servers view and select Debug.

Figure 4-24 Starting the Oracle CEP Server in Debug Mode
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4. The server will start, and when it gets to your breakpoint the thread will stop.

If the Oracle CEP IDE for Eclipse does not automatically switch to the Debug
perspective, switch to that perspective by selecting Window > Open Perspective >
Other and selecting the Debug option from the list of perspective.

5. Debug your application using the Debug perspective.

Note: In some cases you may get a dialog box warning that it could
not install a breakpoint because of missing line number information.
This dialog comes from the core Eclipse debugger and is normally a
harmless issue with Oracle CEP Service Engine applications. Simply
check the Don't Tell Me Again checkbox and continue debugging.

6. When you are finished you can stop the server as usual (see Section 4.3.2, "How to
Stop an Oracle CEP Server").
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Oracle CEP IDE for Eclipse and the Event
Processing Network

The Oracle CEP Event Processing Network (EPN) is the central concept in an Oracle
CEP application. It is the primary point where application components are wired
together. Using Oracle CEP IDE for Eclipse, you can use an EPN Editor that provides a
graphical view of the EPN and offers visualization and navigation features to help you
build Oracle CEP applications.

This section describes how to use the editor and the information it displays, including:
= Section 5.1, "Opening the EPN Editor"

m  Section 5.2, "EPN Editor Overview"

= Section 5.3, "Navigating the EPN Editor"

= Section 5.4, "Using the EPN Editor"

5.1 Opening the EPN Editor

You can open the EPN Editor from either the project folder or a context or
configuration file of an Oracle CEP application.

5.1.1 How to Open the EPN Editor from a Project Folder

You can open the EPN Editor from the Eclipse project folder of an Oracle CEP
application. Alternatively, you can open the EPN Editor from a context or
configuration file (see Section 5.1.2, "How to Open the EPN Editor from a Context or
Configuration File").

To open the EPN Editor from a project:
1. Launch the Oracle CEP IDE for Eclipse.

2. Open your Oracle CEP project in the Project Explorer.
3. Right-click the project folder and select Open EPN Editor as Figure 5-1 shows.
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Figure 5-1 Opening the EPN Editor from a
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The EPN Editor opens in a tab named

Project
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4

EPN: PROJECT-NAME, where

PROJECT-NAME is the name of your Oracle CEP project, as Figure 5-2 shows.

Figure 5-2 EPN Editor
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5.1.2 How to Open the EPN Editor from a Context or Configuration File

You can open the EPN Editor from a Spring context file or an Oracle CEP server
configuration file in an Oracle CEP application. Alternatively, you can open the EPN
Editor from a context or configuration file (see Section 5.1.1, "How to Open the EPN
Editor from a Project Folder")

To open the EPN Editor from a context or configuration file:
1. Launch the Oracle CEP IDE for Eclipse.

2. Open your Oracle CEP project in the Project Explorer.

3. Right-click a context or configuration file and select Open in EPN Editor as
Figure 5-3 shows.

Figure 5-3 Opening the EPN Editor from a Context or Configuration File
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The EPN Editor opens in a tab named EPN: PROJECT-NAME, where
PROJECT-NAME is the name of your Oracle CEP project, as Figure 5—4 shows.
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Figure 5-4 EPN Editor
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5.2 EPN Editor Overview

This section describes the main controls you use to manage the EPN view and how the
EPN Editor displays Oracle CEP application information, including:

»  Section 5.2.1, "Flow Representation”

= Section 5.2.2, "Filtering, Zooming, and Layout"

= Section 5.2.3, "Printing and Exporting to an Image"
s Section 5.2.4, "Configuration Badging"

m  Section 5.2.5, "Link Specification Location Indicator"

= Section 5.2.6, "Nested Stages"

5.2.1 Flow Representation

The primary display in the editor is of the flow inside the application as Figure 5-5
shows.
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Figure 5-5 EPN Flow Representation
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The EPN is composed of nodes connected by links and streams. Nodes are of various
types including adapter, processor, database table, bean, and cache. For more
information on the graphic notation the EPN Editor uses on nodes, links, and streams,
see:

= Section 5.2.4, "Configuration Badging"

= Section 5.2.5, "Link Specification Location Indicator"

5.2.2 Filtering, Zooming, and Layout

Although you often specify your EPN in a single assembly file, you may specify an
EPN across multiple assembly files. By default the EPN Editor shows the entire
network with the information combined from all files. To see the network for a single
assembly file simply select that file from the Filter pull-down menu as Figure 5-6
shows.

Figure 5-6 Filtering the EPN by Assembly File

[5h EPM: signal_generation 53 =0

Filter: = Full EPM &t a7 [1o0% S

Full EPH X
algo_trading, contesxt, xml &
sub_Flow, context, sl

‘3»‘ . AlgoTradingBean
< Rad

socketAdapter signalgenerationProcessor

cachel

Orverviewm

You can optimize and simplify the EPN layout by clicking Layout EPN as Figure 5-7
shows.
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Figure 5-7 Optimize Layout
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You can also filter out <bean> elements with no references in the EPN. Clicking
Show/Hide Unconnected Beans will toggle the visibility of such beans as Figure 5-8
shows. For more information, see Section 5.4.3, "Laying Out Nodes".

Figure 5-8 Show/Hide Unconnected Beans
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You can change the zoom level of the EPN Editor by entering a percent value into the
zoom field or selecting a value from the zoom field pull-down menu as Figure 5-9
shows. To fit the EPN into the current EPN Editor window, select Fit to Window.

Figure 5-9 Zoom Level
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5.2.3 Printing and Exporting to an Image

You can export the EPN Editor view to an image file by clicking Export to Image as
Figure 5-10 shows. You can export the image as a .bmp, .gif, . jpg, or .png file.
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Figure 5-10 Exporting the EPN as an Image File
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You can print the EPN Editor view by clicking Print as Figure 5-11 shows.

Figure 5-11 Printing the EPN
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5.2.4 Configuration Badging

Nodes that have configuration information in one of the configuration files in the
META-INF/wlevs directories are badged with an indicator on the bottom right as
Figure 5-12 shows.

Figure 5-12 Configuration Badging

outStream
algoTradingProcessor

Nodes with this badge will also have the Go To Configuration Source context menu
item.

5.2.5 Link Specification Location Indicator
When working with streams, you can specify a link in the assembly file as a:
= source element in the downstream node.
= listener element in the upstream node

A circle on the line indicates where a particular link is specified in the assembly file.
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Figure 5-13 shows an example in which the link is specified as a source element on the
downstream node outStream so the circle is next to the out Stream node.
Figure 5-14 shows the corresponding assembly file.

Figure 5-13 Link Source

Pommmen— - W

= filkered3tream
filkerFanoutProcessor

Figure 5-14 Link Source Assembly File

<wlevs:processor 1d="hREASaE-taTaRkisd S aal
</wlevs:processor>

<wleva:channel id="filtereditream”
event-type="FilteredPriceEvent ">
<wlewvs:listener ref="bhaProcessor™ /&
<wleva:listener ref="analyticsProcessor™ />
<wlevs:source ref="filterFanoutProcessor™ />
</wlevs:channels

3 e e e e 4 3434 63 33 3 3 3 3 3 S S A e A 34 4 3 3 3 3 3 3 3 N S S e A e A3 33 3 S S S S S S S e A e A 343 3 3 N N N S N A A A3 3 A AN AN A

Figure 5-15 shows an example in which the link is specified as a listener element in the
upstream node algoTradingProcessor so the circle is next to the
algoTradingProcessor node. Figure 5-16 shows the corresponding assembly file.

Figure 5-15 Link Listener

P

4 ¥

= CrossRatesStream
FindCrossRates

Figure 5-16 Link Listener Assembly File

<wlewvs:processor id=")lsl =" provider="oglt:>

<wlevs: listener ref="CrossRateStream™/ >
</wlevsiprocessors

<wlews:channel id="CrossBate3tream” event-type="SpreaderCuputEvent” advertise="true":
<wlevs:listener ref="summarizeResulta™/>
“wlevs:listeners
<hean class="com.oracle.cep.sample.fx.0utputBean” autovire="hylame"/>
</wlevs: listeners
</wlevsichannels

5.2.6 Nested Stages

When you define a child node within a parent node, the child node is said to be
nested. Only the parent node can specify the child node as a listener. You can drag
references from a nested element, but not to them. For more information, see
Section 5.4.2, "Connecting Nodes".

Consider the EPN that Figure 5-17 shows. Example 5-1 shows the EPN assembly
source for this EPN. Note that the HelloWorldBean is nested within the
helloworldOutputChannel. As a result, it appears within a box in the EPN
diagram. Only the parent helloworldOutputChannel may specify the nested bean
as a listener.

5-8 Oracle CEP IDE Developer's Guide for Eclipse



EPN Editor Overview

Figure 5-17 EPN With Nested Bean

hellowerldInputChannel 6= helloworldOutputChannel
helloworldadapter hellowarldProcessor HelloWorldBean

Example 5-1 Assembly Source for EPN With Nested Bean

<wlevs:adapter id="helloworldAdapter"
class="com.bea.wlevs.adapter.example.helloworld.HelloWorldAdapter" >

<wlevs:instance-property name="message" value="HelloWorld - the current time is:"/>
</wlevs:adapter>

<wlevs:channel id="helloworldInputChannel" event-type="HelloWorldEvent" >
<wlevs:listener ref="helloworldProcessor"/>
<wlevs:source ref="helloworldAdapter"/>

</wlevs:channel>

<wlevs:processor id="helloworldProcessor" />

<wlevs:channel id="helloworldOutputChannel" event-type="HelloWorldEvent" advertise="true">
<wlevs:listener>
<bean class="com.bea.wlevs.example.helloworld.HelloWorldBean" />
</wlevs:listener>
<wlevs:source ref="helloworldProcessor"/>
</wlevs:channel>

Alternatively, you can define this EPN so that all nodes are nested as Figure 5-18
shows. Example 5-2 shows the EPN assembly source for this EPN. Note that all the
nodes are nested and as a result, all nodes appear within a box in the EPN diagram.
The helloworldAdapter is the outermost parent node and does not appear within a
box in the EPN diagram.

Figure 5-18 EPN With all Nodes Nested

helloworldInputChannel =
helloworldAdapter helloworldProcessor

helloworldOutputChannel

)

HelloWorldBean

Example 5-2 Assembly Source for EPN With all Nodes Nested

<wlevs:adapter id="helloworldAdapter" class="com.bea.wlevs.adapter.example.helloworld.HelloWorldAdapter" >
<wlevs:instance-property name="message" value="HelloWorld - the current time is:"/>
<wlevs:listener>
<wlevs:channel id="helloworldInputChannel" event-type="HelloWorldEvent" >
<wlevs:listener>
<wlevs:processor id="helloworldProcessor">
<wlevs:listener>
<wlevs:channel id="helloworldOutputChannel" event-type="HelloWorldEvent">
<wlevs:listener>
<bean class="com.bea.wlevs.example.helloworld.HelloWorldBean" />
</wlevs:listener>
</wlevs:channel>
</wlevs:listener>
</wlevs:processor>
</wlevs:listener>
</wlevs:channel>
</wlevs:listener>
</wlevs:adapter>
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5.3 Navigating the EPN Editor

Because the EPN Editor has a view of the whole project it is a natural place from which
to navigate to the various artifacts that make up an Oracle CEP application. Oracle
CEP IDE for Eclipse offers the following features to help navigate the EPN Editor:

= Section 5.3.1, "Moving the Canvas"
= Section 5.3.2, "Shortcuts to Component Configuration and EPN Assembly Files"
= Section 5.3.3, "Hyperlinking"

m  Section 5.3.4, "Context Menus"

5.3.1 Moving the Canvas

To move the EPN canvas without using the horizontal and vertical scroll bars, you can
use any of the following options:

= Position the cursor on the canvas, hold down the middle mouse button, and drag.
=  Hold down the space bar and click and drag the canvas.

s In the Overview view, click in the highlight box and drag.

5.3.2 Shortcuts to Component Configuration and EPN Assembly Files

If a node has a configuration object associated with it, then double-clicking that node
will open the component configuration file where that node's behavior is defined.

Otherwise, double-clicking that node will open the EPN assembly file (the Spring
context file) where that node is defined.

A configuration badge will be shown on nodes with associated configuration objects
as shown in Figure 5-19.

Figure 5-19 Node with Configuration Badge

&)
exampleProcess ot
For more information, see:

= Section 5.2.4, "Configuration Badging"
= Section 5.3.3, "Hyperlinking"

5.3.3 Hyperlinking

When editing a component configuration file or EPN assembly file, hold down the Ctrl
key to turn on hyperlinking. Using hyperlinking, you can easily move between
assembly and configuration files and follow reference IDs to jump to bean
implementation classes.

Figure 5-20 shows a component configuration file with the cursor over the value of a
processor element name child element while holding down the Ctrl key. The name
value has an underline to indicate it is a hyperlink. Click this link to jump to the
corresponding element in the EPN assembly file as Figure 5-21 shows.
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Figure 5-20 Component Configuration File: Hyperlinking to EPN Assembly File
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Similarly, hovering over the wlevs : processor element id child element value
filterFanoutProcessor while holding down the Ctrl key allows you to hyperlink
back to the component configuration file.

Figure 5-21 EPN Assembly File: Hyperlinking to Component Configuration File

Fﬁ'@’g EFM: COLTest ¥ citipoc,context.xml 22 X com.oracle.cep.sample.fx. context. xml |X| citipoc, xml o]
a1 </wlevs:adapters> A
52
53 <wlevs:channel id="price3tream”™ event-type="PriceEvent™:

54 <wlevs:listener ref="filterFanoutProcessor"™ />
85 <wlevs:source ref="Pricelidapter™ />

101

</wlevs:channel>
<!—-— By default, CQL i= used for OCEP 11.0 —-->

<wlevs:processor id="filtcerFanoutProcessor™ >
!

«</wlevs:processor>

<wlevs:channel id="filtered3tream™
event-type="FilteredPriceEwvent™:
<wlevs:listener ref="bbaProcessor™ />
<wlevs:listener ref="analyticsProcessor"™ />
<wlevs:source ref="filterFanoutProcessor”™ /&
</wlevs:channel>

<!-— Ewplicitly specify provider CQL -->
<wlevs:processor id="bbaProcessor™ provider="ooglt™:

<wlevs:listener ref="bidiskBBEAStream" />
</wlevs:processor>

Design | Source

5.3.4 Context Menus

Each node on the EPN Editor has a group of context menu items that provide
convenient access to various node-specific functions. Right-click the node to display its
context menu.
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Depending on the node type, you can use the EPN Editor context menu to select from
the following options:

= Go to Configuration Source: opens the corresponding component configuration
file and positions the cursor in the appropriate element. You can use hyperlinking
to quickly move from this file to the corresponding EPN assembly file. For more
information, see Section 5.3.3, "Hyperlinking".

= Go to Assembly Source: opens the corresponding EPN assembly file and
positions the cursor in the appropriate element. You can use hyperlinking to
quickly move from this file to the corresponding component configuration file. For
more information, see Section 5.3.3, "Hyperlinking"

= Go to Java Source: opens the corresponding Java source file for this component.

s Delete: deletes the component from both the EPN assembly file and component
configuration file (if applicable).

= Rename: allows you to change the name of the component. The name is updated
in both the EPN assembly file and component configuration file (if applicable).

= Help: displays context sensitive help for the component.

Note that these navigation options will become disabled when a corresponding source
artifact cannot be found. For example, if an adapter does not have a corresponding
entry in a configuration XML file, its Go to Configuration Source menu item will be
greyed out.

5.4 Using the EPN Editor

The EPN Editor allows you to create and edit an application's EPN using actions on
the editor surface. Most actions in the EPN Editor result in edits to an assembly file in
that application.

The EPN Editor shows the EPN for a single Oracle CEP application bundle. An
application may have more than one assembly file that defines the application EPN as
Figure 5-22 shows.

Figure 5-22 EPN Editor Filter

[El EPM: SimpleProject 52 =0

Filker: &SimpIeProject.context.xml &b AL 100% E =
Full EPM
Secondassembly, context, xm
SimpleProject. conbext, xml

Cvervien

When editing an EPN, the assembly file shown in the EPN Editor filter is the assembly
file to which new nodes will be added. If the EPN Editor filter is set to Full EPN then
the first assembly file in the filter list will be the file to which new nodes will be added.
Existing nodes will be edited in or deleted from the assembly file in which they are
defined.
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If the assembly file the EPN Editor edits is open in an Eclipse source editor, then the
edits will be made to the editor for that open file. In this case, you will need to save
changes to the open editor before the changes appear in the file on disk.

If the assembly file the EPN Editor edits is not open in an Eclipse source editor, then
the edits are immediately applied to the file on disk.

The following sections describe EPN Editor editing tasks, including;:
»  Section 5.4.1, "Creating Nodes"

= Section 5.4.2, "Connecting Nodes"

= Section 5.4.3, "Laying Out Nodes"

= Section 5.4.4, "Renaming Nodes"

= Section 5.4.5, "Deleting Nodes"

For more information, see:

= Section 3.1, "Oracle CEP Project Overview"
s Section 5.2, "EPN Editor Overview"

= Section 5.1, "Opening the EPN Editor"

= Section 5.3, "Navigating the EPN Editor"

5.4.1 Creating Nodes

When adding new nodes to an EPN using the EPN editor, a new node will appear at
the location of the mouse click that was used to show the EPN Editor context menu.
You can create any of the nodes that Table 5-1 lists.

Table 5-1 EPN Editor Icons

Node Description

o Adapter: a node that interfaces an event data source with the EPN or interfaces
e the EPN with an event data sink.

For more information, see:

s Chapter 6, "Configuring J]MS Adapters"

= Chapter 7, "Configuring HTTP Publish-Subscribe Server Adapters"

= Chapter 8, "Configuring Custom Adapters, Event Beans, and Spring Beans"

s Chapter 15, "Testing Applications With the Load Generator and csvgen
Adapter”

\ Bean: a Plain Old Java Object (POJO) node that consumes events. A bean is
& managed by the Spring framework.

For more information, see Chapter 8, "Configuring Custom Adapters, Event
Beans, and Spring Beans".

Cache: a node that provides a temporary storage area for events, created
exclusively to improve the overall performance of your Oracle CEP application.

For more information, see Chapter 12, "Configuring Caching".

CT D Channel: a node that conveys events between an event data source and an
event data sink.

For more information, see Chapter 9, "Configuring Channels".
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Table 5-1 (Cont.) EPN Editor Icons

Node Description
' Event Bean: a node similar to a standard Spring bean except that it can be
@ managed by the Oracle CEP management framework and can actively use the

capabilities of the Oracle CEP server container.

For more information, see Chapter 8, "Configuring Custom Adapters, Event
Beans, and Spring Beans".

Table: a node that connects a relational database table to the EPN as an event
data source.

For more information, see Section 10.3, "Configuring an Oracle CQL Processor
Table Source".

o Processor: a node that executes Oracle CQL or EPL rules on the event data
- offered to it by one or more channels.

For more information, see:
= Chapter 10, "Configuring Oracle CQL Processors"
= Chapter 11, "Configuring EPL Processors"

5-14 Oracle CEP

The user may not reposition the nodes on the EPN Editor. To refresh the layout of the
nodes on the EPN Editor, click the Layout EPN button on the EPN Editor toolbar. For
more information, see Section 5.4.3, "Laying Out Nodes".

When a child node is nested within a parent node, its icon appears within a box. For
more information, see Section 5.2.6, "Nested Stages".

This section describes:
s Section 5.4.1.1, "How to Create a Basic Node"

s Section 5.4.1.2, "How to Create a Processor Node"

5.4.1.1 How to Create a Basic Node

Basic nodes include adapters, beans, caches, channels, event beans, and tables. For
information on how to create a processor node, see Section 5.4.1.2, "How to Create a
Processor Node".

To create a basic node:
1. Open the EPN Editor (see Section 5.1, "Opening the EPN Editor").

2. Right-click on an empty portion of the EPN Editor surface and select New from
the context menu as Figure 5-23 shows.
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Figure 5-23 Creating a Basic Node
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3. Select the type of node you want to create.

The EPN Editor edits the source file indicated in the EPN Editor filter and the EPN
Editor displays the new EPN node. For most nodes, a default ID is chosen and the
new node is immediately opened for rename as Figure 5-24 shows.

Figure 5-24 New Basic Node
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To rename the node, see Section 5.4.4, "Renaming Nodes".

To reposition the node and update the EPN Editor layout, see Section 5.4.3,
"Laying Out Nodes".

4. Optionally, configure additional node options.
See:
»  Chapter 6, "Configuring J]MS Adapters"
»  Chapter 7, "Configuring HTTP Publish-Subscribe Server Adapters"
»  Chapter 8, "Configuring Custom Adapters, Event Beans, and Spring Beans"
»  Chapter 9, "Configuring Channels"
= Section 10.3, "Configuring an Oracle CQL Processor Table Source"
»  Chapter 12, "Configuring Caching"

»  Chapter 15, "Testing Applications With the Load Generator and csvgen
Adapter"
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5.4.1.2 How to Create a Processor Node

This section describes how to create a processor node using the EPN Editor. For
information on creating other node types, see Section 5.4.1.1, "How to Create a Basic

Node".

When deploying an Oracle CEP application with a wlevs:processor node, other
nodes in an EPN may reference that processor only if a processor configuration exists
for that processor. Processor configurations are defined in Oracle CEP application
configuration files. See Section 1.1.5, "Component Configuration Files" for more
information about CEP configuration files.

To create a processor node:

1. Open the EPN Editor (see Section 5.1, "Opening the EPN Editor").

2. Right-click on an empty portion of the EPN Editor surface and select New from
the context menu as Figure 5-25 shows.

Figure 5-25 Creating a Processor Node
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3. Select node type Processor.
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The New Processor dialog appears as shown in Figure 5-26.

Figure 5-26 New Processor Dialog

& New Processor,

Specify an 1D and configuration location for the new processor, @

Processor ID;

Configuration location:
(%) Create a new file:

| processar, xml

() Use an existing configuration file:

@] [

Ok H Caneel ]

4. Configure the New Processor dialog as shown in Table 5-2.
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Table 5-2 New Processor Dialog

Attribute

Description

Processor ID

Specifies the ID of the processor EPN element and the
name of the associated processor configuration element

Create a new file

Creates the processor configuration in a new file.

The new file is created in the application's
META-INF/wlevs directory with the same name as the
processor ID.

Use an existing configuration file

Creates the processor configuration in an existing
configuration file.

The new processor configuration element is appended to
the configurations in the selected file.

5. Click OK.

The EPN Editor creates the processor configuration in the file you specified in the
New Processor dialog, edits the source file indicated in the EPN Editor filter, and
displays the new EPN node as Figure 5-27 shows.

Figure 5-27 New Processor Node
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To rename the node, see Section 5.4.4, "Renaming Nodes".

To reposition the node and update the EPN Editor layout, see Section 5.4.3,

"Laying Out Nodes".

Note: In Oracle CEP, you must use a channel to connect an event
source to an Oracle CQL processor and to connect an Oracle CQL
processor to an event sink. A channel is optional with other Oracle

CEP processor types.

6. Optionally, configure additional processor options.

See:

s Chapter 10, "Configuring Oracle CQL Processors"

s Chapter 11, "Configuring EPL Processors"

Oracle CEP IDE for Eclipse and the Event Processing Network 5-17




Using the EPN Editor

5.4.2 Connecting Nodes

The nodes in the EPN represent the flow of events through an Event Processing
Network of an Oracle CEP application. When a node may forward events to another
node in the EPN, the EPN Editor allows you to connect that node visually by dragging
a line from the source node to the destination node.

5.4.2.1 How to Connect Nodes
This section describes how to connect nodes in the EPN Editor.

To connect nodes:
1. Open the EPN Editor (see Section 5.1, "Opening the EPN Editor").

2. Select the source of events and drag to the target of the event flow.

= If a connection is allowed, a plug icon is shown at the target end as
Figure 5-28 shows.

Figure 5-28 Connecting Nodes: Connection Allowed
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s If the connection is not allowed, a forbidden icon is shown at the target end as
Figure 5-29 shows.

Qverview

Figure 5-29 Connecting Nodes: Connection Forbidden
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Not all nodes may be a target of event flow. For example, connection is
forbidden if:

— A node does not define a valid identifier.
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- A node is nested (for more information, see Section 5.2.6, "Nested Stages").
3. Release the mouse button to complete the connection.

When the connection is made, the EPN Editor updates the EPN assembly file. For
example:

= When you connect an adapter to a channel or a channel to a processor or event
bean, the EPN Editor adds a wlevs:1listener element to the source node
with a reference to the target node by ID.

= When you connect a table to a processor, the EPN Editor adds a
wlevs:table-source element to the target processor node that references
the source table.

For example, suppose you connect the adapter to the channel, and the channel to
the processor shown in Figure 5-30.

Figure 5-30 Valid Connections

channel
adapter processor

Figure 5-31 shows the EPN assembly file before connection.

Figure 5-31 EPN Assembly File: Before Connection

<wlevs:adapter id="adapter" provider="httppuh™:>
</wlevs:adapters

<wlevsichannel id="channel">
</wlevs:channel>

<wlevs:processor id="processor -
</wlevs:processor:>

Figure 5-32 shows the EPN assembly file after connection.

Figure 5-32 EPN Assembly File: After Connection

<wlevs:adapter id="adapter" provider="httppuk:
<wlevs:listener ref="channel" />
</wlevs:adapters

<wlevz:channel id="channel™:-
<wlevs: listener ref="processor"™ >
</ wlevs:channelx

<wlevs:processor id="processor™:
</wlevs:processor>

5.4.3 Laying Out Nodes

Certain EPN Editor actions will use the location of the action as the location of the
rendered result. For example, when adding new nodes to an EPN using the EPN
editor, a new node will appear at the location of the mouse click that was used to show
the EPN Editor context menu. The user may not reposition the nodes on the EPN
Editor. To refresh the layout of the nodes on the EPN Editor, click the Layout EPN
button on the EPN Editor toolbar as Figure 5-33 shows.
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Figure 5-33 Laying Out Nodes
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For more information, see Section 5.2.2, "Filtering, Zooming, and Layout".

5.4.4 Renaming Nodes

Most node types support a rename operation that will change all references to the
node across both assembly and configuration XML files. You can select Rename from
the node’s context menu as Figure 5-34 shows.

Figure 5-34 Renaming Nodes

| Goto Assembly Source ‘

5.4.5 Deleting Nodes

You may delete most nodes and connections visible on the EPN Editor using the

node’s context menu. Right-click on the object to show the context menu, then select
Delete as Figure 5-35 shows.

Figure 5-35 Deleting Nodes
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When deleting a node, the incoming and outgoing connections are also deleted. For

example, Figure 5-36 shows the EPN and Figure 5-38 shows the assembly file before
deleting the channel node named stream.
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Figure 5-36 EPN Before Deleting a Channel Node
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Figure 5-37 Assembly File Before Deleting a Channel Node

<wlevs:adapter id="adapter" provider="httppubh™:>
<wleva:listener ref="channel" />
</wlevs:adapters
<wlevs:channel id="channel™:
<wlevs: listener ref="processor"™ />

</wlevs:channels

<wlevz:processor id="processor':
</wlevs:processors

Figure 5-38 shows the EPN and Figure 5-39 shows the assembly file after deleting this
channel node.

Figure 5-38 EPN After Deleting a Channel Node
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Figure 5-39 Assembly File After Deleting a Channel Node

<wlews:adapter id="adapter”™ provider="httppub">

</wlevs:adapters

<wlewvs:processor id="processor:>
</wlevsiprocessors
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Note: If a bean or other anonymous element is deleted, then the
object containing that object is deleted too. For example, given a
bean within a wlevs: listener element, then deleting the bean
will delete the 1istener element too.
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6

Configuring JMS Adapters

This section contains information on the following subjects:
= Section 6.1, "Overview of J]MS Adapter Configuration"
= Section 6.2, "Using JMS Adapters"

6.1 Overview of JMS Adapter Configuration

Oracle CEP provides two Java Message Service (JMS) adapters that you can use in
your event applications to send and receive messages to and from a JMS queue,
respectively, without writing any Java code.

The built-in JMS adapter supports the following modes of operation:
s Section 6.1.1, "Inbound JMS"

s Section 6.1.2, "Outbound JMS"

Oracle CEP supports the following JMS providers:

s Oracle WebLogic JMS

= TIBCO EMS JMS

Oracle CEP includes a WebLogic JMS client. When connecting to Oracle WebLogic
server, Oracle CEP uses the T3 client by default. You can use the IIOP WebLogic client
by starting Oracle WebLogic Server with the ~useIIOP command-line argument. This
is a server-wide setting that is independent of the J]MS code being used (whether it is
one of the provided adapters or custom JMS code). It is not possible to mix T3 and
IIOP usage within a running Oracle CEP server.

If you are using a JMS provider other than WebLogic JMS, such as TIBCO, you must
include the appropriate client jar as a library within your application jar.

For general information about JMS, see Java Message Service on the Sun Developer
Network athttp://java.sun.com/products/jms/.

6.1.1 Inbound JMS

The inbound JMS adapter receives messages from a JMS queue and automatically
converts them into events by matching property names with a specified event type.
Typically, you also customize this conversion by writing your own Java class to specify
exactly how you want the incoming JMS messages to be converted into one or more
event types.

If you do not provide your own converter class, and instead let Oracle CEP take care
of the conversion between messages and event types, the following is true:
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You must specify an event type that Oracle CEP uses in its conversion. See
Section 6.2.3, "Configuring the JMS Adapters" for details.

By default, the inbound JMS adapter default converter expects incoming JMS
messages to be of type MapMessage. For each incoming message, an event of the
specified event type is created. For each map element in the incoming message, the
adapter looks for a property on the event-type and if found, sets the
corresponding value.

For more information, see Section 6.1, "Overview of J]MS Adapter Configuration".

6.1.2 Outbound JMS

The outbound JMS adapter sends events to a JMS queue, automatically converting the
event into a J]MS map message by matching property names with the event type.
Typically, you also customize this conversion by writing your own Java class to specify
exactly how you want the event types to be converted into outgoing JMS messages.

If you do not provide your own converter class, and instead let Oracle CEP take care
of the conversion between messages and event types, the following is true:

You must specify an event type that Oracle CEP uses in its conversion. See
Section 6.2.3, "Configuring the JMS Adapters" for details.

By default, the outbound JMS adapter default converter creates JMS messages of
type MapMessage. For each property of the event, a corresponding element is
created in the output MapMessage.

For more information, see Section 6.1, "Overview of J]MS Adapter Configuration".

6.2 Using JMS Adapters

The following procedure describes the typical steps to use the JMS adapters provided
by Oracle CEP.

Note: It assumed in this section that you have already created an
Oracle CEP application along with its EPN assembly file and
component configuration files, and that you want to update the
application to use an inbound or outbound JMS adapter. If you have
not, refer to Chapter 1, "Overview of Creating Oracle CEP
Applications" for details.

To use JMS adapters:

1.

Optionally create a converter Java class if you want to customize the way JMS
messages are converted into event types, or vice versa in the case of the outbound
JMS adapter. This step is optional because you can let Oracle CEP make the
conversion based on mapping property names between JMS messages and a
specified event type.

See Section 6.2.1, "Creating a Custom Converter Between JMS Messages and Event
Types."

Update the EPN assembly file of the application by adding a <wlevs:adapter>
tag for each inbound and outbound JMS adapter you want to use in your
application.

See Section 6.2.2, "Updating the EPN Assembly File With JMS Adapters."
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3. Configure the JMS properties of the JMS adapter by updating the component
configuration file.

See Section 6.2.3, "Configuring the JMS Adapters."

4. Update the MANIFEST . MF file of your application, adding the package
com.bea.core.encryption to the Import-Package header. For example:

Import-Package:
com.bea.core.encryption
com.bea.wlevs.adapter.defaultprovider;version="2.0.0.0",

See Section 14.2.2.1, "Creating the MANIFEST.MF File" for additional information
on the manifest file.

6.2.1 Creating a Custom Converter Between JMS Messages and Event Types

If you want to customize the way a JMS message is converted to an event type, or vice
versa, you must create your own converter bean.

The custom converter bean for an inbound JMS must implement the
com.bea.wlevs.adapters.jms.api.InboundMessageConverter interface.
This interface has a single method:

public List convert (Message message) throws MessageConverterException, JMSException;

The message parameter corresponds to the incoming JMS message and the return
value is a List of events that will be passed on to the next stage of the event
processing network.

The custom converter bean for an outbound JMS must implement the
com.bea.wlevs.adapters.jms.api.OutboundMessageConverter interface.
This interface has a single method:

public List<Message> convert (Session session, Object event) throws MessageConverterException,
JMSException;

The parameters correspond to an event received by the outbound JMS adapter from
the source node in the EPN and the return value is a List of J]MS messages.

See the Oracle CEP Java API Reference for a full description of these APIs.

The following example shows the Java source of a custom converter bean that
implements both InboundMessageConverter and OutboundMessageConvert;
this bean can be used for both inbound and outbound JMS adapters:

package com.customer;

import com.bea.wlevs.adapters.jms.api.InboundMessageConverter;

import com.bea.wlevs.adapters.jms.api.MessageConverterException;

import com.bea.wlevs.adapters.jms.api.OutboundMessageConverter;

import javax.jms.JMSException;

import javax.jms.Message;

import javax.jms.Session;

import javax.jms.TextMessage;

import java.util.ArrayList;

import java.util.List;

public class MessageConverter implements InboundMessageConverter, OutboundMessageConverter {

public List convert (Message message) throws MessageConverterException, JMSException {

TestEvent event = new TestEvent();
TextMessage textMessage = (TextMessage) message;
event.setString_ 1 (textMessage.getText());
List events = new ArrayList(l);
events.add(event) ;
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return events;

}

public List<Message> convert (Session session, Object inputEvent) throws

MessageConverterException, JMSException {

TestEvent event = (TestEvent) inputEvent;
TextMessage message = session.createTextMessage (
"Text message: " + event.getString 1()

)

List<Message> messages = new ArrayList<Message>();
messages.add (message) ;

return messages;

6.2.2 Updating the EPN Assembly File With JMS Adapters

For each JMS adapter in your event processing network, you must add a
corresponding <wlevs:adapter> tag to the EPN assembly file of your application;
use the provider attribute to specify whether the JMS adapter is inbound or
outbound. Follow these guidelines:

If you are specifying an inbound JMS adapter, set the provider attribute to
jms-inbound, as shown:

<wlevs:adapter id="jmsInbound" provider="jms-inbound"/>

The value of the id attribute, in this case jms Inbound, must match the name
specified for this JMS adapter in its configuration file. The configuration file
configures the JMS queue from which this inbound JMS adapter gets its messages.

Because no converter bean is specified, Oracle CEP automatically converts the
inbound message to the event type specified in the component configuration file
by mapping property names.

If you are specifying an outbound JMS adapter, set the provider attribute to
jms-outbound, as shown:

<wlevs:adapter id="jmsOutbound" provider="jms-outbound"/>

The value of the id attribute, in this case jmsOutbound, must match the name
specified for this JMS adapter in its configuration file. The configuration file
configures the JMS queue to which this outbound JMS adapter sends messages.

Because no converter bean is specified, Oracle CEP automatically converts the
incoming event types to outgoing JMS messages by mapping the property names.

For both inbound and outbound JMS adapters, if you have created a custom
converter bean to customize the conversion between the JMS messages and event
types, first use the standard <bean> Spring tag to declare it in the EPN assembly
file. Then pass a reference of the bean to the JMS adapter by specifying its id using
the <wlevs:instance-property> tag, with the name attribute set to
converterBean, as shown:

<bean id="myConverter"
class="com.customer.MessageConverter"/>
<wlevs:adapter id="jmsOutbound" provider="jms-outbound">
<wlevs:instance-property name="converterBean" ref="myConverter"/>
</wlevs:adapter>

In this case, be sure you do not specify an event type in the component
configuration file because it is assumed that the custom converter bean takes care
of specifying the event type.
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As with any other stage in the EPN, add listeners to the <wlevs:adapter> tag to
integrate the JMS adapter into the event processing network. Typically, an inbound
JMS adapter is the first stage in an EPN (because it receives messages) and an
outbound JMS adapter would be in a later stage (because it sends messages). However,
the requirements of your own Oracle CEP application define where in the network the
JMS adapters fit in.

The following sample EPN assembly file shows how to configure an outbound JMS
adapter. The network is simple: a custom adapter called getData receives data from
some feed, converts it into an event type and passes it to myProcessor, which in turn
sends the events to the jmsOutbound JMS adapter via the st reamOne channel.
Oracle CEP automatically converts these events to JMS messages and sends the
messages to the JMS queue configured in the component configuration file associated
with the jmsOutbound adapter.

<?xml version="1.0" encoding="UTF-8"?>
<beans xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:osgi="http://www.springframework.org/schema/osgi"
xmlns:wlevs="http://www.bea.com/ns/wlevs/spring"
xsi:schemalocation="
http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans.xsd
http://www.springframework.org/schema/osgi
http://www.springframework.org/schema/osgi/spring-osgi.xsd
http://www.bea.com/ns/wlevs/spring
http://www.bea.com/ns/wlevs/spring/spring-wlevs-v1l1l_0_0_0.xsd">
<wlevs:event-type-repository>
<wlevs:event-type type-name="JMSEvent">
<wlevs:class>com.customer.JMSEvent</wlevs:class>
</wlevs:event-type>
</wlevs:event-type-repository>
<!-- Custom adapter that gets data from somewhere and sends it to myProcessor -->
<wlevs:adapter id="getData"
class="com.customer.GetData">
<wlevs:listener ref="myProcessor"/>
</wlevs:adapter>
<wlevs:processor id="myProcessor" />
<wlevs:adapter id="jmsOutbound" provider="jms-outbound"/>
<!-- Channel for events flowing from myProcessor to outbound JMS adapter -->
<wlevs:channel id="streamOne">
<wlevs:listener ref="jmsOutbound"/>
<wlevs:source ref="myProcessor"/>
</wlevs:channel>
</beans>

The following sample EPN assembly file shows how to configure an inbound JMS
adapter. The network is simple: the inbound JMS adapter called jmsInbound receives
messages from the JMS queue configured in its component configuration file. The
Spring bean myConverter converts the incoming JMS messages into event types, and
then these events flow to the mySink event bean.

<?xml version="1.0" encoding="UTF-8"?>
<beans xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:osgi="http://www.springframework.org/schema/osgi"
xmlns:wlevs="http://www.bea.com/ns/wlevs/spring"
xs1:schemalocation="
http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans.xsd
http://www.springframework.org/schema/osgi
http://www.springframework.org/schema/osgi/spring-osgi.xsd
http://www.bea.com/ns/wlevs/spring
http://www.bea.com/ns/wlevs/spring/spring-wlevs-v1l1l_0_0_0.xsd">
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<wlevs:event-type-repository>
<wlevs:event-type type-name="JMSEvent">
<wlevs:class>com.customer.JMSEvent</wlevs:class>
</wlevs:event-type>
</wlevs:event-type-repository>
<!-- Event bean that is an event sink -->
<wlevs:event-bean id="mySink"
class="com.customer.MySink" />
<!-- Inbound JMS adapter with custom converter class; adapter sends events to mySink
event bean-->
<bean id="myConverter" class="com.customer.MessageConverter"/>
<wlevs:adapter id="jmsInbound" provider="jms-inbound">
<wlevs:instance-property name="converterBean" ref="myConverter"/>
<wlevs:listener ref="mySink"/>
</wlevs:adapter>
</beans>

6.2.3 Configuring the JMS Adapters

You configure the JMS adapters in their respective configuration files, similar to how
you configure other components in the event processing network, such as processors
or streams. For general information about these configuration files, see Section 1.1.5,

"Component Configuration Files."

The root element for configuring a JMS adapter is jms-adapter. The name child
element for a particular adapter must match the 1d attribute of the corresponding
wlevs:adapter element in the EPN assembly file that declares this adapter.

The following table describes the additional child elements of jms-adapter you can
configure for both inbound and outbound JMS adapters.

Table 6-1 Child Elements of jms-adapter for Inbound and Outbound Adapters

Child Element Description

event-type Event type whose properties match the JMS message properties.

Specify this child element only if you want Oracle CEP to automatically
perform the conversion between JMS messages and events. If you have
created your own custom converter bean, then do not specify this element.

jndi-provider-url Required. The URL of the JNDI provider.

jndi-factory Optional. The JNDI factory name. Default value is
weblogic.jndi.WLInitialContextFactory, for Oracle CEP server
JMS.

connection-jndi-name | Optional. The JNDI name of the JMS connection factory. Default value is
weblogic.jms.ConnectionFactory, for Oracle CEP server JMS.

destination-jndi-name | Required. Either the JNDI name, or actual name, of the JMS destination.

destination-name Specify one or the other, but not both.

user Optional. The username for the external resource.
password Optional The password for the external resource.
encrypted-password Optional. The encrypted password for the external resource.

See Section 6.2.4, "Encrypting Passwords in the JMS Adapter Configuration
File" for details on encrypting the password.

The following table lists the optional child elements of jms-adapter you can
configure for inbound JMS adapters only.
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Table 6-2 Optional Child Elements for Inbound JMS Adapters

Child Element Description

work-manager Name of a work manager, configured in the server's config.xml file. This
name corresponds to the value of the <name> child element of the
<work-manager> element in config.xml.

The default value is the work manager configured for the application itself.

concurrent-consumers | Number of consumers to create. Default value is 1.

If you set this value to number greater than one, be sure that your
converter bean is thread-safe. This is because the converter bean will be
shared among the consumers.

message-selector JMS message selector to use to filter messages.

session-ack-mode-name | Session acknowledgement mode.

session-transacted Boolean value that specifies whether to use transacted sessions.

The following table lists the optional child elements of jms-adapter you can
configure for outbound JMS adapters only.

Table 6-3 Optional Child Elements for Outbound JMS Adapters

Child Element Description

delivery-mode | Specifies the delivery mode: persistent (default value) or nonpersistent.

For the full schema for the configuration of J]MS adapters, see Section B.1, "Component
Configuration Schema wlevs_application_config.xsd".

The following configuration file shows a complete example of configuring both an
inbound and outbound JMS adapter.

<?xml version="1.0" encoding="UTF-8"?>
<nl:config
xsi:schemalocation="http://www.bea.com/ns/wlevs/config/application wlevs_application_
config.xsd"
xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<jms-adapter>
<name>jmsInbound</name>
<jndi-provider-url>t3://localhost:7001</jndi-provider-url>
<destination-jndi-name>Queuel</destination-jndi-name>
<user>weblogic</user>
<password>weblogic</password>
<work-manager>JettyWorkManager</work-manager>
<concurrent-consumers>1</concurrent-consumers>
<session-transacted>false</session-transacted>
</Jjms-adapter>
<jms-adapter>
<name>jmsOutbound</name>
<event-type>JMSEvent</event-type>
<jndi-provider-url>t3://localhost:7001</jndi-provider-url>
<destination-jndi-name>Topicl</destination-jndi-name>
<delivery-mode>nonpersistent</delivery-mode>
</jms-adapter>
</nl:config>

The following snippet shows how to configure an inbound JMS adapter connecting to
TIBCO EMS JMS:

<jms-adapter>
<name>myJmsAdapter</name>
<jndi-provider-url>t3://localhost:7222</jndi-provider-url>
<jndi-factory>com.tibco.tibjms.naming.TibjmsInitialContextFactory</jndi-factory>
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<connection-jndi-name>TibcoQueueConnectionFactory</connection-jndi-name>
<destination-jndi-name>MyQueue</destination-jndi-name>

</jms-adapter>

6.2.4 Encrypting Passwords in the JMS Adapter Configuration File

You can encrypt the password in the JMS adapter configuration file.

Note: The procedure assumes that you are currently using the
<password> element in the configuration file, along with a cleartext
password value, but want to start using the
<encrypted-password> element to encrypt the password.

To encrypt passwords in the JMS adapter configuration file:

1.

Open a command window and set your environment as described in "Setting Your
Development Environment" in the Oracle CEP Getting Started.

Change to the directory that contains the configuration file for your JMS adapter.

Execute the following encryptMSAConfig command to encrypt the value of the
<password> element in the configuration file:

prompt> ORACLE_CEP_HOME/ocep_11.1/bin/encryptMSAConfig . config file
msainternal.dat_file

where ORACLE_CEP_HOME refers to the main BEA directory into which you
installed Oracle CEP, such as d: \oracle_cep. The second argument refers to
the directory that contains the JMS adapter configuration file; because this
procedure directs you to actually change to the directory, the example shows " . ".
The config file parameter refers to the name of your JMS adapter
configuration file. Finally, the msainternal.dat_file parameter refers to the
location of the .msainternal.dat file associated with your domain; by default
this file is located in the DOMAIN_DIR/servername directory, where DOMAIN
DIR refers to the domain directory such as /oracle_cep/user_
projects/domains/mydomain and servername refers to the server instance.

The encryptMSAConfig command comes in two flavors:
encryptMSAConfig.cmd (Windows) and encryptMSAConfig. sh (UNIX).

After you run the command, the value of the <password> element will be
encrypted, as shown in bold in the following example:

<jms-adapter>
<name>jmsInbound</name>
<jndi-provider-url>t3://localhost:7001</jndi-provider-url>
<destination-jndi-name>Queuel</destination-jndi-name>
<user>weblogic</user>
<password>{Salted-3DES}B7L6nehu7dgPtJITnTIJWRA==</password>
<work-manager>JettyWorkManager</work-manager>
<concurrent-consumers>1</concurrent-consumers>
<session-transacted>false</session-transacted>

</jms-adapter>

Using your favorite XML editor, edit the JMS adapter configuration file. Change
the <password> element (whose value is now encrypted) to
<encrypted-password>, as shown in bold in the following example:

<jms-adapter>
<name>jmsInbound</name>
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<jndi-provider-url>t3://localhost:7001</jndi-provider-url>
<destination-jndi-name>Queuel</destination-jndi-name>

<user>weblogic</user>
<encrypted-password>{Salted-3DES}B7L6nehu7dgPtJITnTIJWRA==</encrypted-password

<work-manager>JettyWorkManager</work-manager>

<concurrent-consumers>1</concurrent-consumers>

<session-transacted>false</session-transacted>
</jms-adapter>
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Configuring HTTP Publish-Subscribe Server
Adapters

This section contains information on the following subjects:

1

= Section 7.1, "Overview of HTTP Publish-Subscribe Server Adapter Configuration'
= Section 7.2, "Using the Built-In HTTP Pub-Sub Adapters in an Application"

7.1 Overview of HTTP Publish-Subscribe Server Adapter Configuration

An HTTP Publish-Subscribe server (pub-sub server) is a mechanism whereby Web
clients, such as browser-based clients, subscribe to channels, receive messages as they
become available, and publish messages to these channels, all using asynchronous
messages over HTTP. A channel is similar to a JMS topic.

Every instance of Oracle CEP includes a pub-sub server that programmers can use to
implement HTTP publish-subscribe functionality in their applications. The pub-sub
server is configured in the config.xml file along with other server services such as
Jetty and JDBC datasources. The pub-sub server is based on the Bayeux protocol (see
http://svn.xantus.org/shortbus/trunk/bayeux/bayeux.html) proposed
by the cometd project (see http://cometd. com/). The Bayeux protocol defines a
contract between the client and the server for communicating with asynchronous
messages over HTTP.

In Oracle CEP, programmers access HTTP publish-subscribe functionality by using the
following built-in HTTP publish-subscribe adapters (pub-sub adapters):

= Publishing to a channel: see Section 7.1.1, "Overview of the Built-In Pub-Sub
Adapter for Publishing"

— Local publishing to a channel: see Section 7.1.1.1, "Local Publishing".
- Remote publishing to a channel: see Section 7.1.1.2, "Remote Publishing".

= Subscribing to a channel: see Section 7.1.2, "Overview of the Built-In Pub-Sub
Adapter for Subscribing".

Oracle CEP also provides a pub-sub API for programmers to create their own custom
pub-sub adapters for publishing and subscribing to a channel, if the built-in pub-sub
adapters are not adequate. For example, programmers might want to filter incoming
messages from a subscribed channel, dynamically create or destroy local channels, and
so on. The built-in pub-sub adapters do not provide this functionality, which is why
programmers must implement their own custom pub-sub adapters in this case. For
details, see Chapter 8, "Configuring Custom Adapters, Event Beans, and Spring
Beans."
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By default, Oracle CEP performs automatic conversion to and from Oracle CEP event
types. Alternatively, you can create a custom converter. See Section 7.2.1, "Creating a
Custom Converter Between the HTTP Pub-Sub Messages and Event Types".

Oracle CEP can also automatically convert between JSON messages and Oracle CEP
event types. See Section 7.1.3, "Converting Between JSON Messages and Event Types".

The built-in pub-sub adapters work like any other adapter: they are stages in the event
processing network, they are defined in the EPN assembly file, and they are
configured with the standard component configuration files. Typical configuration
options include specifying channels, specifying the local or remote pub-sub server, and
user authentication.

The pub-sub server can communicate with any client that can understand the Bayeux
protocol. Programmers developer their Web clients using one of the following
frameworks:

= Dojo JavaScript library (see http://dojotoolkit.org/) that supports the
Bayeux protocol. Oracle CEP does not provide this library.

s WebLogic Workshop Flex plug-in that enables development of a Flex client that
uses the Bayeux protocol to communicate with a pub-sub server.

For information on securing an HTTP pub-sub server channel, see "Configuring HTTP
Publish-Subscribe Server Channel Security" in the Oracle CEP Administrator’s Guide.

7.1.1 Overview of the Built-In Pub-Sub Adapter for Publishing

You can use the built-in pub-sub adapter for publishing events to a channel. The
built-in pub-sub adapter supports the following publishing modes:

= Section 7.1.1.1, "Local Publishing"
= Section 7.1.1.2, "Remote Publishing"

For more information, see Section 7.1, "Overview of HTTP Publish-Subscribe Server
Adapter Configuration".

7.1.1.1 Local Publishing

Figure 7-1 shows how the built-in pub-sub adapter for local publishing fits into a
simple event processing network. The arbitrary adapter and processor are not
required, they are just an example of possible components in your application in
addition to the pub-sub adapter.
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Figure 7-1 Built-In Pub-Sub Adapter For Local Publishing
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Note the following in Figure 7-1:

Events flow from some source into an adapter of an application running in Oracle
CEP. This adapter is not required, it is shown only as an example.

The events flow from the adapter to an arbitrary processor; again, this processor is
not required.

The processor sends the events to the built-in pub-sub adapter for local
publishing. The adapter in turn sends the events to the local HTTP pub-sub server
configured for the Oracle CEP instance on which the application is deployed. The
pub-sub adapter sends the messages to the channel for which it has been
configured.

The local HTTP pub-sub server configured for Oracle CEP then sends the event as
a message to all subscribers of the local channel.

7.1.1.2 Remote Publishing

Figure 7-2 shows how the built-in pub-sub adapter for remote publishing fits into a
simple event processing network.
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Figure 7-2 Built-In Pub-Sub Adapter For Remote Publishing
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Note the following in Figure 7-2:

= Events flow from some source into an adapter of an application running in Oracle
CEP. The arbitrary adapter is not required, it is shown only as an example.

s The events flow from the adapter to an arbitrary processor; again, this processor is
not required.

= The processor sends the events to the built-in pub-sub adapter for remote
publishing. The adapter in turn sends the events as messages to the remote HTTP
pub-sub server for which the adapter is configured; this HTTP pub-sub server
could be on another Oracle CEP instance, a WebLogic Server instance, or any other
third-party implementation. The pub-sub adapter sends the messages to the
channel for which it has been configured.

s The remote HTTP pub-sub server then sends the message to all subscribers of the
channel.

7.1.2 Overview of the Built-In Pub-Sub Adapter for Subscribing

Figure 7-3 shows how the built-in pub-sub adapter for subscribing fits into a simple
event processing network. The arbitrary processor and business POJO are not
required, they are just an example of possible components in your application in
addition to the pub-sub adapter.
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Figure 7-3 Built-In Pub-Sub Adapter For Subscribing
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= Messages are published to a remote HTTP pub-sub server, which could be another
instance of Oracle CEP, WebLogic Server, or a third-party implementation. The
messages are typically published by Web based clients (shown in graphic), by the
HTTP pub-sub server itself, or another server application.

Note the following in Figure 7-3:

s The built-in pub-sub adapter running in an Oracle CEP application subscribes to
the HTTP pub-sub server and receives messages from the specified channel. The
adapter converts the messages into the event type configured for the adapter.

s The pub-sub adapter sends the events to a processor. This processor is not
required, it is shown only as an example of a typical Oracle CEP application.

»  The processor sends the events to a business POJO. Again, this business POJO is
not required.

For more information, see Section 7.1, "Overview of HTTP Publish-Subscribe Server
Adapter Configuration".

7.1.3 Converting Between JSON Messages and Event Types

Oracle CEP can automatically convert incoming JSON messages to event types, and
vice versa in the outbound case. However, if you want to customize the way a JSON
message (either inbound via a HTTP pub-sub adapter for subscribing or outbound via
an HTTP pub-sub adapter for publishing) is converted to an event type, or vice versa,
you must create your own converter bean. See Section 7.2.1, "Creating a Custom
Converter Between the HTTP Pub-Sub Messages and Event Types" for details.

If you do not provide your own converter class, and instead let Oracle CEP take care of
the conversion between messages and event types, the following is true:

= You must specify an event type that Oracle CEP uses in its conversion. See
Section 7.2.2, "Configuring an HTTP Pub-Sub Adapter" for details.
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s The default converter used in the HI'TP adapter for subscribing creates a new
event of the specified type for each incoming message. For each property of the
specified event type, it looks for a corresponding property name in the JSON
object that constitutes the message, and if found, sets the corresponding value.

s The default converter used in the HITP adapter for publishing creates a JSON
message for each event. For each property of the specified event type, a
corresponding element is created in the output JSON message.

7.2 Using the Built-In HTTP Pub-Sub Adapters in an Application

The following procedure describes typical steps for using the built-in pub-sub adapters
in your Oracle CEP application. See Chapter 8, "Configuring Custom Adapters, Event
Beans, and Spring Beans," for details about creating a custom pub-sub adapter.

Note: This section assumes that you have already created an Oracle
CEP application, along with its EPN assembly file and component
configuration files, and that you want to update the application to use
the built-in pub-sub adapters. If this is not true, refer to Chapter 1,
"Overview of Creating Oracle CEP Applications" for general
information about creating an Oracle CEP application.

To use the built-in HTTP pub-sub adapters in an application:

1. Optionally create a converter Java class if you want to customize the way the
inbound or outbound messages are converted into event types. This step is
optional because you can let Oracle CEP make the conversion based on mapping
property names between the messages and a specified event type.

See Section 7.2.1, "Creating a Custom Converter Between the HTTP Pub-Sub
Messages and Event Types."

2. If you are going to use the local HTTP pub-sub server associated with the Oracle
CEP instance for local publishing, use Visualizer, the Oracle CEP Administration
Tool, to add new channels with the channel pattern required by your application.

For details, see "How to Configure Security for an HTTP Publish-Subscribe
Channel" in the Oracle CEP Visualizer User's Guide.

3. Configure the built-in pub-sub adapters you are going to add to you application
by updating the component configuration files.

See Section 7.2.2, "Configuring an HTTP Pub-Sub Adapter."

4. Update the EPN assembly file, adding declarations for each built-in pub-sub
adapter you are adding to your application.

See Section 7.2.3, "Updating the EPN Assembly File."

5. Update the MANIFEST . MF file of your application, adding the package
com.bea.core.encryption to the Import-Package header. For example:

Import-Package:
com.bea.core.encryption
com.bea.wlevs.adapter.defaultprovider;version="2.0.0.0",

See Section 14.2.2.1, "Creating the MANIFEST.MF File" for additional information
on the manifest file.
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7.2.1 Creating a Custom Converter Between the HTTP Pub-Sub Messages and Event
Types

If you want to customize the way a message (either inbound via a HTTP pub-sub
adapter for subscribing or outbound via an HTTP pub-sub adapter for publishing) is
converted to an event type, or vice versa, you must create your own converter bean.

The custom converter bean for an inbound HTTP pub-sub message must implement
the com.bea.wlevs.adapters.httppubsub.api.InboundMessageConverter
interface. This interface has a single method:

public List convert (JSONObject message) throws Exception;

The message parameter corresponds to the incoming HTTP pub-sub message and the
return value is a List of events that will be passed on to the next stage of the event
processing network. The incoming message is assumed to be the JSON format.

The custom converter bean for an outbound HTTP pub-sub message must implement
the

com.bea.wlevs.adapters.httppubsub.api.OutboundMessageConverter
interface. This interface has a single method:

public List<JSONObject> convert (Object event) throws Exception;

The parameters correspond to an event received by the outbound HTTP pub-sub
adapter from the source node in the EPN and the return value is a List of JSON
messages.

See the Oracle CEP Java API Reference for a full description of these APIs.

The following example shows the Java source of a custom converter bean that
implements both InboundMessageConverter and OutboundMessageConvert;
this bean can be used for both inbound and outbound HTTP pub-sub adapters:

package com.sample.httppubsub;
import com.bea.wlevs.adapters.httppubsub.api.InboundMessageConverter;
import com.bea.wlevs.adapters.httppubsub.api.OutboundMessageConverter;
import com.bea.httppubsub.json.JSONObject;
import java.util.List;
import java.util.ArrayList;
import java.util.HashMap;
import java.util.Map;
public class TestConverter implements InboundMessageConverter, OutboundMessageConverter {
public List convert (JSONObject message) throws Exception {
List eventCollection = new ArrayList();
PubsubTestEvent event = new PubsubTestEvent () ;
event.setMessage ("From TestConverter: " + message);
eventCo